KnowledgeWorks and Prolog User Guide

Version 8.0
Copyright and Trademarks

KnowledgeWorks and Prolog User Guide (Windows version)

Version 8.0

December 2021

Copyright © 2021 by LispWorks Ltd.

All Rights Reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of LispWorks Ltd.

The information in this publication is provided for information only, is subject to change without notice, and should not be construed as a commitment by LispWorks Ltd. LispWorks Ltd assumes no responsibility or liability for any errors or inaccuracies that may appear in this publication. The software described in this book is furnished under license and may only be used or copied in accordance with the terms of that license.

LispWorks and KnowledgeWorks are registered trademarks of LispWorks Ltd.

Adobe and PostScript are registered trademarks of Adobe Systems Incorporated. Other brand or product names are the registered trademarks or trademarks of their respective holders.


The XP Pretty Printer bears the following copyright notice, which applies to the parts of LispWorks derived therefrom: Copyright © 1989 by the Massachusetts Institute of Technology, Cambridge, Massachusetts.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that this copyright and permission notice appear in all copies and supporting documentation, and that the name of M.I.T. not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. M.I.T. makes no representation about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty. M.I.T. disclaims all warranties with regard to this software, including all implied warranties of merchantability and fitness. In no event shall M.I.T. be liable for any special, indirect or consequential damages or any damages whatsoever resulting from loss of use, data or profits, whether in an action of contract, negligence or other tortious action, arising out of or in connection with the use or performance of this software.

LispWorks contains part of ICU software obtained from http://source.icu-project.org and which bears the following copyright and permission notice:

ICU License - ICU 1.8.1 and later

COPYRIGHT AND PERMISSION NOTICE
Copyright © 1995-2006 International Business Machines Corporation and others. All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
Copyright and Trademarks

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder. All trademarks and registered trademarks mentioned herein are the property of their respective owners.

US Government Restricted Rights
The LispWorks Software is a commercial computer software program developed at private expense and is provided with restricted rights. The LispWorks Software may not be used, reproduced, or disclosed by the Government except as set forth in the accompanying End User License Agreement and as provided in DFARS 227.7202-1(a), 227.7202-3(a) (1995), FAR 12.212(a)(1995), FAR 52.227-19, and/or FAR 52.227-14 Alt III, as applicable. Rights reserved under the copyright laws of the United States.

<table>
<thead>
<tr>
<th>Address</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>LispWorks Ltd</td>
<td>From North America: 877 759 8839 (toll-free)</td>
<td>From North America: 617 812 8283</td>
</tr>
<tr>
<td>St. John's Innovation Centre</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cowley Road</td>
<td>From elsewhere: +44 1223 421860</td>
<td>From elsewhere: +44 870 2206189</td>
</tr>
<tr>
<td>Cambridge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CB4 0WS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>England</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

www.lispworks.com
1 Introduction 8

1.1 KnowledgeWorks 8
1.2 Notation and conventions 10

2 Tutorial 11

2.1 Getting Started 11
2.2 Loading the Tutorial 11
2.3 Running the Tutorial 12
2.4 Browsers 13
2.5 KnowledgeWorks Listener 17
2.6 Debugging 17
2.7 Lisp Integration 20
2.8 Systems 21
2.9 Exiting KnowledgeWorks 21

3 Rules 22

3.1 Forward chaining 22
3.2 Backward Chaining 26
3.3 Common Lisp Interface 28

4 Objects 29

4.1 CLOS objects 29
4.2 Relational Database Objects 30
4.3 KnowledgeWorks Structures 35

5 The Programming Environment 36

5.1 The KnowledgeWorks Listener 36
5.2 The Editor 37
5.3 Clearing KnowledgeWorks 37
5.4 The System Browser 38
5.5 The Class Browser 38
5.6 The Objects Browser 41
5.7 The Rule Browser 43
5.8 Debugging with the Environment 43
5.9 Monitor Windows 44
6 Advanced Topics 47

6.1 Control Flow 47
6.2 Optimization 52
6.3 Use of Meta-Classes 55
6.4 Logical Dependencies and Truth Maintenance 56
6.5 Inferencing States 57

7 Reference Guide 59

all-debug 59
any 59
assert 60
clear-all 61
clear-rules 62
conflict-set 62
context 63
current-cycle 64
cut 64
*cycle* 65
defcontext 65
def-kb-class 67
def-kb-struct 68
def-named-kb-class 69
defrule 70
def tactic 71
destroy-inferencing-state 72
erase 73
fail 73
findall 74
findallset 74
find-inferencing-state 75
fire-rule 76
get-kb-object 77
infer 78
*inferencing-state* 78
inferencing-state-name 79
*in-interpreter* 80
instantiation 80
inst-bindings 81
inst-rulename 82
inst-token 82
kb-name 83
kw-class 84
lex 85
Appendix B: Examples 128

B.1 The Tutorial 128
B.2 Explanation Facility 130
B.3 Uncertain Reasoning Facility 134
B.4 Other Examples 137

Appendix C: Implementation Notes 138

C.1 Forward Chainer 138
C.2 Backward Chainer 138

Appendix D: For More Information 140

D.1 General References 140
D.2 The LispWorks manuals 140

Appendix E: Converting Other Systems 142

E.1 OPS5 142
E.2 Prolog 144

Glossary 145

Index
1 Introduction

1.1 KnowledgeWorks

KnowledgeWorks® is a LispWorks® toolkit for building knowledge based systems. It is a multi-paradigm programming environment which allows developers to express problems in terms of objects, rules, and procedures. This section provides an historical perspective and an overview of the system.

1.1.1 Background

Broadly speaking, there have been two generations of commercial knowledge based system (KBS) shells. The first generation of KBS shells were built on top of symbolic programming languages such as Lisp. These shells exhibited a high degree of flexibility and functionality as a result, but suffered because of their lack of standardization, poor performance, and inability to communicate with other applications. The second generation of KBS shells were generally written in C to attack the latter two weaknesses of Lisp-based shells. However these C-based shells are inevitably less flexible, and exacerbate the standardization issue. Although written in a C (a standard language), each C-based shell must re-invent a range of features already provided as standard in every Common Lisp implementation, including the object-system and even elementary structures like lists.

KnowledgeWorks addresses all of these issues by providing a high performance rule-based system for LispWorks. The latter is a full and efficient Common Lisp implementation including the Common Lisp Object System (CLOS), and foreign function interfaces to languages such as C, C++, and FORTRAN. Hence KnowledgeWorks constitutes a tightly integrated multi-paradigm programming environment, allowing all the most powerful features of rule-based, object-oriented and procedural approaches to be combined without abandoning accepted standards.

1.1.2 Technical Overview

KnowledgeWorks includes:

- High performance inferencing mechanisms:
  - forward chaining (OPS compatible).
  - backward chaining (Prolog compatible).
- A powerful standard object system (CLOS).
- A flexible standard procedural language (Common Lisp).
- Metaprotocols for extending the object and rule systems (MOP & MRP — see below).
- Support for multiple independent inferencing operations using inferencing state objects.
- A full set of graphical tools for developing and debugging knowledge bases.
- Built using the CAPI and integrated with the LispWorks IDE.
- Integration within larger applications, possibly following a completely different paradigm.
KnowledgeWorks rules perform pattern-matching directly over the object base (KnowledgeWorks CLOS objects and KnowledgeWorks structures). Forward chaining rules use this pattern-matching to perform actions, while backward chaining rules use it to deduce goals. The actions of forward chaining rules can call backward chaining rules, and the backward chaining inference engine may also invoke the forward chainer. Forward chaining rules may be grouped to increase the modularity of the rulebase and to introduce a mechanism for procedural control by explicit invocation of rule groups.

KnowledgeWorks CLOS objects are conventional CLOS objects with the simple addition of a mixin class providing KnowledgeWorks functionality, and they can be used outside the rulebase as ordinary CLOS objects. Any existing CLOS code may simply be reused and augmented with rules by adding the mixin to chosen classes.

LispWorks CLOS includes an implementation of the Meta Object Protocol (MOP) which allows the object system to be extended and customized in a standard way. In the same spirit of self-reflection, KnowledgeWorks rule-based system can be extended and customized using a Meta Rule Protocol (MRP) which allows meta-interpreters to be defined for rules. Together these protocols mean that KnowledgeWorks defines a region rather than a point in space of KBS shells, and ensure that developers are not constrained by the default behavior of the system.

KnowledgeWorks has a comprehensive programming environment that enables rapid development and debugging of rulebases. Tools are provided that enable the interactive examination of classes and objects. Graphical debugging windows allow forward and backward chaining rules to be single-stepped and monitored. The full LispWorks programming environment and tools are also available, for example, the editor which allows rules to be defined and redefined incrementally and dynamically (see the Editor User Guide). You can include KnowledgeWorks in a delivered runtime application if you have LispWorks Enterprise Edition, LispWorks for iOS Runtime or LispWorks for Android Runtime. See the Delivery User Guide for details.
1.2 Notation and conventions

1.2.1 Prolog syntax

Syntax will be presented in BNF. Any other non-standard notation will be explained as used.

::= introduces a definition.

<..> token, or non-terminal symbol.

[..] delimits optional items.

* 0 or more repetitions of the previous token.

+ 1 or more repetitions of the previous token.

| separates alternatives.

1.2.2 Viewing example files

This manual sometimes refers to example files in the LispWorks library via a Lisp form like this:

\[(example-edit-file "kw/animal/defsystem")\]

These examples are Lisp source files in your LispWorks installation under \texttt{lib/8-0-0-0/examples/}. You can simply evaluate the given form to view the example source file.

The examples files are in a read-only directory and therefore you should compile them inside the IDE (by the Editor command \texttt{Compile Buffer} or the toolbar button or by choosing \texttt{Buffer > Compile} from the context menu), so it does not try to write a fasl file.

If you want to manipulate an example file or compile it on the disk rather than in the IDE, then you need first to copy the file elsewhere (most easily by using the Editor command \texttt{Write File} or by choosing \texttt{File > Save As} from the context menu).

1.2.3 Appearance of the graphical tools

Please note that your windows may differ in some respects from the illustrations given in this manual. This is because some details are controlled by the window manager that you are using, not by LispWorks itself.

The screenshots in this manual show toolbars that may have been customized (using the context menu) so you might see some differences from your setup.
2 Tutorial

The tutorial is a simple example based on an animal guessing game. In this game the user thinks of an animal and the program asks yes/no questions. Eventually the program mentions an explicit animal and asks whether it is correct. If so, the game ends. If it is not correct it will ask what the animal was and ask for a question to distinguish it from its last guess. This is a trivial example of a learning program. The tutorial assumes a certain familiarity with Lisp, LispWorks and the Common Lisp Object System (CLOS).

All examples in this chapter assume that you are typing in expressions in a package that uses the KW package, for instance, **KW-USER**.

### 2.1 Getting Started

To run the tutorial, put this form in your LispWorks initialization file (usually called .lispworks):

```lisp
(rerequire "kw")
```

Start LispWorks. The KnowledgeWorks Podium window will appear. Note the position of the **KnowledgeWorks** menu, which you will use to access the tools described in this manual.

KnowledgeWorks Podium

On Microsoft Windows you may see a different Podium, depending on which of the Window Options has been selected. See the section "Windows Multiple Document Interface" in the *LispWorks IDE User Guide* for details. This manual, the *KnowledgeWorks and Prolog User Guide*, will usually show single windows in figures in order to show more detail for the specific KnowledgeWorks tool under discussion.

### 2.2 Loading the Tutorial
First bring up a KnowledgeWorks Listener by choosing **KnowledgeWorks > Listener** from the KnowledgeWorks Podium. The KnowledgeWorks Listener accepts Lisp input as well as KnowledgeWorks input. Enter:

```
(in-package "KW-USER")
```

into the KnowledgeWorks Listener, and then change the current directory to that of the animals demo by entering:

```
(cd (lispworks:example-file "kw/animal/"))
```

If this fails, check the value of the Lisp variable 

*li

sp-work-directory*.

Load the tutorial by typing:

```
(load "de

fsystem")
```

to load the tutorial system definition, and:

```
(compile-system "ANIMAL" :load t :target-directory (get-temp-file))
```

to compile and load the rules and object base (CLOS objects). In interpreting these two commands, the KnowledgeWorks Listener has behaved just like a Lisp Listener. In general, whenever input has no specific KnowledgeWorks interpretation, the KnowledgeWorks Listener just accepts it as Lisp.

## 2.3 Running the Tutorial

First run the tutorial example a few times. Think of an animal and type **infer** into the listener. **infer** is a function which starts the forward chaining engine. Popup question windows will appear, which require clicking on either **Yes** or **No**. If your animal is guessed correctly, execution will terminate and the listener prompt will reappear. If the final guess is incorrect then:

1. Another popup will ask what the animal was. Type in the name of an animal and press **Return** (or click on **OK**). If the animal is already known to the system this constitutes an error. A confirmer popup will inform you of this; click on **Confirm** and execution will terminate.

2. You will be asked for a question to distinguish your animal from the system's last guess. Type in a question (again without quotes or double-quotes) and press **Return**. Execution will terminate.
3. The tutorial may be restarted by typing \texttt{(infer)} again in the listener. This time the system will know about your new animal and the question that distinguishes it. Every time the rule interpreter finishes, it will return and display in the listener the number of rules the forward chaining engine fired.

2.4 Browsers

There are a number of browsers for examining the state of KnowledgeWorks. They will be introduced here, and again when the Programming Environment is discussed in 5 The Programming Environment.

2.4.1 Rule Browser

KnowledgeWorks Rule Browser

This may be obtained by choosing \texttt{KnowledgeWorks > Rules}. The defined forward chaining contexts (or rule groups) are displayed in a drop-down list at the top. There is also a special pseudo-context for all the backward chaining rules, which is shown initially. In this case, the only other context is named \texttt{DEFAULT-CONTEXT}. Below that are listed the rules for the selected context. Choose \texttt{DEFAULT-CONTEXT} from the drop-down list and click on one of the rules, for example \texttt{PLAY}, and edit it by choosing \texttt{Works > Rule > Find Source} from the menu bar. An editor window will appear showing this rule definition.

What this rule says is:

\begin{verbatim}
(root ?r node ?node)
(not (current-node ? node ?))

---

((capi:display-message " ANIMAL GUESSING GAME - ~
  think of an animal to continue")

(assert (current-node ? node ?node))
\end{verbatim}

which means:

If the node \texttt{?node} is the root node of the tree of questions, and there is no current node indicating the question about to be asked, then tell the user to think of an animal and make the root node \texttt{?node} the current node (so that the top question of the tree will be asked next). This is the rule that starts the game by instructing: "if you haven't got a question you're about to ask, ask the topmost question in the tree of questions". The detailed syntax of forward chaining rule definitions will be explained in 3.1 Forward chaining.

Select "\texttt{- All backward rules -}" from the drop-down list and bring up a backward chaining rule definition by clicking on its name in the Rule Browser and choosing \texttt{Works > Rule > Find Source} again. The detailed syntax of backward
2 Tutorial

chaining rules is in 3.2 Backward Chaining.

2.4.2 Objects Browser

KnowledgeWorks Objects Browser

The Objects Browser is for exploring the contents of the KnowledgeWorks object base. Start it by choosing KnowledgeWorks > Objects. The system knows about the CLOS objects that make up the object base. One class of CLOS objects in this example is the node class so choose NODE from the Preset query/pattern drop-down. All the node objects in the object base will be displayed in the pane below. Click on one of these objects and the bottom pane will display the slots and slot values of the object.

To make the display clearer and allow input without explicit package qualifiers, change the package of the Objects Browser. Do this via Tools > Preferences... > Objects Browser > Package. Edit the Package pane so that it says KW-USER and press OK.

Now change the Query field to read (node ?object animal ?a) and press Return. The animals associated with each node are displayed. In this game there is a tree of questions with each node object representing a question. Some nodes have a nil value for the animal slot; these are the non-terminal nodes in the question tree. The program learns your new animals by adding new nodes to the tree.

Now type ?a into the Pattern field (and press Return). This displays only the animals. The values displayed in the topmost of the two panes is the Pattern field instantiated with every possible object that matches the Query field. However, if the Pattern field is empty then the value of the Query field is taken to be the pattern.

Change the Query field to read (and (node ?n animal ?a) (test ?a)) and press Return.
Objects Browser matching animals

Only the non-nil animals are displayed.

2.4.3 Class Browser
The Class Browser is obtained by choosing **KnowledgeWorks > Classes**. This brings up the LispWorks Class Browser with an initial focus on the class `standard-kb-object`. Select the Subclasses tab to display the subclasses of `standard-kb-object`. Double click on `NODE` in the subclasses pane to examine the node class used in this tutorial. Select the Slots tab to display its slots and click on one of the slots in the middle pane, for example the `ANIMAL` slot. This displays more information about the slot in the Description pane.

Other useful features of the Class Browser include the Superclasses tab which display a graph of the superclasses; the Hierarchy tab which displays direct superclasses and subclasses; and the Functions tab which displays the generic functions or methods defined on a class either directly or through inheritance. For more information about the Class Browser, see the *LispWorks IDE User Guide*.

### 2.4.4 Forward Chaining History
KnowledgeWorks Forward Chaining History

This is obtained by choosing KnowledgeWorks > FC History. If you have just run the tutorial a window will appear of which the left column contains the entry DEFAULT-CONTEXT. These are all the contexts (rule groups) the forward chaining engine has executed (in this case only one). On the right is a detailed breakdown of what happened in each cycle within this context. You will see the rule names listed down the left, and the cycle numbers along the top. The boxes indicate which rules fired. In the last cycle, you will see a black box indicating that the rule GAME-FINISHED fired, and a outlined box for the rule PLAY. This means that the rule PLAY could have fired, but that GAME-FINISHED was preferred.

**Note:** you can remove the package prefixes from displayed symbols by setting the current package of the FC History tool to KW-USER, in the same way as you did for the Objects Browser tool (see 2.4.2 Objects Browser).

Look at the definition for GAME-FINISHED (find the source using the Rule Browser) and notice that it contains :priority 15. This means that the GAME-FINISHED rule has higher priority than the PLAY rule (which has the default value of 10), and so was preferred. Other methods of conflict resolution are also available.

### 2.5 KnowledgeWorks Listener

The KnowledgeWorks Listener has already been shown to function as a Lisp Listener. However it extends this with the ability of the Objects Browser to match objects. When using the Objects Browser the Query pane contained patterns which could be matched against the Object Base. These same patterns can be entered into the KnowledgeWorks Listener. Enter (node ?object) into the Listener. This asks "Are there any node objects?". A NODE object will be returned. To ask for more solutions press the Next button. If there are more you will be shown another, otherwise the listener displays the word NO and the listener prompt reappears. If you do not want to see any more, just press the Return key.

Try entering some of the other expressions from the Objects Browser, for example (and (node ?n animal ?a) (test ?a)). If the input is not recognized it is treated as Lisp.

### 2.6 Debugging
2.6.1 Monitoring Forward Chaining Rules

KnowledgeWorks Rule Monitor

One of the problems with forward chaining rules is determining why they are (or are not) being matched. To deal with this KnowledgeWorks has Monitor Windows for forward chaining rules. To bring up a Monitor Window, select the DEFAULT-CONTEXT in the Rule Browser, click on PLAY and choose Works > Rule > Monitor. Alternatively you can use the context menu to raise the Rule Monitor window. A Rule Monitor window appears displaying in its upper pane the conditions of the rule. Both are highlighted meaning they are matched (as single conditions without reference to any variable bindings across conditions) in the object base. If you select one or more of these conditions, the message will change from "Number of instantiations matching selected conditions: <n>" to "No instantiations matching selected conditions" depending on whether objects can be found in the object base to match all the selected conditions at once (this takes account of variables bound across conditions).

By selecting the All Unfired Instantiations button, you can list any unfired instantiations of the rule. In this case there is one unfired instantiation. Selecting this in the lower pane and then choosing Works > Instantiations > Inspect raises an Inspector tool displaying the variable bindings in the instantiation.

You can have any number of monitor windows (though at most one per rule). At times (during rule execution, for example) the object base may change. Monitor windows can be updated by choosing Tools > Refresh from the Rule Monitor menu bar, or KnowledgeWorks > Memory > Update Monitor Windows from the KnowledgeWorks Listener. When you are single-stepping through rules (see below) Monitor windows are updated automatically.

2.6.2 Single-Stepping Rules

![Rule Monitor Window](image)
Select a rule, say, Y-N-QUESTION, in the Rule Browser and choose **Works > Rule > GSpy** from the menu bar. This brings up a Spy Window for the rule. In it you will see the actions of the rule.

Now enter (infer) in the Listener to run the demo again. Execution will stop when this rule fires. A message in the listener will say that the rule Y-N-QUESTION has been called. Click on the Creep button at the bottom of the Listener to single step through the rule. Watch the highlight move through the Spy Window as you go. If you still have a Monitor Window for the PLAY rule it will be updated automatically as you go.

Click on Leap at the bottom of the Listener and it will "leap" to the end of the rule. When you have finished, close the Spy Window (for example by pressing **Alt+F4**) and press Leap in the Listener window to remove the break point and continue normally.

At any point when rule execution is suspended by this mechanism, the other KnowledgeWorks tools may be used, for example to examine the object base (with the Objects Browser) or see which rules have fired (with the forward chaining history). Spy Windows are available for backward chaining rules as well, and they work in exactly the same way (they are set by selecting the rule in the Rule Browser and choosing **Works > Rule > Gspy**).

### 2.6.3 Editing Rule Definitions
Let us suppose that when the demo finishes we would like it to ask if we want to play again. Find the definition for GAME-FINISHED (using the Rule Browser). One line in the definition is commented out with a ; (semi-colon) at the start. Remove the semi-colon and compile the new definition by choosing Works > Definitions > Compile from the editor menu bar. Press Space to return to the editor view. This rule will now ask if the user wants to play again and execution will only stop (the (return) instruction ends execution) if requested. Run the demo to see this happen.

The rule FETCH-NEW-ANIMAL also has a commented-out line (repeat) which will make it repeat its prompt until given an animal it does not already know. Remove the semi-colon at the start of the line in and compile the new definition of the rule. Run the demo again and try giving the system an animal it recognizes. It will prompt again. Give it an animal it does not recognize to finish.

2.7 Lisp Integration

You can save your object base of animals by entering:

```
(save-animals "my-animal-objs.lisp")
```

into the Listener. In the file of rules "animal-rules.lisp" look at the function `save-animals` which does this. Note how the Lisp code directly uses the same objects as the rules. If we used the Lisp code to modify the slots of the objects the KnowledgeWorks rule interpreter would keep track.

Note: KnowledgeWorks CLOS objects are ordinary CLOS objects and can be used outside KnowledgeWorks rules.

2.7.1 The LispWorks IDE

The entire programming environment of the LispWorks IDE is available from the menus on the KnowledgeWorks Podium window. See the LispWorks IDE User Guide for more details.
2.8 Systems

KnowledgeWorks System Browser

If you are familiar with LispWorks system definitions, look at the system definition for the animal demo, by evaluating:

```
(example-edit-file "kw/animal/defsystem")
```

It contains systems with type :kb-system and :kb-init-system. Examine the components of each system (which can be source files or subsystems) using the System Browser which is available from the Editor via Alt+X Describe System or File > Browse Parent System.

Systems with type :kb-system are reloaded when the rules are cleared. Systems with type :kb-init-system are reloaded when the object base is cleared.

Try this out by finding the KnowledgeWorks Listener and choosing Memory > Clear Objects and Rules. Then enter (load-system "ANIMAL") into the KnowledgeWorks Listener to reload the system animal. Both the files animal-rules and animal-objs are reloaded. Now choose KnowledgeWorks > Memory > Clear Objects and reload the animal system again and note how only the file animal-objs is reloaded.

2.9 Exiting KnowledgeWorks

KnowledgeWorks is integrated with LispWorks so you cannot exit from KnowledgeWorks independently. You can close individual KnowledgeWorks windows. You can exit LispWorks by choosing File > Exit from the Podium. If you have any unsaved edited files you will be asked whether you wish to save them. There will be a final confirmation before KnowledgeWorks quits.
3 Rules

KnowledgeWorks rules are defined as follows:

```lisp
<rule> ::= (defrule <rule-name> <direction> [<doc-string>] <body>)
```

```lisp
<direction> ::= {:forward | :backward}
```

Every rule must have a unique name which must also be distinct from any KnowledgeWorks object class name and from any context (rule-group) name. The expressions which form the body of a rule have the same syntax and meaning regardless of whether they occur on the left or right hand side of a forward or backward chaining rule. If `doc-string` is given, then it should be a string. The value can be retrieved by calling the function `documentation` with doc-type `rule`.

3.1 Forward chaining

3.1.1 Overview

Forward chaining rules consist of a condition part and an action part. The condition part contains conditions which are matched against the object base. If and only if all the conditions are matched, the rule may fire. If the rule is selected to fire, the actions it performs are given in the action part of the rule. The process of selecting and firing a rule is known as the Forward Chaining Cycle, and the forward chaining engine cycles repeatedly until it runs out of rules or a rule instructs it to stop. KnowledgeWorks forward chaining rules reside in a group of rules, or context, and may have a priority number associated with them for conflict resolution (choosing which of a set of eligible rules may fire).

3.1.2 Forward Chaining Syntax

Forward chaining rule bodies are defined by:

```
<body> ::= [:context <context-name>] [:priority <priority-number>] <forward-condition>* --> <expression>*
```

where `<context-name>` is the name of a context which has already been defined (see 3.1.5 Control Flow) defaulting to `default-context`, and `<priority-number>` is a number (see 3.1.5 Control Flow) defaulting to 10.

The syntax for forward-conditions is:

```
<forward-condition> ::= <object-condition>
                     | (test <lisp-expr>)
                     | (not <forward-condition>+)
                     | (logical <forward-condition>+)
```

```
<object-condition> ::= (<class-name> <variable> [<object-slot-condition>]*)
```

22
3 Rules

<object-slot-condition> ::=  
<slot-name> <term>

<object-condition> is an object-base match where the variables (introduced by "?" in <term>) are bound (via destructuring) to the corresponding data in the slot named by <slot-name>. <variable> is a single variable bound to the object matched.

Note: "?" on its own denotes an anonymous variable which always matches.

(test <lisp-expr>) is a Lisp test where <lisp-expr> is any Lisp expression using the variables bound by other conditions, and which must succeed (return non-nil) for the condition to match. Computationally cheap Lisp tests can frequently be used to reduce the search space created by the object base conditions. Lisp tests, and any functions invoked by them, should not depend on any dynamic global data structures, as changing such structures (and hence the instantiations of the rule) will be invisible to the inference engine. Lisp tests can depend on the values of slots in objects matched by preceding object-base conditions only if the values are bound to variables in the rule using the <object-slot-condition> syntax. They cannot depend on values obtained by calling slot-value or a reader function.

(not <forward-condition>+)) is simply a negated condition. A negated condition never binds any variables outside its scope. Variables not bound before the negation will remain unbound after it.

(logical <forward-condition>++) is used to indicate clauses that describe the logical dependencies amongst objects. See 6.4 Logical Dependencies and Truth Maintenance for more details.

Note that if a forward chaining rule contains any conditions at all then it must contain at least one object base reference of the form:

    (<class-name> <variable> ...)

The syntax for expressions is:

<expression> ::=  
<forward-condition>  
| (erase <variable>)  
| (assert (<class-name> <variable>  
[<slot-name> <term>]*))  
| (context <context-list>)  
| (return)  
| (<lisp-expr> <term>*)  
| <goal>

<forward-condition> is a forward condition which must succeed for execution of the action part of the rule to continue.

(erase <variable>) removes the instance bound to <variable> from the knowledge base. It is an error if <variable> is bound to anything but a KnowledgeWorks instance.

(assert (<class-name> <variable> [<slot-name> <term>]*)) is an assertion which modifies the contents of the object base, where if <variable> is unbound a new object of the given class with the given slot-values is created, and if it is bound, the object to which it is bound has its slots modified to the given values.

(context <context-list>) adds the given list of contexts to the top of agenda (see 3.1.5 Control Flow).

(return) passes control to the top context on the agenda and removes it from the agenda (see 3.1.5 Control Flow).

(<lisp-expr> <term>*) binds the result or results of calling <lisp-expr> to the <term>s with execution of the rule terminating if any bindings fail (if no <term>s are given execution will always continue).

<goal> may be any backward chaining goal expression (see 3.2 Backward Chaining).

Note that in the action part of a rule, only backward chaining goals and object base matches invoke the backward chainer.
3 Rules

3.1.2.1 Example

(defrule move-train :forward
   :context train
   (train ?train position ?train-pos)
   (signal ?signal position ?signal-pos color green)
   (test (= ?signal-pos (1+ ?train-pos)))
-->
   ((format t "~%Train moving to position ~s" ?signal-pos))
   (assert (signal ?signal color red))
   (assert (train ?train position ?signal-pos)))

specifies that if there is a train with a green signal directly in front then the train may move on and the signal changes to red.

3.1.3 Defining Forward Chaining Rules

Forward chaining rules may be defined and redefined incrementally. When redefined all the instantiations of the rule are recreated. This means that during execution of a rulebase the redefinition capability should be used with care as previously fired instantiations will reappear and may fire again.

When a rule is redefined it inherits its order (with respect to the order conflict resolution tactic) from its initial definition. If this is not required, the rule should be explicitly undefined before being redefined.

A forward chaining rule may be undefined by entering:

   (undefrule <rule-name>)

A warning will be given if the rule does not exist.

3.1.3.1 Example

   (undefrule move-train)

3.1.4 The Forward Chaining Interpreter

The forward chaining rule interpreter may be invoked by the Lisp function:

   (infer [:contexts <context-list>])

where <context-list> is a list of contexts where control is passed immediately to the first in the list, and the rest are placed at the top of the agenda. The object base may or may not be empty when the forward chainer is started. The infer function returns the final cycle number. When not specified, <context-list> defaults to (default-context).

3.1.5 Control Flow

3.1.5.1 The Agenda

The agenda is essentially a stack of rule groups (called contexts) which are still awaiting execution. The initial invocation of the forward chainer and any subsequent rule can cause contexts to be added to the top of the agenda. During normal execution the forward chainer simply proceeds down the agenda context by context. When the agenda is empty, passing control on will terminate the execution of the rule interpreter. This is a proper way to exit the forward chainer.
3 Rules

3.1.5.2 Contexts

Contexts are the groups into which rules are partitioned. The context default-context always exists. Contexts are defined by:

\[
<context> ::= (defcontext <context-name>
[:strategy <CRS>]
[:auto-return t | nil]
[:meta <meta-actions>]
[:documentation <doc-string>])
\]

where \(<context-name>\) is a symbol, \(<CRS>\) is a conflict resolution strategy defaulting to \((\text{priority recency order})\) (see below). If :auto-return is set to \(t\) (the default) then when the context has no more rules to fire, control passes to the next context on the agenda, but if it is \(\text{nil}\) an error occurs (a rule in the context should have issued a \((\text{return})\) instruction explicitly). The :meta option is necessary only if the default behavior of the context is to be modified and is explained in 6.1.1 Meta Rule Protocol. If :documentation is given, then \(\text{doc-string}\) should be a string and the value can be retrieved by calling the function \text{documentation} with doc-type \text{context}.

3.1.5.3 Conflict Resolution

Every context has its own conflict resolution strategy, specified in the defcontext form. A conflict resolution strategy is an ordered list of conflict resolution tactics. A conflict resolution tactic may be any of the following:

- **priority**

  Instantiations of rules with the highest priority are preferred.

- **-priority**

  Instantiations of rules with the lowest priority are preferred.

- **recency**

  The most recently created instantiations are preferred.

- **-recency**

  The least recently created instantiations are preferred.

- **order**

  Instantiations of rules defined/loaded earliest are preferred. This favors the topmost rules in a file.

- **-order**

  Instantiations of rules defined/loaded latest are preferred.

- **specificity**

  The most specific rules are preferred (specificity is a score where a point is awarded for every occurrence of a variable after the first, every Lisp test, and every destructuring expression; the highest score wins).

- **-specificity**

  The least specific rules are preferred.

- **mea**

  MEA stands for Means End Analysis. Instantiations are preferred where the object corresponding to the topmost object-matching condition is more recently modified.

- **-mea**

  Instantiations are preferred where the object corresponding to the topmost object-matching condition is less recently modified.

- **lex**

  LEX stands for LEXicographic. Each instantiation is represented by the (in descending order) sorted list of the most recently modified cycle numbers of the objects in the instantiation; these lists are compared place by place with an instantiation being preferred if it first has a larger number in a particular position, or if it runs out first (hence the analogy with lexicographic ordering).

- **-lex**

  The converse of the above.

The tactics are applied successively starting with the left-most until only one instantiation is left or until all tactics have been applied when it is unspecified which of the resulting set is chosen. For example, using the strategy \((\text{priority recency})\)
first all the instantiations which are not of the highest priority rule or rules (as given by the rule's priority number) are discarded and then all instantiations which were not created in the same forward chaining cycle as the most recently created instantiation will be discarded. If more than one instantiation is left it is unspecified which will be selected to fire.

Note that the strategy (lex specificity) is equivalent to the OPS5 strategy LEX and (mea lex specificity) is equivalent to the OPS5 strategy MEA, hence the borrowing of these terms. For further information on LEX and MEA in OPS5 the reader is referred to Programming Expert Systems in OPS5, by Brownston, Farrell, Kant and Martin (published by Addison-Wesley). However, KnowledgeWorks is not heavily optimized to use the tactics mea, -mea, lex or -lex.

3.1.6 Examples

(defcontext trains
  :strategy (priority recency order)
  :auto-return t)

(defcontext trains)

These two definitions are in fact equivalent.

3.1.6.1 Defining Contexts

A context may be defined and redefined. Redefining a context will clear all the rules in the context.

A context may be undefined and removed by entering:

(undefcontext <context-name>)

3.1.7 Forward Chaining Debugging

Forward chaining debugging may be turned on by typing:

(all-debug)

and off by typing:

(no-debug)

When KnowledgeWorks is started, debugging is on. Debugging allows the actions of forward chaining rules to be single-stepped like backward chaining rules (see 3.2.7 Backward Chaining Debugging), and also records information on which objects are modified by which rules. For information on how to use the debugging tools, refer to 5 The Programming Environment.

3.2 Backward Chaining

3.2.1 Overview

Backward chaining involves trying to prove a given goal by using rules to generate sub-goals and recursively trying to satisfy those. The KnowledgeWorks backward chaining engine is an extension of the LispWorks Common Prolog system which can match directly over KnowledgeWorks CLOS objects (the object base). All the standard Common Prolog facilities and built in predicates are available. For more detailed information the reader is referred to the Appendix A: Common Prolog. Note that all the different ways of proving a particular goal are defined together in the same form.
### 3.2.2 Backward Chaining Syntax

Backward chaining rule bodies are defined as:

- `<body>` ::= `<clause>`+
- `<clause>` ::= `<goal>` <-- `<expression>`*
- `<goal>` ::= `<rule-name>` `<term>`*

In each sub-clause of the rule, the goal must have the same arity (number of arguments). Within each `<term>` destructuring is allowed and variables are introduced by `?` (and `?` on its own denotes the anonymous variable which always matches). `<expression>` is as defined in 3.1.2 Forward Chaining Syntax.

#### 3.2.2.1 Example

```lisp
(defrule link-exists :backward
  ((link-exists ?town1 ?town2)
   <--
   (or (link ?link town1 ?town1 town2 ?town2)
       (link ?link town2 ?town1 town1 ?town2))
   (cut))
  ((link-exists ?town1 ?town2)
   <--
   (route-exists ?town1 ?town2)))
```

which says that a link exists between two towns either if there is a link object between them in the object base or if there is a route between the towns. The `route-exists` predicate would be defined by another backward chaining rule, or might be in the Prolog database.

### 3.2.3 Objects

Backward chaining rules may refer to the object base using the standard

- `(class-name) (variable) [slot-name (term)]**` syntax, and these expressions are instantiated directly without creating any sub-goals. The `<class-name>` of any CLOS class or KnowledgeWorks structure may not coincide with any backward chaining `<rule-name>`. The Common Prolog database may be used to record factual information but it is distinct from the object base in that it may contain variables, and anything in it is inaccessible to the forward chaining rule preconditions.

### 3.2.4 Defining Backward Chaining Rules

Backward chaining rules may be defined and redefined incrementally.

### 3.2.5 The Backward Chaining Interpreter

The backward chaining interpreter can be invoked from Lisp by the following functions:

- `(any expr-to-instantiate expr-to-prove)`

which finds any solution to `expr-to-prove` and instantiates `expr-to-instantiate`, and:

- `(findall expr-to-instantiate expr-to-prove)`

finds all the solutions to `expr-to-prove`, instantiates `expr-to-instantiate` for each and returns these in a list.

For other interface functions to be called from Lisp the reader is referred to Appendix A: Common Prolog.
From the action part of a forward chaining rule the backward chainer is called implicitly when a CLOS match or goal expression is used. The action part of forward chaining rules and the antecedents of backward chaining rules are syntactically and semantically identical.

### 3.2.5.1 Examples

```prolog
(any '(?x is in (1 2 3)) '(member ?x (1 2 3)))
```

returns:

```prolog
(1 is in (1 2 3))
```

The following expression:

```prolog
(findall '(?x is in (1 2 3)) '(member ?x (1 2 3)))
```

returns:

```prolog
((1 is in (1 2 3))(2 is in (1 2 3))(3 is in (1 2 3)))
```

### 3.2.6 Edinburgh Prolog Translator

Edinburgh syntax Prolog files may be compiled and loaded if they are given .pl as a file extension. These are completely compatible with the KnowledgeWorks backward chaining rules. For more details refer to [A.10 Edinburgh Syntax](#).

### 3.2.7 Backward Chaining Debugging

Backward chaining debugging follows the Prolog four port model. Backward chaining rules may be "spied" (this is a Prolog term which corresponds to tracing and single-stepping) which puts a break-point on them and means they can be single-stepped when they are invoked. When forward chaining debugging is on, the action part of forward chaining rules can be spied and single-stepped in the same way when they are fired. [5 The Programming Environment](#), explains this in detail. The leashing of the ports can be adjusted, details are to be found in [A.7 Debugging](#).

### 3.3 Common Lisp Interface

Arbitrary Lisp expressions may be called from rules. See [3.1.2 Forward Chaining Syntax](#).
4 Objects

The object base contains KnowledgeWorks CLOS objects (including relational database objects) and KnowledgeWorks structures. KnowledgeWorks CLOS objects can be treated as ordinary CLOS objects and may be manipulated directly from Lisp. KnowledgeWorks relational database objects may transparently retrieve their slot values from a relational database using the LispWorks object-oriented relational database interface.

KnowledgeWorks structures are more efficient but reduced functionality CLOS objects similar in spirit to Lisp structures. Values in the slots of these objects should not be destructively modified unless these values are themselves KnowledgeWorks objects. This is because the rule interpreter keeps track of the changes to the slots, and a destructive operation is likely to bypass this process.

4.1 CLOS objects

A KnowledgeWorks CLOS class may not have a class name which coincides with any rule, context or KnowledgeWorks structure (See 4.3 KnowledgeWorks Structures). KnowledgeWorks CLOS classes fall into one of two categories, either unnamed or named. Named objects can be given a name (or they use a default name) and can be referred to by name. Otherwise, named and unnamed objects have equivalent functionality. CLOS objects may be made by the Common Lisp function `make-instance`, taking the same arguments. An unbound slot will return `unbound` until set.

Name clashes are arbitrated by `*signal-kb-name-clash*` and signal an error by default. See the reference manual page.

4.1.1 Unnamed Classes

Unnamed classes may be defined by the macro `def-kb-class` which takes the same arguments as the `defclass` macro. It is identical to using `defclass` and supplying the KnowledgeWorks mixin `standard-kb-object` if none of the superclasses already contains it. The function `make-instance` may be used to create instances of the class.

4.1.2 Named Classes

A named KnowledgeWorks CLOS class is defined by the macro `def-named-kb-class` which is syntactically identical to the Common Lisp `defclass` macro, and semantically identical with the exception that it adds a KnowledgeWorks mixin class `named-kb-object` if none of the superclasses already contains it, and makes the default name for the objects be a symbol generated from the class name. Classes defined by `def-named-kb-class` contain a `name` slot which those defined by `def-kb-class` do not.

The function `make-instance` can be given the initialization argument `:kb-name` to specify a name. If not specified, a default name is generated from the name of the class. All names must be distinct as regarded by `eq`. The function:

```
(get-kb-object <name>)
```

retrieves the instance from its name. The function:

```
(kb-name <object>)
```

returns the name of the given object.
4.1.2.1 Examples

(def-named-kb-class truck ()
  ((location :initarg :location)
   (destination :initarg :destination)))

(make-instance 'truck
  :kb-name 'ford1
  :location 'Cambridge)

creates the instance #<KB-OBJECT FORD1>.

(make-instance 'truck :location 'London)

creates the instance #<KB-OBJECT TRUCK123>, and:

(get-kb-object 'ford1)

returns #<KB-OBJECT FORD1> and:

(kb-name (get-kb-object 'ford1))

returns FORD1. The class definition:

(defclass truck (named-kb-object) ...)

would have been identical except that the second truck would have been given a name such as OBJECT345 rather than TRUCK123 (as def-named-kb-class overrides the inherited initform for the kb-name slot (gentemp "OBJECT") with a more specific one (gentemp <class-name>)).

4.2 Relational Database Objects

A CLOS/SQL class may also be given the KnowledgeWorks mixin class, enabling rules to refer to these objects as if there were no database present. However, their database functionality carries over transparently. For example, consider the case where a slot in the database class is designated for deferred retrieval from the database. When the rulebase queries the contents of the slot, a database query will automatically be generated to retrieve and fill in the value of the slot, and the rulebase will continue as if the value had been there in the first place.


4.2.1 Example

(sql:def-view-class vehicle
  (standard-db-object standard-kb-object)
  ((vehicle_no :db-kind :key)
   (keeper)
   (owner :db-kind :join
     :db-info (:home-key :keeper
               :foreign-key person_id
               :retrieval :deferred
               :join-class person)))))

defines a database class vehicle where the person object in the keeper slot is retrieved from the person table in the database using the value of the keeper slot as key, only when queried. In the list of superclasses, standard-kb-object should appear after sql:standard-db-object.
4.2.2 Extended Example

The following example is a complete segment of code which allocates person objects to vehicle objects. Note how once the class definitions have been made, the rules do not in any way reflect the fact that there is an underlying database. The example output assumes a database initialized by the following SQL statements:

```sql
drop table VEHICLE ;
create table VEHICLE
    (PLATE CHAR(8) NOT NULL, MAKE CHAR(20),
     PRICE INTEGER, OWNER CHAR(20)  );
grant all on VEHICLE to public ;
insert into VEHICLE values
    ('E265 FOO', 'VAUXHALL', 5000, '');
insert into VEHICLE values
    ('XDG 792S', 'ROLLS', 50000, '');
insert into VEHICLE values
    ('F360 OOL', 'FORD', 4000, 'PERSEPHONE');
insert into VEHICLE values
    ('HI51 EEE', 'JAGUAR', 15000, '');
insert into VEHICLE values
    ('G722 HAD', 'SKODA', 500, '');

drop table PERSON ;
create table PERSON
    (NAME CHAR(20) NOT NULL, SALARY INTEGER, VEHICLE CHAR(8),
     EMPLOYER CHAR(20)  );
insert into PERSON values ('FRED', 10000, '', 'IBM');
insert into PERSON values ('HARRY', 20000, '', 'FORD');
insert into PERSON values ('PHOEBE', 5000, '', '');
insert into PERSON values ('TOM', 50000, '', 'ACME');
insert into PERSON values ('PERSEPHONE', 15000, 'F360 OOL', 'ICL');
drop table COMPANY ;
create table COMPANY
    (NAME CHAR(20), PRODUCT CHAR(10) );
insert into COMPANY values ('IBM', 'COMPUTERS');
insert into COMPANY values ('FORD', 'CARS');
insert into COMPANY values ('ICL', 'COMPUTERS');
insert into COMPANY values ('ACME', 'TEAPOTS');
```

Below is an example rulebase that analyzes the database and outputs a suggestion as to which vehicle should be allocated to which person. The full code and the SQL statements to set up the database are included in the examples distributed with KnowledgeWorks.

```
(in-package "KW-USER")

;;;; the vehicle class maps onto the car table in the
;;;; database owner is a join slot which looks up the
;;;; owner person object

(sql:def-view-class vehicle
   ((number-plate :accessor vehicle-number-plate
                   :type (string 8)
                   :db-kind :key
                   :column plate)
    (make :accessor vehicle-make
           :type (string 20)
           :db-kind :base
           :column make)
    (price :accessor vehicle-price
           :type integer
           :db-kind :base
```

31
;; the person class maps onto the person table in the database
;; vehicle is a join slot which looks up the owned vehicle object
;; company is a join slot which looks up the company object

(sql:def-view-class person
  (sql:standard-db-object standard-kb-object)
  ((name :accessor person-name
        :type (string 20)
        :db-kind :key
        :column name)
   (salary :accessor person-salary
          :type integer
          :db-kind :base
          :column salary)
   (vehicle-number-plate :type (string 8)
                          :db-kind :base
                          :column vehicle)
   (vehicle :accessor person-vehicle
            :db-kind :join
            :db-info (:home-key vehicle-number-plate
                      :foreign-key number-plate
                      :join-class vehicle
                      :set nil
                      :retrieval :deferred))
   (employer :type (string 20)
             :db-kind :base
             :column employer)
   (company :accessor person-company
            :db-kind :join
            :db-info (:home-key employer
                      :foreign-key name
                      :join-class company
                      :set nil
                      :retrieval :deferred)))))

;; the company class maps onto the company table in the database

(sql:def-view-class company
  (sql:standard-db-object standard-kb-object)
  ((name :accessor company-name
        :type (string 20)
        :db-kind :key
        :column name)
   (product :accessor company-product
            :type (string 10)
            :db-kind :base
            :column product)))

;; here we assume we have a database connected with the correct data in it - if we do we retrieve all

32
the person and vehicle objects but company objects
will be retrieved only when needed by querying
the company slot of the person objects

;if sql:*default-database*
(progn
  (sql:select 'vehicle)
  (sql:select 'person))
(format t
  "~%Please connect to a database with
  contents ~ created by file data.sql")
;;; to store which vehicles a person can drive
(def-kb-struct vehicles-for-person person vehicles)
(defcontext database-example :strategy (priority))

;;; for every person initialize the list of vehicles they
;;; can drive
(defrule init-vehicles-for-person :forward
  :context database-example
  (person ?person vehicle nil)
  -->
  (assert (vehicles-for-person ?person ?person vehicles nil)))

;;; for every vehicle a person can drive which has not yet
;;; been included in the list, add it to the list
(defrule vehicle-for-person :forward
  :context database-example
  (person ?person vehicle nil)
  (vehicle ?vehicle owner nil)
  (vehicles-for-person ?c-f-p
    person ?person
    vehicles ?vehicles)
  (test (not (member ?vehicle ?vehicles)))
  ; has it been included?
  -->
  (vehicle-ok-for-person ?vehicle ?person)
  ; check if ok to drive vehicle
  (assert (vehicles-for-person ?c-f-p vehicles
    (?vehicle . ?vehicles))))

;;; rules expressing what vehicles a person can drive:
;;; if they have no employer they can only drive a
;;; Skoda otherwise they will refuse to drive a Skoda.
;;; anyone will drive a Rolls or a Jaguar.
;;; they'll only drive a Ford or Vauxhall if salary is
;;; less than 40k.
(defrule vehicle-ok-for-person :backward
  ((vehicle-ok-for-person ?vehicle ?person)
   <--
   (person ?person company nil)
   (cut)
   (vehicle ?vehicle make "SKODA")))
((vehicle-ok-for-person ?vehicle ?person)
 <--
 (vehicle ?vehicle make "SKODA")
 (cut)
 (fail))
((vehicle-ok-for-person ?vehicle ?person)
 <--
 (or (vehicle ?vehicle make "ROLLS")
     (vehicle ?vehicle make "JAGUAR")
     (cut))
((vehicle-ok-for-person ?vehicle ?person)
 <--

;;; next to rules are just simple allocation rules,  
;;; trying out each possibility until one fits

(defrule alloc-vehicles-to-persons :backward  
  ((alloc-vehicles-to-persons ?allocs)  
    <--  
    (alloc-internal nil nil nil ?allocs)))

(defrule alloc-internal :backward  
  ((alloc-internal ?done-persons ?done-vehicles  
                   ?allocs ?allocs)  
    <--  
    (not (and (vehicles-for-person ? person ?person)  
              (not (member ?person ?done-persons))))  
    (cut))  
  ((alloc-internal ?done-persons ?done-vehicles  
                   ?allocs-so-far ?allocs)  
    <--  
    (vehicles-for-person ? person ?person  
                         vehicles ?vehicles)  
    (not (member ?person ?done-persons))  
    (member ?vehicle ?vehicles)  
    (not (member ?vehicle ?done-vehicles))  
    (alloc-internal (?person . ?done-persons)  
                     (?vehicle . ?done-vehicles)  
                     (?person . ?vehicle) . ?allocs-so-far)  
                     ?allocs))))

;;; find a solution and print it out

(defrule find-solution :forward  
  :context database-example  
  :priority 5  
  (not (not (vehicles-for-person ?)))  
  -->  
  (alloc-vehicles-to-persons ?solution)  
  ((dolist (pair ?solution)  
     (format t "~A drives ~A"  
             (person-name (car pair))  
             (vehicle-number-plate (cdr pair)))))

Below is sample output from the rulebase with SQL recording turned on to demonstrate the SQL statements that are automatically passed to the database by manipulating the objects:

KW-USER 53 > (infer :contexts '(database-example))  
(SELECT VEHICLE.PLATE, VEHICLE.MAKE, VEHICLE.PRICE, VEHICLE.OWNER FROM VEHICLE  
WHERE (VEHICLE.PLATE = 'F360 OOL'))  
(SELECT VEHICLE.PLATE, VEHICLE.MAKE, VEHICLE.PRICE, VEHICLE.OWNER FROM VEHICLE  
WHERE (VEHICLE.PLATE = ''))  
(SELECT VEHICLE.PLATE, VEHICLE.MAKE, VEHICLE.PRICE, VEHICLE.OWNER FROM VEHICLE  
WHERE (VEHICLE.PLATE = ''))  
(SELECT PERSON.NAME, PERSON.SALARY, PERSON.VEHICLE, PERSON.EMPLOYER  
FROM PERSON WHERE (PERSON.NAME = ''))  
(SELECT VEHICLE.PLATE, VEHICLE.MAKE, VEHICLE.PRICE, VEHICLE.OWNER FROM VEHICLE  
WHERE (VEHICLE.PLATE = ''))  
(SELECT PERSON.NAME, PERSON.SALARY, PERSON.VEHICLE, PERSON.EMPLOYER  
FROM PERSON WHERE (PERSON.NAME = ''))  
(SELECT VEHICLE.PLATE, VEHICLE.MAKE, VEHICLE.PRICE, VEHICLE.OWNER FROM VEHICLE
WHERE (VEHICLE.PLATE = '')
(SELECT PERSON.NAME, PERSON.SALARY, PERSON.VEHICLE, PERSON.EMPLOYER
FROM PERSON WHERE (PERSON.NAME = ''))
(SELECT PERSON.NAME, PERSON.SALARY, PERSON.VEHICLE, PERSON.EMPLOYER
FROM PERSON WHERE (PERSON.NAME = 'PERSEPHONE'))
(SELECT COMPANY.NAME, COMPANY.PRODUCT FROM COMPANY
WHERE (COMPANY.NAME = 'FORD'))
(SELECT COMPANY.NAME, COMPANY.PRODUCT FROM COMPANY
WHERE (COMPANY.NAME = 'ACME'))
(SELECT COMPANY.NAME, COMPANY.PRODUCT FROM COMPANY
WHERE (COMPANY.NAME = 'IBM'))

HARRY drives E265 FOO
TOM drives XDG 792S
FRED drives H151 EEE
PHOEBE drives G722 HAD

4.3 KnowledgeWorks Structures

An optimization for improved performance is to replace CLOS objects by KnowledgeWorks structures when the objects are not needed outside the rules, or the full power of object-oriented programming is not required. Within rules they behave the same, although they are not proper CLOS objects. This is discussed in detail in 6.2 Optimization.
5 The Programming Environment

The KnowledgeWorks programming environment is designed for the development of rules. KnowledgeWorks applications will typically contain a mixture of programming styles and so the LispWorks programming environment is available from the menus on the KnowledgeWorks Podium. This chapter deals with KnowledgeWorks specific tools but see the LispWorks IDE User Guide for more details on the LispWorks tools.

KnowledgeWorks Podium

All KnowledgeWorks windows except the Podium can be closed independently of the others. You can switch between windows by choosing Works > Windows > window-name.

5.1 The KnowledgeWorks Listener

KnowledgeWorks Listener

The KnowledgeWorks Listener is obtained by choosing KnowledgeWorks > Listener. This tool is based on the LispWorks Common Prolog Logic Listener (see Appendix A: Common Prolog for further details). Input is taken as being a goal expression to be satisfied unless no predicate of that name and arity (number of arguments) exists in which case it is taken as a Lisp expression. That is, the input may be either:

<expression>

as defined in 3.1 Forward chaining, or:
with the former interpretation taking priority when ambiguous. Interaction is Prolog-style, so when the bindings which satisfy a goal are printed, pressing \textbf{Return} terminates execution, and entering ; (semi-colon) and \textbf{Return} (or just clicking on the \textbf{Next} button at the bottom) looks for the next solution to the goal.

The \textbf{File}, \textbf{Leashing} and \textbf{Spy} menus behave as for the Common Prolog Logic Listener (see \textit{Appendix A: Common Prolog}) and the \textbf{Values}, \textbf{Debug} and \textbf{History} menus behave as for the Lisp Listener (see the \textit{LispWorks IDE User Guide}).

5.2 The Editor

KnowledgeWorks Editor

The KnowledgeWorks Editor is created by choosing \textbf{KnowledgeWorks > Editor}. It is the same as the LispWorks Editor tool. Please see the \textit{LispWorks IDE User Guide} for more information on the editor tool and the \textit{Editor User Guide} for information on the various editing commands.

5.3 Clearing KnowledgeWorks

The KnowledgeWorks object base (all the KnowledgeWorks CLOS objects and any optimized structures) may be cleared by choosing \textbf{Memory > Clear Objects} from the KnowledgeWorks Listener, or by calling the function \texttt{reset}.

KnowledgeWorks rules may be cleared by choosing \textbf{Memory > Clear Rules} from the KnowledgeWorks Listener, or by calling the function \texttt{clear-rules}. Clearing the rules does not remove the default context \texttt{default-context} but all the rules in it are removed.

KnowledgeWorks object base and rules may be cleared by choosing \textbf{KnowledgeWorks > Memory > Clear Objects and Rules} from the KnowledgeWorks Listener, or by calling the function \texttt{clear-all}. CLOS class definitions remain in effect.
5.4 The System Browser

The KnowledgeWorks system browser is obtained by choosing KnowledgeWorks > Systems. It is the same as the LispWorks System Browser, but includes new types of system:

- :kb-system, which are reloaded when the KnowledgeWorks rules are cleared (see 5.3 Clearing KnowledgeWorks).
- :kb-init-system, which are reloaded when the KnowledgeWorks object base is cleared (see 5.3 Clearing KnowledgeWorks).


5.5 The Class Browser
KnowledgeWorks Class Browser

The Class Browser is obtained by choosing **KnowledgeWorks > Classes**. It is the same as the LispWorks Class Browser except that:

- It appears with an initial focus on **standard-kb-object**.
- When looking at a KnowledgeWorks class the **Works > Classes** menu and context menu contain an **Inspect Instances** command which allows you to look at the instances of the class.
Inspecting instances from the Class Browser

This raises an Inspector tool with a list of all the instances.
Any of the instances displayed in the lower pane may itself be inspected by double-clicking on it.

Other options available in the Class Browser include:

- **Superclasses** and **Subclasses** tabs to draw a graphs of the superclasses or subclasses of the class being looked at.
- **Slots** and **Initargs** tabs to show how the instances can be accessed and initialized.
- **Functions** tab to show the generic functions or methods defined on this class, either directly or by inheritance.

Additionally the **Works > Classes** menu contains a **Browse Metaclass** command which browses the class of this class.

Further details can be found in the *LispWorks IDE User Guide*.

### 5.6 The Objects Browser
KnowledgeWorks Objects Browser

The Objects Browser is obtained by choosing KnowledgeWorks > Objects. Any <expression> (See 3.1 Forward chaining) may be entered into the Query pane. This expression may be a query about the object base or any expression for the backward chainer to prove. The Pattern pane contains the pattern to be instantiated for each solution of the query. If left blank, the pattern used is the query itself.

The Show Inferencing State dropdown allows you to choose which named inferencing state is used to supply the object base for the query.

The Preset query/pattern pane offers a convenient way to examine instances on a per-class basis. All the instances of a class class-name known to KnowledgeWorks (either a CLOS class or a KnowledgeWorks structure class) may be examined by selecting class-name, and all the instances in the object base may be viewed by selecting All classes.

The package used to read and print symbols may be modified by choosing Tools > Preferences... > Objects Browser > Package and entering a package name into the Package pane. Clicking OK will update the tool.

The pane below the query displays all the instantiations of the query, and if the entries refer to an object (so are of the form (<class-name> <object> ...) or just <object>) double-clicking on them will display the slot names and values, and information on when the object was created or modified (if debugging is turned on) in the bottom pane. The selected query item may be inspected by choosing Works > Instantiations > Inspect.

The Objects Browser may be updated by positioning the mouse in either the Query or the Pattern pane and pressing Return or by choosing Tools > Refresh.
5.7 The Rule Browser

KnowledgeWorks Rule Browser

The Rule Browser may be obtained by choosing KnowledgeWorks > Rules. It displays contexts and their rules. The Contexts pane at the top allows you to select from a drop-down list either a forward chaining context or the special pseudo-context containing all the backward chaining rules. The Rules pane lists the rules for the selected context.

The Works > Context menu acts on the selected context. Choosing Works > Context > Find Source will bring up the definition of the context in the file where it was defined, and choosing Works > Context > Gspy will bring up a Spy Window (see 5.8 Debugging with the Environment) for the context, displaying the meta-interpreter (see 6.1.1 Meta Rule Protocol) for the context if one is defined. If debugging is turned on a meta-interpreter is always defined. Choosing Works > Context > NoGspy will remove the Spy Window (see 5.8 Debugging with the Environment).

The Works > Rule menu acts on the rule selected in the lower pane. All rules may be edited by choosing Works > Rule > Find Source. Spy Windows can be brought up or removed by choosing Works > Rule > Gspy. Forward chaining rules may have Monitor Windows (see 5.8 Debugging with the Environment) brought up or removed by choosing Works > Rule > Monitor (this command is disabled when a backward chaining rule has been selected). These are explained in 5.8 Debugging with the Environment.

The package used for displaying symbols may be modified by choosing Tools > Preferences... > Rule Browser > Package and entering a package name into the Package area. Clicking OK will update the tool.

5.8 Debugging with the Environment

5.8.1 Spy Windows
Spy Windows display graphically the actions or subgoals a rule (either forward or backward chaining) will invoke when it fires. A Spy Window may be obtained by selecting a rule in the Rule Browser and choosing Works > Rule > Gspy or choosing Gspy from the context menu. or by choosing KnowledgeWorks > Spy > Gspy in the KnowledgeWorks Listener.Spying can be cancelled by closing the Spy Window or by choosing KnowledgeWorks > Spy > NoSpy or KnowledgeWorks > Spy > NoSpy All from the KnowledgeWorks Listener.

Selecting one of the graph nodes in the top pane of the Spy Window displays the full text of the box in the pane below. Choosing Gspy from the context menu brings up a Spy Window for the goal in the box.

When the rule being displayed fires, execution stops and the buttons at the bottom of the KnowledgeWorks Listener allow the rule to be single-stepped. Clicking on the Creep button steps through the rule, and Leap advances to the end of the rule (unless any of the intervening goals invoke another rule which has been spied). When single-stepping, a highlight marks the action or goal being performed. When execution is suspended in this manner, any of the KnowledgeWorks tools or browsers may be used.

More details on single stepping through rules are in Appendix A: Common Prolog.

5.9 Monitor Windows
Monitor Windows allow the preconditions of forward chaining rules to be monitored. They may be obtained by choosing Work > Rule > Monitor or by choosing KnowledgeWorks > Spy > Monitor Rule from the KnowledgeWorks Listener.

The top part of the window is the Select instantiations pane, as described below. The lower part displays a list of either fired or unfired instantiations. This list is not kept up to date if the rulebase is executing with debugging turned off. To examine a binding in a displayed instantiation, select the corresponding line and choose Work > Instantiations > Inspect. This shows the objects themselves in a LispWorks Inspector tool, so double-clicking on one of the entries will cause that entry to be inspected. See the LispWorks IDE User Guide for more details.

The Show Inferencing State dropdown allows you to choose which named inferencing state is used to find the instantiations.

When the All Unfired Instantiations button is selected, the unfired instantiations are displayed.

When the Matching Selected Conditions button is selected, the instantiations that match all of the selected preconditions are displayed. The topmost shows the preconditions of the rule. Any conditions that are matched by the object base are highlighted. This highlighting means the condition is matched without reference to any of the other conditions. A message indicates the number of instantiations matching the highlighted preconditions. A group of preconditions matched individually (hence highlighted) may not be matched together if, for instance, variables were bound across them.

If a rule has the conditions, for example:

\[
\begin{align*}
&\text{(person ?person1 father ?person)} \\
&\text{(person ?person2 son ?person)} \\
&\text{(test (not (eq ?person nil)))}
\end{align*}
\]

these would be displayed in the top pane of the Rule Monitor Window. The first two would be highlighted if the object base contained a person object. But instantiations would only be displayed if there was a person object with the same father value as some (other) person object has son.

The selection of conditions may be toggled by left-clicking. So in the above example the last condition could be selected also by clicking on it, and there would be no instantiations displayed if the only consistent value of ?person was nil.
5.9.1 Forward Chaining History

KnowledgeWorks Forward Chaining History

The Forward Chaining History may be viewed by choosing KnowledgeWorks > FC History. This displays the rules which the forward chaining engine has fired. The left pane lists sequentially the contexts which have been executed, with the cycle number in which they were entered. These can be clicked on to show in the right pane, the history for that context. The rules in it are listed down the left, and the cycle numbers along the top, forming a two dimensional grid.

Each position in the grid indicates the status of the rule in that cycle. A colored box indicates that the rule fired. A half-colored box indicates that the rule fired, but that the invocation of the backward chainer on the right-hand side failed at some point. There can only be one colored or half-colored box per cycle. An outlined box indicates that the rule was in the conflict set but was not chosen to fire. Absence of any icon indicates that the rule was not even in the conflict set.

If the forward chaining history is displayed while a rule is executing (for example, while the rule is being single stepped) a half-colored box is displayed as execution is not complete.

The Works > Rule menu can be used in the same way as in the Rule Browser, described in 5.7 The Rule Browser. It applies to the selected rule in the FC Cycles pane.

The Show Inferencing State dropdown allows you to choose which named inferencing state is examined.

This tool is not available when debugging is turned off.
6 Advanced Topics

6.1 Control Flow

6.1.1 Meta Rule Protocol

The meta rule protocol (MRP) reifies the internal actions of the forward chainer in terms of backward chaining goals. This allows the user to debug, modify, or even replace the default behavior of the forward chainer. The basic hooks into the Forward Chaining Cycle provided by the MRP include conflict resolution and rule firing. Each context may have a meta-rule defined for it which behaves as a meta-interpreter for that context. For example, if no meta-rule is defined for a context it behaves as if it were using the following meta-rule:

\[
\text{(defrule ordinary-context :backward}
\text{ ((ordinary-context}
\text{ <--}
\text{ (start-cycle)
\text{ (instantiation ?instantiation)
\text{ (fire-rule ?instantiation)
\text{ (cut)
\text{ (ordinary-context)))})}
\]

This rule describes the actions of the forward chaining cycle for this context. Firstly \text{start-cycle} performs some internal initializations and updates the conflict set. It is essential that this is called at the start of every cycle. Next the preferred instantiation is selected from the conflict set by the call to \text{instantiation} and is stored in the variable \text{?instantiation}. The rule corresponding to this is fired (by \text{fire-rule}) and the recursive call to \text{ordinary-context} means that the cycle is repeated. The \text{cut} is also essential as it prevents back-tracking upon failure. Failure occurs when there are no more instantiations to fire (the \text{instantiation} predicate fails) and this causes control to be passed on as normal.

A meta-rule may be assigned to a context with the \text{:meta} keyword of the \text{defcontext} form. The argument of the \text{:meta} keyword is the list of actions to be performed by the context. For example, a context using the above ordinary meta-interpreter can be defined by:

\[
\text{(defcontext my-context :meta ((ordinary-context)))}
\]

This implicitly defines the rule:

\[
\text{(defrule my-context :backward}
\text{ ((my-context}
\text{ <--}
\text{ (ordinary-context)))})
\]

and whenever this context is invoked, the rule of the same name is called. The context could equally well have been defined as:

\[
\text{(defcontext my-context :meta}
\text{ ((start-cycle)
\text{ (instantiation ?instantiation)
\text{ (fire-rule ?instantiation)
\text{ (cut)
\text{ (my-context)))})}
\]
Sometimes it is useful to manipulate the entire conflict set. For this purpose the action \((\text{conflict-set } ?\text{conflict-set})\) will return the entire conflict set in the given variable, in the order specified by the context's conflict resolution strategy. The actions:

\[
\begin{align*}
\text{(conflict-set } ?\text{conflict-set}) \\
\text{(member } ?\text{instantiation } ?\text{conflict-set})
\end{align*}
\]

are equivalent to:

\[
\text{(instantiation } ?\text{instantiation})
\]

although the latter is more efficient.

Now that the user has access to the instantiations of rules, functions are provided to examine them.

### 6.1.1.1 Functions defined on Instantiations

The following functions may be called on instantiations:

\[
\begin{align*}
\text{(inst-rulename } \text{instantiation}) \\
\text{(inst-token } \text{instantiation}) \\
\text{(inst-bindings } \text{instantiation})
\end{align*}
\]

which returns the name of the rule of which this is an instantiation. The function \((\text{inst-token } \text{instantiation})\) which returns the list of objects (the token) which match the rule. These appear in reverse order to the conditions they match. The function \((\text{inst-bindings } \text{instantiation})\) which returns an a-list of the variables matched in the rule and their values.

### 6.1.1.2 A Simple Example

This meta-rule displays the conflict set in a menu to the user and asks for one to be selected by hand on each cycle. Note that we have to check both that there were some instantiations available, and that the user selected one (rather than clicking on the Abort button).

\[
\text{(defrule manual-context :backward}
\]

\[
\begin{align*}
&\text{(manual-context)} \\
&\text{\quad \langle--} \\
&\text{(start-cycle)} \\
&\text{(conflict-set } ?\text{conflict-set}) \\
&\text{(test } ?\text{conflict-set}) \\
&\quad \text{; are there any instantiations?} \\
&\text{(select-instantiation } ?\text{conflict-set}) \\
&\text{?instantiation) \\
&\text{(test } ?\text{instantiation}) \\
&\quad \text{; did the user pick one?} \\
&\text{(fire-rule } ?\text{instantiation)} \\
&\text{(cut)} \\
&\text{(manual-context)})
\end{align*}
\]

where the function \textbf{select-instantiation} could be defined as:

\[
\text{(defun select-instantiation } \text{conflict-set)} \\
\text{(tk:scrollable-menu } \text{conflict-set}
\]

\[
48
\]
6 Advanced Topics

Now a context could be defined by:

(defcontext a-context :strategy ()
  :meta ((manual-context)))

6.1.1.3 A Simple Explanation Facility

Meta-rules can also be used to provide an explanation facility. A full implementation of the explanation facility described here is included among the examples distributed with KnowledgeWorks, and is given also in B.2 Explanation Facility.

Suppose we have a rule about truck scheduling of the form:

(defrule allocate-truck-to-load :forward
  (load ?l size ?s truck nil destination ?d location ?loc)
  (test (not (eq ?d ?loc)))
  (truck ?t capacity ?c load nil location ?loc)
  (test (> ?c ?s))
  (assert (truck ?t load ?l))
  (assert (load ?l truck ?t)))

and we wish to add an explanation by entering a form like:

(defexplain allocate-truck-to-load
  :why (~S has not reached its destination ~S and ~ does not have a truck allocated, ~ does not have a load allocated, and ~ with capacity ~S is able to carry the load, ~ and both are at the same place ~S
  :what (~S is scheduled to carry ~S to ~S
  ?t ?l ?d)
  :because (~A customer requires ~S to be moved to ~S
  ?l ?d))

where the :why form explains why the rule is allowed to fire, the :what form explains what the rule does and the :because gives the ultimate reason for firing the rule.

The stages in the implementation are as follows:

• Define a macro called defexplain to store the explanation information in, say, a hash-table keyed against the rule name.

• Define a function add-explanation takes an instantiation, fetches the explanation information from the hash-table and the variable bindings in the instantiation, and adds the generated explanations to another global data structure, something like:

(defun add-instantiation (inst)
  (let ((explain-info (gethash (inst-rulename inst)
     *explain-table*))))
    (when explain-info

Implement graphical tools to browse the resulting explanations.

Define a meta-interpreter for which will produce explanations, for example:

```
(defrule explain-context :backward
  ((explain-context)
   <--
   (start-cycle)
   (inst-binding ?inst)
   ((add-explanation ?inst))
   (fire-rule ?inst)
   (cut)
   (explain-context)))
```

### 6.1.1.4 Reasoning with Certainty Factors

Another application of meta-rules is in the manipulation of uncertainty. A full implementation of the uncertain reasoning facility described below is included among the examples distributed with KnowledgeWorks, and also in [B.3 Uncertain Reasoning Facility](#).

In this example, we wish to associate a **certainty factor** with objects in a manner similar to the MYCIN system (see [Rule-Based Expert Systems](#), B. G. Buchanan and E. H. Shortliffe, Addison-Wesley 1984). When we assert an "uncertain" object we wish it to acquire the certainty factor of the instantiation which is firing. We define the certainty factor of an instantiation to be the certainty factor of all the objects making up the instantiation multiplied together. Additionally, we wish rules to have a **implication strength** associated with them which is a multiplicative modifier to the certainty factor obtained by newly asserted uncertain objects. The general approach is as follows:

- Define global variables *c-factor* to hold the certainty factor of the current instantiation and *implic-strength* to hold the implication strength of the rule, and a class of "uncertain" KnowledgeWorks objects:

  ```
  (def-kb-class uncertain-kb-object ()
    *((c-factor :initform (* *c-factor* *implic-strength*)
                 :accessor object-c-factor))
  )
  ```

  The uncertain objects should contain this class as a mixin.

- Define a function to obtain the certainty factor of instantiations:

  ```
  (defun inst-c-factor (inst)
    (reduce '* (inst-token inst) :key 'object-c-factor)
  )
  ```

- Define a conflict resolution tactic to prefer either more or less certain instantiations (See [6.1.2 User-definable Conflict Resolution](#) for details).

- Define a meta-rule to set the global certainty factor to the certainty factor of the instantiation about to fire:

  ```
  (defrule uncertain-context :backward
    ((uncertain-context)
     <--
     (start-cycle)
     (inst-binding ?inst)
     ((setq *c-factor* (inst-c-factor ?inst)))
     (fire-rule ?inst)
     (cut)
     (uncertain-context)))
  ```
Define a function implication-strength which sets the variable `implic-strength` so that rules may set their implication strength by calling the action:

```lisp
((implication-strength <number>))
```

A rule could be defined similarly to:

```lisp
(deffrule my-rule :forward
  (my-class ?obj1)
  (my-class ?obj2)
  -->
  ((implication-strength 0.6))
  (assert (my-class ?obj3)))
```

where the certainty factor of the new object `?obj3` will automatically become:

```lisp
(* (object-c-factor ?obj1) (object-c-factor ?obj2) 0.6)
```

While this is an extremely simplistic version of uncertain reasoning, it suggests how a more elaborate treatment might be approached.

### 6.1.2 User-definable Conflict Resolution

A conflict resolution strategy is a list of conflict resolution tactics. A conflict resolution tactic is a function which takes as arguments two rule instantiations, and returns `t` if and only if the first is preferred to the second, otherwise `nil`. A conflict resolution tactic may be defined by:

```lisp
(deftactic <tactic-name> {<type>} <lambda-list> [<doc-string>] <body>)
```

where `<tactic-name>` is the name of the tactic and of the function being defined which implements it, and `<lambda-list>` is a two argument lambda-list. `<type>` may be either :static or :dynamic, defaulting to :dynamic. A dynamic tactic is one which looks into the objects which match the rule to make up the instantiation; a static one does not. For example, a tactic which prefers instantiations which match, say, truck objects to instantiations which do not could be defined as static. However, if it looks into the slot values of the truck object it should be defined as dynamic. Static tactics are treated more efficiently but wrongly declaring a tactic as static will lead to incorrect conflict resolution. If `doc-string` is given, then it should be a string. The value can be retrieved by calling the function `documentation` with doc-type function.

It is an absolute requirement that there exist no instantiations for which:

```lisp
(<tactic-name> <instantiation1> <instantiation2>)
```

and:

```lisp
(<tactic-name> <instantiation2> <instantiation1>)
```

both return `t`. Consequently, for any single given instantiation:

```lisp
(<tactic-name> <instantiation> <instantiation>)
```

must return `nil`.

The function which defines a conflict resolution tactic should be computationally cheap as it is used repeatedly and frequently to compare many different pairs of instantiations.
6.1.2.1 Examples

The following tactic prefers instantiations with truck objects to ones without:

```
(deftactic prefer-trucks :static (inst1 inst2)
  (flet ((truck-p (obj) (typep obj 'truck)))
    (and (some #'truck-p (inst-token inst1))
      (notany #'truck-p (inst-token inst2))))))
```

Note that this tactic would be incorrect if we did not check that the second instantiation does not refer to any trucks (otherwise it would always return `true` if both instantiations contain trucks). It can safely be declared as static as it does not look into the slots of the objects which make up the instantiation.

This tactic implements alphabetical ordering on rule names:

```
(deftactic alphabetical-rulename :static (inst1 inst2)
  (string< (symbol-name (inst-rulename inst1))
            (symbol-name (inst-rulename inst2))))
```

This tactic prefers instantiations which bind the variable `?x` to zero:

```
(deftactic prefer-?x=0 :dynamic (inst1 inst2)
  (flet ((fetch-?x (inst)
      (cdr (assoc '?x (inst-bindings inst))))
    (and (eql 0 (fetch-?x inst1))
      (not (eql 0 (fetch-?x inst2))))))
```

Note that again we must not forget to check that `?x` is not zero in the second instantiation. This tactic must be declared dynamic as `?x` must have been instantiated from the slots of one of the matched objects.

The final tactic is for the example of uncertain reasoning and implements a method of preferring "more certain" instantiations:

```
(deftactic certainty :dynamic (inst1 inst2)
  (> (inst-c-factor inst1) (inst-c-factor inst2)))
```

This tactic must be dynamic if the certainty factors of objects can be modified after creation. If this is forbidden the tactic could be defined as static. Then the context defined by:

```
(defcontext my-context :strategy (priority certainty))
```

will prefer instantiations of rules with higher priority or, if this does not discriminate sufficiently, instantiations which are "more certain".

6.2 Optimization

6.2.1 Forward Chaining

6.2.1.1 KnowledgeWorks Structures

A CLOS class may be replaced by a structure for increased speed when all the power of CLOS is not needed. Within the rule interpreter the structure behaves like a CLOS class which:

- Has an initform of `nil` for each slot.
6 Advanced Topics

- Has the keyword version of the slot name as initarg for each slot.
- Has only single inheritance.
- Has no methods defined on it.
- Should not be modified from Lisp after its creation.

A KnowledgeWorks structure is defined by the macro:

```
(def-kb-struct <class-spec> <slot-spec>*
```

where the arguments are the same as for `defstruct` except that in `<class-spec>` only the options `:include` and `:print-function` are allowed. A structure may only be included in a KnowledgeWorks structure if it too is a KnowledgeWorks structure defined by `def-kb-struct`. All the functions normally provided by `defstruct` (accessors, a predicate etc.) are generated. An instance of the structure class may be created by the generic function:

```
(make-instance <class-name>
    {<slot-specifier> <value>}*)
```

where `<slot-specifier>` is the keyword version of the slot name, as with any structures, and `<value>` is the value the slot is to take, otherwise defaulting to the value specified in the `def-kb-struct` form. If created from Lisp by any means other than `make-instance` (for example, by the automatically defined `make-<structure-name>` constructor), the inference engine will not know about the structure.

Once created, structures must not be modified directly from Lisp as this will corrupt the state of the forward chaining inference engine. For example:

```
(def-kb-struct train position speed)
(def-kb-struct signal position color)
(make-instance 'train :position 0 :speed 80)
(make-instance 'signal :position 10 :color 'red)
```

defines KnowledgeWorks structures for trains and signals and makes an instance of each. Note that they are not fully-fledged CLOS objects but are analogous to working memory elements in OPS5.

### 6.2.1.2 Efficient Forward Chaining Rule Preconditions

Forward chaining rules are more efficient if the more restrictive preconditions (that is, the ones which will have fewer matches) are written first. Computationally cheap Lisp tests should be used wherever possible as they reduce the search space of the rule interpreter. The Lisp tests should where possible be broken into sufficiently small pieces that they can be applied as early on as possible.

For example, the precondition fragment:

```
(train ?t position ?p1)
(test (> ?p1 5))
(signal ?s position ?p2)
(test (> ?p2 6))
```

is better than:

```
(train ?t position ?p1)
(signal ?s position ?p2)
(test (and (> ?p1 5) (> ?p2 5)))
```

because in the first example the Lisp tests can be applied directly to the trains and signals respectively before looking at
combinations of trains and signals, whereas in the second case all the combinations must be produced before the Lisp test can be applied. Simply separating the tests is enough for the rule compiler to apply them to the right object base matches — the precise order of the tests is unimportant.

### 6.2.1.3 Profiling

You can use the profiler to profile forward chaining rules. See `set-up-profiler` in the *LispWorks® User Guide and Reference Manual*.

### 6.2.2 Conflict Resolution

#### 6.2.2.1 Use of Contexts

The single most significant way to improve conflict resolution time is to divide the rulebase up into contexts. The time taken by conflict resolution is dependent on the total number of instantiations of all the rules in the context so the fewer rules in each context, the more efficient conflict resolution will be.

#### 6.2.2.2 Optimization of the Strategy

A conflict resolution strategy may be optimized by combining the constituent tactics in a more effective manner. There are three different types of conflict resolution tactic:

- **Rule-defined** (meaning the tactic relies only on the rule of the instantiation and on nothing else), including `priority`, `-priority`, `order`, `-order`, `specificity` and `-specificity`.
- **Static** (meaning the tactic does not look into the slots of the matched objects which make up the instantiation), including `recency` and `-recency`.
- **Dynamic** (meaning the tactic may look into the objects making up the instantiation), including `mea`, `-mea`, `lex` and `-lex`.

KnowledgeWorks is best able to optimize rule-defined tactics and least able to optimize dynamic tactics. The optimizations for a particular type of tactic can only be applied if it is preceded only by tactics which can be optimized to the same degree (or better). For example, in the strategy `(recency priority)`, the tactic `priority` would only be optimized as a static tactic. In the strategy `(priority mea recency)`, `priority` can be optimized as a rule-defined tactic but `recency` will be treated as a dynamic tactic.

Some final points to bear in mind:

- Tactics which tend to prefer existing instantiations over newer ones (for example `-mea`, `-lex` and `-recency`) will degrade performance.

- `recency` and `lex` have similar functionality but `recency` is more efficient.

### 6.2.3 Backward Chaining

#### 6.2.3.1 Pattern Matching

The KnowledgeWorks Backward Chainer indexes clauses for a backward rule based on the first argument. If the first arguments to backward rule clauses are distinct non-variables, the backward chainer can pre-select possible matching clauses for a call.

For example, in the following rule:
The call: `(age-of james ?x)` would jump directly to the third clause and bind ?x to 28 without trying the other two.

The call: `(age-of tom ?x)` would fail immediately without doing any pattern matching.

Clauses are distinguished first by the types and then the values of their first arguments.

### 6.2.3.2 Tail Recursion

The KnowledgeWorks Backward Chainer supports the transformation of "tail-recursive" calls into jumps. Thus, stack overflow can be avoided without resorting to "repeat, fail" loops in most cases. For example, given the definition:

```lisp
(defrule run-forever :backward
  ((run-forever)
   <--
   (run-forever)))
```

the call: `(run-forever)` will run forever without generating a stack overflow. Note that this optimization is not limited to recursive calls to the same rule. The last call of any rule will be compiled as a jump, drastically reducing stack usage.

### 6.2.3.3 Cut

The use of "cut" is a well known performance enhancement for Prolog-style rules. In KnowledgeWorks it does more than reduce the time spent in search. When a "cut" is invoked, all the stack space between the initial call to the containing rule and the current stack location is reclaimed immediately, and can have a significant impact on the total space requirements of a program.

### 6.3 Use of Meta-Classes

Objects of meta-classes other than `standard-class` may be made available to KnowledgeWorks by including the KnowledgeWorks mixins `standard-kb-object`. This requires:

- The existence of a `validate-superclass` method allowing `standard-kb-object` (meta-class `standard-class`) to be a superclass of the class being defined with a different meta-class.
- That the meta-class in question does not implement any particularly strange behavior on slot access, for example, if querying a slot value results in setting it.

#### 6.3.1 Example

A meta-class `standard-kb-class` could be defined as a KnowledgeWorks class. New KnowledgeWorks classes (or even ordinary non-KnowledgeWorks classes) could be defined with this meta-class. KnowledgeWorks could then reason about the instances of the classes and about the class objects themselves. The code below implements this:

```lisp
(def-kb-class standard-kb-class (standard-class) ()
  (defmethod validate-superclass
    ((class standard-kb-class)
     (superclass standard-class))
    t)
  (def-kb-class foo () ((slot))
    (:metaclass standard-kb-class))
```
Then when the following rule fires:

```lisp
(defrule find-kb-class :forward
  (standard-kb-class ? clos::name ?n)
  -->
  ((format t "~%I can reason about class ~s" ?n)))
```

it will output:

I can reason about class FOO

### 6.4 Logical Dependencies and Truth Maintenance

When a rule creates an object that depends on a specific set of preconditions, it is sometimes necessary to erase that object when those preconditions no longer hold. This is an example of truth maintenance.

KnowledgeWorks provides a mechanism to track logical dependencies between objects and preconditions which cause any dependent objects to be erased automatically. This is achieved using a **logical** clause in a forward chaining rule, with a precondition of the form:

```
(logical <forward-condition>+)
```

The enclosed forward conditions in this clause are matched as normal, but if the rule fires and creates new objects (by `assert` or `make-instance`) then these objects are associated with the enclosed conditions. If the conditions are found to be false in the future, then the created objects are erased automatically (see `erase`).

**NB:** There can be at most one logical clause in a rule (though it can contain multiple subclauses) and it must be the first clause in the rule. Other clauses can follow the logical clause, but they are not part of the logical dependency.

#### 6.4.1 Example

Given the following classes and rules:

```lisp
(def-kb-class number-object ()
  ((value :initarg :value)))

(def-kb-class have-some-large-numbers ()
  ()
)

(defrule notice-a-large-number :forward
  (logical (number-object ? value ?value)
    (test (> ?value 100))
  -->
  (assert (have-some-large-numbers ?)))
```

then a **have-some-large-numbers** object will be created when a number larger than 100 exists:

```lisp
(setq n1 (make-instance 'number-object :value 10))
(infer)
(any '?x '(have-some-large-numbers ?x)) ==> false
(setf (slot-value n1 'value) 200) ; this is large
(infer)
(any '?x '(have-some-large-numbers ?x)) ==> true
```

In addition, when the large number becomes smaller, the **have-some-large-numbers** object will be erased again:
because a logical dependency was tracked between the preconditions:

\[ \text{(number-object ?value ?value)} \]
\[ \text{(test (> ?value 100))} \]

and the \text{have-some-large-numbers} object.

### 6.5 Inferencing States

An \text{inferencing state} represents all the state needed to run the forward chaining interpreter, including the object base, the current cycle number and the set of unfired instantiations. It does not include rule or context definitions or any backward chaining state information.

#### 6.5.1 Creating and Maintaining Inferencing States

Inferencing states are first-class objects that can be created and destroyed as required. Each inferencing state must have a unique name (as compared with \text{eq}) and initially there is a single inferencing state named \text{:default}.

The function \text{make-inferencing-state} makes a new empty inferencing state. Inferencing states must be destroyed with \text{destroy-inferencing-state} when no longer needed, to release the memory that they use.

Inferencing states can be found using the function \text{find-inferencing-state} and the function \text{list-all-inferencing-states} can be used to make a list of all known inferencing states.

#### 6.5.2 The Current Inferencing State

The value of the variable \text{*inferencing-state*} is known as the current inferencing state. Its value can be changed before calling KnowledgeWorks functions, but should not be changed within the body of a rule.

Some operations, such as object creation, slot modification, \text{reset} and \text{infer} only affect the current inferencing state. Backward chaining operations that match the object base only find objects from the current inferencing state.

Operations that change rules or contexts, such as \text{defrule} and \text{clear-all}, affect all inferencing states.

#### 6.5.3 Uses of Inferencing States

In many cases, a single inferencing state is sufficient and the initial inferencing state named \text{:default} can be used without any special effort.

To allow several independent inferencing operations to be performed simultaneously, multiple inferencing states must be managed explicitly. Some typical situations are described below.

#### 6.5.3.1 Multiple threads

By binding \text{*inferencing-state*} around all KnowledgeWorks operations in a thread's main function as in the example below, its value can be unique to each thread.

```lisp
(defun test-1-counter (name)
  (let* ((*inferencing-state* nil)
         (step (1+ (random 10))))
)```
(limit (* step (+ 2000 (random 100))))
(unwind-protect
  (progn
    (setq *inferencing-state*
      (make-inferencing-state name))
    (make-instance 'counter
      :value limit
      :step step)
    (infer))
  (destroy-inferencing-state *inferencing-state*))
)

(mp:process-run-function (format nil "Test ~D" index)
  ()
  'test-1-counter
  (gensym))

6.5.3.2 Interleaved in a Single Thread

By binding *inferencing-state* around specific KnowledgeWorks operations in a function as in the example below, multiple inferencing states can be maintained within a single thread.

(defun test-stepping-single-context ()
  (let ((state1 (make-inferencing-state 'state1))
        (state2 (make-inferencing-state 'state2)))
    (unwind-protect
      (progn
        (let ((*inferencing-state* state1))
          (make-instance 'step-controller
            :kb-name 'stepper-one-a))
        (let ((*inferencing-state* state2))
          (make-instance 'step-controller
            :kb-name 'stepper-one-b))
        (loop repeat 10
            do
              (let ((*inferencing-state* state1))
                (infer))
              (let ((*inferencing-state* state2))
                (infer))))
    (destroy-inferencing-state state1)
    (destroy-inferencing-state state2))))

58
The symbols documented in the following pages are all external in the KW package unless stated otherwise. They are listed in alphabetical order.

### all-debug

**Package**

kw

**Signature**

`all-debug`

**Description**

The function `all-debug` turns on all KnowledgeWorks debugging facilities. This means that rules and contexts can be single stepped and monitored, and a record is kept of whenever objects are created or modified.

This should be called before compiling any rules or contexts that are to be debugged.

**Examples**

```
(all-debug)
```

**See also**

`no-debug`

### any

**Summary**

Return the first match of a backward chaining goal.

**Package**

kw
any pattern-to-instantiate goal-to-prove => result, successp

Arguments

pattern-to-instantiate↓
A list or symbol.
goal-to-prove↓
Any backward chaining goal.

Values

result
nil or a value matching pattern-to-instantiate.
successp
A boolean.

Description

The function any starts the backward chaining inference engine to look for any set of bindings which satisfy goal-to-prove. Using those bindings, pattern-to-instantiate is instantiated and returned.

Two values are returned. The second value indicates with t that a proof was found, or with nil that no proof exists. In the former case, the first value is the instantiated version of pattern-to-instantiate, in the latter case, the first value is nil.

Any subgoals that match the object base will only find objects from the current inferencing state.

Examples

(any '(?x is in (1 2 3)) '(member ?x (1 2 3)))
returns (1 IS IN (1 2 3)), T.

(any '(?truck is a truck) '(truck ?truck))
returns (#<TRUCK TRUCK5> IS A TRUCK), T.

See also

findall

assert (class-name variable {slot-and-term}*)

Summary

Backward Chaining Goal

Creates or modifies objects in the object base.
slot-and-term ::= (slot-name term)

Arguments

class-name \(\downarrow\) The name of a class.

variable \(\downarrow\) A variable beginning with \(?\).

slot-name \(\downarrow\) The name of a slot in class-name.

term \(\downarrow\) An expression.

Description

The backward chaining goal \texttt{assert} creates or modifies objects in the object base.

class-name must be the name of a class of objects known to KnowledgeWorks. Each term is an expression composed of Lisp data structures and KnowledgeWorks variables.

If variable is unbound a new instance of class-name is created with each named slot-name initialized to the value of the corresponding term.

If variable is bound, that bound instance has its named slots modified to contain the values of term corresponding to each slot-name. It is an error if the bound object is not of the named class.

It is an error to put an unbound variable into a slot of an object in the object base.

Only objects in the current inferencing state will be affected.

Examples

\[
\begin{align*}
\texttt{(assert (truck ?truck driver ?driver))} \\
\texttt{(assert (possible-trucks ?trucks (?truck . ?trucks))}
\end{align*}
\]

See also \texttt{erase}

\begin{center}
\textbf{clear-all} \hspace{1cm} \textit{Function}
\end{center}

Summary

Clears all contexts, rules and objects.

Package

\texttt{kw}

Signature

\texttt{clear-all}

Description

The function \texttt{clear-all} clears all contexts, rules and objects. The list of KnowledgeWorks classes remains unaffected. The
default context `default-context` is not removed, but all rules in it are.

The function affects all inferencing states.

Examples

    (clear-all)

See also

`clear-rules`
`reset`

---

**clear-rules**

**Summary**

Clears all contexts and rules.

**Package**

`kw`

**Signature**

`clear-rules`

**Description**

The function `clear-rules` clears contexts and rules. The list of KnowledgeWorks classes and the object base remains unaffected. The default context `default-context` is not removed, but all rules in it are.

This function affects all inferencing states.

Examples

    (clear-rules)

See also

`clear-all`
`reset`

---

**conflict-set**

**Summary**

Finds the current meta-interpreter rule instantiations.
Package

kw

Signature

conflict-set variable

Arguments

variable An unbound KnowledgeWorks variable introduced by ?.

Description

The backward chaining goal conflict-set is only relevant when writing a meta-interpreter for a context. conflict-set binds variable to the list of all existing rule instantiations in the currently executing context. This list is in the order preferred by the conflict resolution strategy for the context.

Examples

(conflict-set ?conflict-set)

See also

instantiation

fire-rule

context

Backward Chaining Goal

Summary

Adds new contexts to the agenda.

Package

kw

Signature

context context-list

Arguments

context-list A list of context names.

Description

The backward chaining goal context adds new contexts context-list on top of the agenda (the context stack). The current context is not changed. It is an error if the named contexts do not exist.

If context-list contains variables, then they must be already bound.
Examples

```prolog
<context (my-context))
<context (?x ?y)); if ?x ?y bound to context names
```

See also

`return`

---

**current-cycle**

*Function*

Summary

Returns the current forward chaining cycle number.

Package

`kw`

Signature

```
current-cycle => cycle-number
```

Values

`cycle-number` An integer.

Description

The function `current-cycle` returns the current cycle number of the forward chaining rule interpreter in the current inferencing state. If the forward chaining rule interpreter is not running, then it returns the total number of cycles executed by the forward chaining rule interpreter the last time it ran. If the forward chaining rule interpreter has not run at all, then it return zero.

See also

`*inferencing-state*`

---

**cut**

*Backward Chaining Goal*

Summary

The standard prolog predicate that stops backtracking.

Package

`kw`

Signature

```
cut
```
The backward chaining goal cut is a standard prolog predicate. When first called it succeeds and freezes certain choices made by the backward chainer up to this point. It may no longer attempt to resatisfy any of the goals between the start of clause and the cut, and it may not attempt to use any other clauses to satisfy the same goal.

Examples

(defrule nice :backward
   ((nice ?x)
    <--
    (rottweiler ?x)
    (cut)
    (fail))
   ((nice ?x) <--))

implements "everything is nice unless it is a rottweiler". First the backward chainer will attempt to prove (nice fido) with the first clause. If fido is a rottweiler the cut then prevents the backward chainer from using the second clause which says "everything is nice". The fail ensures that (nice fido) fails.

See also

fail

cycle*

Symbol Macro

Summary
Deprecated.

Package
kw

Description
The symbol macro *cycle* is deprecated. New code should use current-cycle.

Prior to LispWorks 5.0, *cycle* was a variable.

See also

current-cycle

defcontext

Macro

Summary
Defines a context.
Package

KW

Signature

```
defcontext context-name &key refractoriness auto-return strategy meta documentation
```

Arguments

- `context-name`\: The name of the context being defined.
- `refractoriness`\: A boolean.
- `auto-return`\: A boolean.
- `strategy`\: A list of symbols.
- `meta`\: A list of actions.
- `documentation`\: A string.

Description

The macro `defcontext` defines a context named `context-name`. If a context of that name already exists then it, and all the rules in it, are first removed.

If `refractoriness` is `nil` then a rule instantiation remains eligible to fire again after firing once. If `refractoriness` is `t` (the default) then each rule instantiation will only fire once.

`auto-return` indicates, when there are no more rules to be fired in the context, whether to signal an error or simply to pass control to the next context on the agenda. The default value `t` passes control on without an error.

`strategy` is the conflict resolution strategy for the context, consisting of a list of tactic names.

`meta` is a list of actions which make up the optional meta-interpreter for the context.

If `documentation` is supplied, then it should be a string. The value can be retrieved by calling the function `documentation` with doc-type `context`.

Examples

```
(defcontext my-context :strategy (priority recency))
(defcontext another-context :strategy (order)
  :meta ((start-cycle)
         (instantiation ?inst)
         (fire-rule)
         (cut)
         (another-context)))
```

See also

- `standard-context`
- `lex`
- `lex`
- `mea`
- `order`
- `order`
def-kb-class

Summary

Defines a class for use in the object base.

Package

kw

Signature

def-kb-class class-name superclass-list slot-descriptions &rest options => class

Arguments

class-name
A symbol.

superclass-list
A list of symbols.

slot-descriptions
A list of defclass slot descriptions.

options
defclass options.

Values

class
The named class object.

Description

The macro def-kb-class defines a new CLOS class name class-name, as defclass does. However, if none of the superclasses in superclass-list is a subclass of standard-kb-object, then standard-kb-object is added to the list of superclasses.

slot-descriptions and options are used as in the standard defclass macro.

Examples

(defun vehicle () ((driver :initarg :driver)))
(defun truck (vehicle)
  ((load :accessor truck-load)))

See also

def-named-kb-class
def-kb-struct
def-kb-struct

Summary
Defines a structure class for use in the object base.

Package
kw

Signature
def-kb-struct name-and-options {slot-description}* => name

name-and-options ::= name | (name {option}*)

option ::= (:include superclass) | (:print-function print-function)

Arguments

slot-description↓ A defstruct slot description.
name↓ A symbol.
superclass↓ A symbol.
print-function↓ A symbol or a lambda expression.

Values
name The name of the structure class.

Description
The macro def-kb-struct defines a KnowledgeWorks structure class name name. Objects of these classes are analogous to Lisp structures except that they may be used in rules similarly to CLOS objects.

If superclass is supplied then name will inherit from superclass, which must be KnowledgeWorks structure class.

print-function and slot-description are used as in defstruct.

Examples

(def-kb-struct start)
(def-kb-struct (named-kb-struct
    (:print-function print-named-kb-struct))
    (name (gensym 'named-kb-struct)))

(def-kb-struct (possible-trucks-for-load
    (:include named-kb-struct))
    load trucks)
# def-named-kb-class

## Summary

Defines a class of named objects for use in the object base.

## Package

```ruby
kw
```

## Signature

```ruby
def-named-kb-class class-name superclass-list slot-descriptions &rest options => class
```

## Arguments

- `class-name` - A symbol.
- `superclass-list` - A list of symbols.
- `slot-descriptions` - A list of `defclass` slot descriptions.
- `options` - `defclass` options.

## Values

- `class` - The named class object.

## Description

The macro `def-named-kb-class` defines a new CLOS class name `class-name`, as `defclass` does. However, if none of the superclasses in `superclass-list` is a subclass of `named-kb-object`, then `named-kb-object` is added to the list of superclasses. The class inherits a name slot called `kb-name`, with accessor `kb-name` and default initialization form `(:initform)` that generates a symbol from the class name using `gentemp class-name`.

`slot-descriptions` and `options` are used as in the standard `defclass` macro.

## Examples

```lisp
(defun vehicle ()
  (def.Named-KB-Class vehicle ()
    ((driver :initarg :driver)))

(defun truck ()
  (def.Named-KB-Class truck (vehicle)
    ((load :accessor truck-load)))
```

## See also

- `def-kb-class`
- `def-kb-struct`
- `get-kb-object`
- `kb-name`
- `named-kb-object`
**defrule**

**Macro**

**Summary**

Defines a rule.

**Package**

kw

**Signature**

\[
\text{defrule rule-name direction} \; \text{&optional} \; \text{doc-string} \; \text{&body} \; \text{body} \; \Rightarrow \; \text{rule-name}
\]

**Arguments**

- **rule-name**\↓
  - A symbol.
- **direction**\↓
  - Either :forward or :backward.
- **doc-string**\↓
  - An optional string.
- **body**\↓
  - Forms as described in 3 Rules.

**Values**

- **rule-name**\↓
  - A symbol.

**Description**

The macro **defrule** defines a rule named **rule-name** (which must be distinct from any other rule name, context name or KnowledgeWorks class name). If **direction** is :forward a forward chaining rule is defined, if :backward a backward chaining rule is defined. If **doc-string** is given, then it should be a string. The value can be retrieved by calling the function **documentation** with doc-type rule.

A full description of **body** is given in 3 Rules.

**Examples**

```lisp
(defrule move-train :forward :context trains
  (train ?train position ?train-pos)
  (signal ?signal position ?signal-pos color green)
  (test (= ?signal-pos (1+ ?train-pos)))
  ---->
  ((format t "Train moving to ~S" ?signal-pos))
  (assert (signal ?signal color red))
  (assert (train ?train position ?signal-pos)))

(defrule link-exists :backward
  ((link-exists ?town1 ?town2)
   <--
   (or (link ?link town1 ?town1 town2 ?town2)
    (link ?link town2 ?town1 town1 ?town2))
    (cut))
  ((link-exists ?town1 ?town2)
   <--
   (route-exists ?town1 ?town2)))
```
deftactic

Summary
Defines a tactic function for use in context strategies.

Package
kw

Signature

\[
deftactic\ tactic-name\ type\ \lambda\text{-list}\ \&\text{body}\ \Rightarrow\ tactic-name
\]

Arguments

- **tactic-name** \(\Downarrow\) A symbol.
- **type** \(\Downarrow\) Either \texttt{:static} or \texttt{:dynamic}.
- **lambda-list** \(\Downarrow\) A two argument lambda list.
- **body** \(\Downarrow\) A function body.

Values

- **tactic-name** A symbol.

Description

The macro `deftactic` defines a new conflict resolution tactic named `tactic-name`.

`type` is the type of the tactic, which may be \texttt{:static} if `body` does not look into the slots of the objects making up the instantiation, otherwise \texttt{:dynamic}.

`lambda-list` specifies two variable, which will be bound to two instantiation objects and when the forms of `body` are evaluated. `body` should return non-nil if and only if the first instantiation object is preferred to the second.

`deftactic` also defines a function named `tactic-name` and `body` can be preceded by a documentation string.

The newly defined tactic may be used as any in-built tactic.

Examples

```lisp
(deftactic prefer-trucks :static (inst1 inst2)
  (flet ((truck-p (obj) (typep obj 'truck)))
    (and (some #'truck-p (inst-token inst1))
         (notany #'truck-p (inst-token inst2))))
)
```

The new tactic may be used in a `defcontext` form:

```lisp
(defcontext my-context :strategy (prefer-trucks))
```
See also

inst-bindings
inst-token
inst-rulename
defcontext

destroy-inferencing-state

Summary
Destroys an inferencing state.

Package
kw

Signature

\texttt{destroy-inferencing-state name-or-state}

Arguments
\texttt{name-or-state} \hspace{1em} Any object.

Description
The function \texttt{destroy-inferencing-state} destroys an inferencing state named by \texttt{name-or-state}.

If \texttt{name-or-state} is an inferencing state, then it is destroyed. Otherwise, any inferencing state with that name (as compared using \texttt{eql}) is destroyed.

It is an error to destroy the current inferencing state.

Examples

\begin{verbatim}
    (destroy-inferencing-state 'my-state)
\end{verbatim}

See also

find-inferencing-state
*inferencing-state*
inferencing-state-name
list-all-inferencing-states
make-inferencing-state
**Summary**

Erases an object from the object base.

**Package**

`kw`

**Signature**

`erase variable`

**Arguments**

`variable`↓

A KnowledgeWorks object.

**Description**

The backward chaining goal `erase` erases an object from the object base. `variable` must be bound to a KnowledgeWorks CLOS object or a KnowledgeWorks structure.

The given object is removed from the object base of the current inferencing state.

**Examples**

```
(erase ?x) ; ?x bound to an object
```

**See also**

`assert`

---

**Summary**

The standard prolog predicate that always fails.

**Package**

`kw`

**Signature**

`fail`
7 Reference Guide

Description

The backward chaining goal **fail** always fails. It is sometimes used with cut.

Examples

```lisp
(defrule nice :backward
  ((nice ?x)
   <--
   (rottweiler ?x)
   (cut)
   (fail))
  ((nice ?x) <--))
```

implements "everything is nice unless it is a rottweiler".

See also

**cut**

### findall

**findallset**

**Summary**

Return all matches of a backward chaining goal.

**Package**

**kw**

**Signatures**

```
findall  pattern-to-instantiate  goal-to-prove  =>  list
findallset  pattern-to-instantiate  goal-to-prove  =>  set
```

**Arguments**

- `pattern-to-instantiate`\↓
  A list or symbol.
- `goal-to-prove`\↓
  Any backward chaining goal.

**Values**

- `list`\↓
  A list.
- `set`\↓
  A list.

**Description**

The function **findall** starts the backward chaining inference engine to look for all sets of bindings which satisfy `goal-to-prove`. For each of those bindings, `pattern-to-instantiate` is instantiated and collected to return a list. The value is **nil** if
nothing *goal-to-prove* cannot be satisfied.

Any subgoals that match the object base will only find objects from the current inferencing state.

The function **findallset** is like **findall** but set will not have any duplicates (as compared by **equal**).

**Examples**

```lisp
(findall '(?x is in (1 2 3)) (member ?x (1 2 3)))
```

returns:

```
(1 IS IN (1 2 3))
(2 IS IN (1 2 3))
(3 IS IN (1 2 3))
```

```lisp
(findall '(?truck is a truck) (truck ?truck))
```

returns:

```
(#<TRUCK TRUCK1> IS A TRUCK)
(#<TRUCK TRUCK2> IS A TRUCK)
```

See also

**any**

---

**find-inferencing-state**

*Function*

**Summary**

Finds a known inferencing state.

**Package**

**kw**

**Signature**

```lisp
find-inferencing-state name &key if-does-not-exist => state
```

**Arguments**

- `name` ⇒ Any object.
- `if-does-not-exist` ⇒ Either :error or :create.

**Values**

- `state` An inferencing state.

---

7 Reference Guide
Description

The function `find-inferencing-state` finds and returns an inferencing state named by `name`.

If an inferencing state with the same name already exists (as compared using `eql`), it is returned.

Otherwise, the value of `if-does-not-exist` determines what happens:

: `error` A continuable error is signaled. Invoking the `continue` restart creates and returns a new inferencing state.

: `create` A new inferencing state is created and returned.

Examples

```lisp
(find-inferencing-state 'my-state)
```

See also

- `destroy-inferencing-state`
- `*inferencing-state*`
- `inferencing-state-name`
- `list-all-inferencing-states`
- `make-inferencing-state`

---

fire-rule

*Backward Chaining Goal*

Summary

Fires the given meta-interpreter rule instantiation.

Package

`kw`

Signature

`fire-rule instantiation`

Arguments

`instantiation` An instantiation object.

Description

The backward chaining goal `fire-rule` is only relevant when writing a meta-interpreter for a context. `fire-rule` fires the given rule instantiation `instantiation`. It is an error if the passed object is not an instantiation object.

Examples

```lisp
(fire-rule ?instantiation)
```
See also

start-cycle
instantiation
defcontext
standard-context

get-kb-object

Summary

Finds a named object in the object base.

Package

kw

Signature

\texttt{get-kb-object object-name} => \texttt{object}

Arguments

\textit{object-name} A symbol.

Values

\textit{object} A KnowledgeWorks CLOS object.

Description

The function \texttt{get-kb-object} returns the KnowledgeWorks object named \textit{object-name} in the object base of the current inferencing state. If there is no such object an error results.

Classes of named objects can be defined using the macro \texttt{def-named-kb-class}.

Examples

\begin{verbatim}
(get-kb-object 'fred)
\end{verbatim}

See also

\texttt{def-named-kb-class}

\texttt{kb-name}
**infer**

Summary
Runs the forward chaining inferencing engine.

Package
kw

Signature
\[
\text{infer} \ \&\text{key} \ \text{contexts} \Rightarrow \text{cycle-count}
\]

Arguments
contexts
A list of context names, default to \((\text{default-context})\).

Values
cycle-count
An integer.

Description
The function \text{infer} runs the forward chaining inference engine in the current inferencing state, with \text{contexts} as the initial agenda. The first rules to fire will be from the first context listed in \text{contexts} until control is passed on.

The value returned as \text{cycle-count} is the total number of cycles executed (given in \text{current-cycle}).

Examples
\[
(\text{infer} \ :\text{contexts} \ '(\text{my-context} \ \text{another-context}))
\]

See also
\text{current-cycle}

**current-cycle**

Summary
The current inferencing state.

Package
kw

Initial Value
An empty inferencing state named \text{:default}. 

*inferencing-state*

Variable

7 Reference Guide
The value of the variable \texttt{*inferencing-state*} is the current inferencing state for many KnowledgeWorks functions.

This variable can be bound to a particular inferencing state before calling other KnowledgeWorks functions, but should not be changed within the body of a rule.

\textbf{See also}

\begin{itemize}
  \item \texttt{current-cycle}
  \item \texttt{destroy-inferencing-state}
  \item \texttt{find-inferencing-state}
  \item \texttt{inferencing-state-name}
  \item \texttt{list-all-inferencing-states}
  \item \texttt{make-inferencing-state}
\end{itemize}

\textbf{inferencing-state-name}

\textbf{Summary}

Returns the name of an inferencing state.

\textbf{Package}

\texttt{kw}

\textbf{Signature}

\texttt{inferencing-state-name state => name}

\textbf{Arguments}

\texttt{state} An inferencing state.

\textbf{Values}

\texttt{name} Any object.

\textbf{Description}

The function \texttt{inferencing-state-name} returns the name of \texttt{state}.

\textbf{Examples}

\begin{itemize}
  \item \texttt{(inferencing-state-name *inferencing-state*)}
\end{itemize}

\textbf{See also}

\begin{itemize}
  \item \texttt{find-inferencing-state}
  \item \texttt{*inferencing-state*}
  \item \texttt{list-all-inferencing-states}
  \item \texttt{make-inferencing-state}
\end{itemize}
Summary

Allows code to detect when it is running in a rule.

Package

\textit{kw}

Initial Value

\textit{nil}

Description

The variable \texttt{*in-interpreter*} is bound to \texttt{t} if the code executing has been called (directly or indirectly) from the forward chaining rule interpreter. Otherwise it bound to \texttt{nil}. The value should not be changed.

\begin{itemize}
  \item \texttt{instantiation} \texttt{variable}
\end{itemize}

Arguments

\texttt{variable} \downarrow \texttt{An unbound variable introduced by ?.}

Description

The backward chaining goal \texttt{instantiation} is only relevant when writing a meta-interpreter for a context. \texttt{instantiation} binds \texttt{variable} to the next preferred instantiation from the conflict set of the currently executing context. This goal may be satisfied repeatedly each time returning the next instantiation. When no instantiations are left, it fails.

Examples

\begin{verbatim}
(instantiation ?instantiation)
\end{verbatim}
See also

conflict-set
inst-bindings
inst-rulename
inst-token
start-cycle
fire-rule
defcontext
standard-context

\textbf{inst-bindings} \hfill \textit{Function}

Summary

Returns the bindings in a rule instantiation.

Package

\texttt{kw}

Signature

\texttt{inst-bindings instantiation => bindings}

Arguments

\texttt{instantiation} \hfill An instantiation object.

Values

\texttt{bindings} \hfill An association list.

Description

The function \texttt{inst-bindings} returns an association list of the variables and their bindings in \textit{instantiation}. The variables are those produced by the condition part of the forward chaining rule.

Examples

For an instantiation of a rule with the precondition:

\[(\texttt{object ? color ?color-value size ?size})\]

the value returned by:

\texttt{(inst-bindings inst)}

might be:

\[((\texttt{?color-value} . :red) (\texttt{?size} . 20))\]
See also

conflict-set
deftactic
inst-rulename
inst-token
instantiation

inst-rulename

Summary

Returns the rule name of a rule instantiation.

Package

kw

Signature

\[ \text{inst-rulename } \text{instantiation } \Rightarrow \text{rulename} \]

Arguments

\[ \text{instantiation} \]

An instantiation object.

Values

\[ \text{rulename} \]

A symbol which is the name of a rule.

Description

The function \text{inst-rulename} returns the rule name of \text{instantiation} (the name of the rule of which this is an instantiation).

See also

conflict-set
inst-bindings
deftactic
inst-token
instantiation

inst-token

Summary

Returns the token of a rule instantiation.

Package

kw

82
Signature

\texttt{inst-token \ instantiation \Rightarrow \ token}

Arguments

\texttt{instantiation} \quad \text{An instantiation object.}

Values

\texttt{token} \quad \text{A list of objects.}

Description

The function \texttt{inst-token} returns the token of \texttt{instantiation}. \texttt{token} is the list of objects that match the condition part of the forward chaining rule. This list of objects is in reverse order to the order in which the conditions appear in the rule.

Examples

If the forward chaining conditions are:

\begin{verbatim}
(train ?train)
(signal ?signal)
\end{verbatim}

then the token will have the form \texttt{(signal-object train-object)}.

See also

\texttt{conflict-set}
\texttt{deftactic}
\texttt{inst-rulename}
\texttt{inst-bindings}
\texttt{instantiation}

\section*{kb-name}

\textbf{Generic Function}

Summary

Returns the name of an object.

Package

\texttt{kw}

Signature

\texttt{kb-name \ object \Rightarrow \ name}

Arguments

\texttt{object} \quad \text{A KnowledgeWorks named CLOS object.}
Values

name A symbol.

Description

The generic function \texttt{kb-name} returns the name of \texttt{object}. It is an error if \texttt{object} is not a named object. Classes of named objects can be defined using the macro \texttt{def-named-kb-class}.

Examples

\begin{verbatim}
  (kb-name (get-kb-object 'fred)) ; returns FRED
\end{verbatim}

See also

\texttt{def-named-kb-class}

\texttt{get-kb-object}

\texttt{named-kb-object}

\section*{kw-class}

\textit{Backward Chaining Goal}

Summary

Matches all KnowledgeWorks class names.

Package

\texttt{kw}

Signature

\texttt{kw-class term}

Arguments

\texttt{term} Any backward chaining term.

Description

The backward chaining goal \texttt{kw-class} matches all KnowledgeWorks class names. It can act as a generator and can be resatisfied. It succeeds when \texttt{term} is a symbol which is the name of a KnowledgeWorks class. If \texttt{term} is an unbound variable it generates the names of the KnowledgeWorks classes.

Examples

\begin{verbatim}
  (kw-class truck) ; succeeds if truck is a KW class

  (kw-class ?class)
  ; ?class is bound to the name of a KW class
\end{verbatim}
See also

def-kb-class
def-kb-struct
def-named-kb-class

**lex**

Conflict Resolution Tactic / Function

Summary

Implements the **lex** tactic.

Package

kw

Signature

\[ \text{lex } \text{instantiation1 } \text{instantiation2 } \Rightarrow \text{result} \]

Arguments

\[ \text{instantiation1} \downarrow \quad \text{An instantiation object.} \]
\[ \text{instantiation2} \downarrow \quad \text{An instantiation object.} \]

Values

\[ \text{result} \quad \text{A boolean.} \]

Description

The conflict resolution tactic / function **lex** implements the LEX tactic. It returns true if and only if \text{instantiation1} is preferred to \text{instantiation2} by the conflict resolution tactic **lex**, otherwise false. The function is intended to be used primarily by including it in the conflict resolution strategy for a context.

Examples

\[
\begin{align*}
&\text{(defcontext my-context1 :strategy (lex))} \\
&\text{(defcontext my-context2 :strategy (priority lex))}
\end{align*}
\]

See also

3.1.5.3 Conflict Resolution

defcontext
deftactic
-lex
instantiation
conflict-set
fire-rule
Conflict Resolution Tactic / Function

-l ex

Summary
Implements the \texttt{--lex} tactic.

Package
\texttt{kw}

Signature
\texttt{-lex instantiation1 instantiation2 => result}

Arguments
\texttt{instantiation1 \downarrow} \quad \text{An instantiation object.}
\texttt{instantiation2 \downarrow} \quad \text{An instantiation object.}

Values
\texttt{result} \quad \text{A boolean.}

Description
The conflict resolution tactic / function \texttt{-lex} returns true if and only if \texttt{instantiation1} is preferred to \texttt{instantiation2} by the conflict resolution tactic -\texttt{lex}, otherwise false. The function is intended to be used primarily by including it in the conflict resolution strategy for a context.

Examples
\begin{verbatim}
(defcontext my-context1 :strategy (-lex))
(defcontext my-context2 :strategy (priority -lex))
\end{verbatim}

See also
3.1.5.3 Conflict Resolution
\texttt{defcontext}
\texttt{deftactic}
\texttt{lex}
\texttt{instantiation}
\texttt{conflict-set}
\texttt{fire-rule}
**list-all-inferencing-states**

**Summary**

Returns a list of all the known inferencing states.

**Package**

kw

**Signature**

`list-all-inferencing-states => states`

**Values**

`states` A list of inferencing states.

**Description**

The function `list-all-inferencing-states` returns a list of all the known inferencing states. Inferencing states become known when they are make and are known until they are destroyed.

**Examples**

```
(list-all-inferencing-states)
```

**See also**

- `destroy-inferencing-state`
- `find-inferencing-state`
- `*inferencing-state*`
- `inferencing-state-name`
- `make-inferencing-state`

---

**make-inferencing-state**

**Summary**

Makes a new inferencing state.

**Package**

kw

**Signature**

`make-inferencing-state name &key set-current-p if-exists => state`
Arguments

- **name**: Any object.
- **set-current-p**: A boolean.
- **if-exists**: Either :error, :supersede or :overwrite.

Values

- **state**: An inferencing state.

Description

The function `make-inferencing-state` returns an inferencing state named by `name`.

If an inferencing state with the same name already exists (as compared using `eql`), then the value of `if-exists` determines what happens:

- **:error**: A continuable error is signaled. Invoking the `continue` restart causes the existing inferencing state to be returned.
- **:supersede**: The existing inferencing state is destroyed and a new one is returned.
- **:overwrite**: The existing inferencing state is returned.

If `set-current-p` is non-nil, then `*inferencing-state*` is set to new inferencing state.

Examples

```lisp
(make-inferencing-state 'my-state)
```

See also

- `destroy-inferencing-state`
- `find-inferencing-state`
- `*inferencing-state*
- `inferencing-state-name`
- `list-all-inferencing-states`

---

### make-instance

**Generic Function**

Summary

Makes a CLOS or KnowledgeWorks structure object.

Package

`common-lisp`

Signature

```lisp
make-instance class &rest initargs => object
```
**Arguments**

- **class**: A class object or a symbol.
- **initargs**: Initialization arguments for the object.

**Values**

- **object**: A new instance of `class`.

**Description**

The generic function `make-instance` makes a new instance of the class `class`.

If `class` is a CLOS class then the behavior is as specified by `make-instance` in the Common Lisp standard.

If `class` is a KnowledgeWorks structure class, then `initargs` are the same as those for the automatically defined constructor function of the structure.

The object is added to the object base of the current inferencing state.

**Examples**

```
(make-instance 'start)
(make-instance 'driver :location 'London :kb-name 'fred)
```

**See also**

- `def-kb-class`
- `def-kb-struct`
- `def-named-kb-class`

---

**mea**

Conflict Resolution Tactic / Function

**Summary**

Implements the `mea` tactic.

**Package**

`kw`

**Signature**

```
mea instantiation1 instantiation2 => result
```

**Arguments**

- **instantiation1**: An instantiation object.
- **instantiation2**: An instantiation object.
Values

\begin{align*}
\text{result} & \quad \text{A boolean.}
\end{align*}

Description

The conflict resolution tactic / function \texttt{mea} returns true if and only if \texttt{instantiation1} is preferred to \texttt{instantiation2} by the conflict resolution tactic \texttt{mea}, otherwise false. The function is intended to be used primarily by including it in the conflict resolution strategy for a context.

Examples

\begin{align*}
(\text{defcontext my-context1 :strategy (mea)}) \\
(\text{defcontext my-context2 :strategy (priority mea)})
\end{align*}

See also

\begin{tabular}{ll}
3.1.5.3 Conflict Resolution & \textit{Conflict Resolution Tactic / Function} \\
defcontext & \\
deftactic & \\
\texttt{mea} & \\
\texttt{instantiation} & \\
\texttt{conflict-set} & \\
\texttt{fire-rule} & \\
\end{tabular}

\texttt{-mea}

Summary

Implements the \texttt{-mea} tactic.

Package

\texttt{kw}

Signature

\begin{align*}
\texttt{-mea instantiation1 instantiation2 => result}
\end{align*}

Arguments

\begin{align*}
\text{instantiation1} & \downarrow \quad \text{An instantiation object.} \\
\text{instantiation2} & \downarrow \quad \text{An instantiation object.}
\end{align*}

Values

\begin{align*}
\text{result} & \quad \text{A boolean.}
\end{align*}

Description

The conflict resolution tactic / function \texttt{-mea} returns true if and only if \texttt{instantiation1} is preferred to \texttt{instantiation2} by the conflict resolution tactic \texttt{-mea}, otherwise false. The function is intended to be used primarily by including it in the conflict resolution strategy for a context.
resolution strategy for a context.

Examples

(defcontext my-context1 :strategy (-mea))
(defcontext my-context2 :strategy (priority -mea))

See also

3.1.5.3 Conflict Resolution

defcontext
deftactic
mea
instantiation
conflict-set
fire-rule

**named-kb-object**

*Class*

Summary

A class that provides named objects.

Package

kw

Superclasses

standard-kb-object

Initargs

:kb-name

The name of the object. The default is computed by calling `gentemp` with the name of the class.

Description

The class `named-kb-object` is the mixin class for named KnowledgeWorks CLOS objects.

Subclasses of `named-kb-object` are typically defined using the macro `def-named-kb-class`.

Examples

```lisp
(defun class-driver
  (named-kb-object)
  ((location) (allocated-truck)))
```

See also

get-kb-object
def-named-kb-class
standard-kb-object
**no-debug**

**Summary**

Turns debugging facilities off.

**Package**

`kw`

**Signature**

`no-debug`

**Description**

The function **no-debug** turns off all KnowledgeWorks debugging facilities. This means that rules and contexts cannot be single stepped or monitored, and no record is kept of when objects are created or modified. Execution speed of the rulebase is improved, and memory requirements reduced.

This should be called before compiling any rules or contexts that are to be optimized.

**Examples**

```plaintext
(no-debug)
```

**See also**

`all-debug`

---

**not**

**Backward Chaining Goal**

**Summary**

A goal that is satisfied when another goal fails.

**Package**

`kw`

**Signature**

`not {condition}*`

**Arguments**

`condition` Any backward chaining goal.
Description

If the backward chaining goal `not` is used in a backward chaining clause, it succeeds if `condition` fails. In this usage, only one condition is allowed.

If `not` is used in a forward chaining pre-condition, it succeeds if any `condition` contained within it fail. In this usage, each `condition` may only contain expressions normally allowed in forward chaining pre-conditions (object base references and lisp tests). See 3.1.2 Forward Chaining Syntax for more details.

Examples

```lisp
(not (truck ?truck driver ?driver) (test ?driver))
```

See also
test

---

`order`

Conflict Resolution Tactic / Function

Summary

Implements the `order` tactic.

Package

kw

Signature

```
order instantiation1 instantiation2 => result
```

Arguments

- `instantiation1` [An instantiation object.]
- `instantiation2` [An instantiation object.]

Values

- `result` [A boolean.]

Description

The conflict resolution tactic / function `order` returns true if and only if `instantiation1` is preferred to `instantiation2` by the conflict resolution tactic `order`, otherwise false. The function is intended to be used primarily by including it in the conflict resolution strategy for a context.

Examples

```lisp
(defcontext my-context1 :strategy (order))
(defcontext my-context2 :strategy (priority order))
```


**Summary**

Implements the `-order` tactic.

**Package**

`kw`

**Signature**

```
-order instantiation1 instantiation2 => result
```

**Arguments**

- `instantiation1` ⇓ An instantiation object.
- `instantiation2` ⇓ An instantiation object.

**Values**

- `result` A boolean.

**Description**

The conflict resolution tactic / function `-order` returns true if and only if `instantiation1` is preferred to `instantiation2` by the conflict resolution tactic `-order`, otherwise false. The function is intended to be used primarily by including it in the conflict resolution strategy for a context.

**Examples**

```lisp
(defcontext my-context1 :strategy (-order))
(defcontext my-context2 :strategy (priority -order))
```

**See also**

3.1.5.3 Conflict Resolution
**fire-rule**

*print-verbose*  

**Summary**  
Controls how much information is printed for an object.

**Package**  
**kw**

**Initial Value**  
nil

**Description**  
The variable *print-verbose* controls how much information is printed for an object. Normally objects in KnowledgeWorks are printed out in a brief form similar to ordinary CLOS objects. If *print-verbose* is set to t then all the slots and slot values are shown in its printed representation. Note that circularities cannot be detected.

**priority**  

**Conflict Resolution Tactic / Function**  

**Summary**  
Implements the priority tactic.

**Package**  
**kw**

**Signature**  

priority instantiation1 instantiation2 => result

**Arguments**  

instantiation1 ↓  An instantiation object.

instantiation2 ↓  An instantiation object.

**Values**  

result  A boolean.

**Description**  
The conflict resolution tactic / function priority returns true if and only if instantiation1 is preferred to instantiation2 by the conflict resolution tactic priority, otherwise false. The function is intended to be used primarily by including it in the
conflict resolution strategy for a context.

Examples

(defcontext my-context1 :strategy (priority))
(defcontext my-context2 :strategy (recency priority))

See also

3.1.5.3 Conflict Resolution

defcontext
deftactic
-priority
instantiation
conflict-set
fire-rule

-priority

Conflict Resolution Tactic / Function

Summary

Implements the \texttt{-priority} tactic.

Package

\texttt{kw}

Signature

\texttt{-priority instantiation1 instantiation2 => result}

Arguments

instantiation1\downarrow \quad \text{An instantiation object.}

instantiation2\downarrow \quad \text{An instantiation object.}

Values

result \quad \text{A boolean.}

Description

The conflict resolution tactic / function \texttt{-priority} returns true if and only if \texttt{instantiation1} is preferred to \texttt{instantiation2} by the conflict resolution tactic \texttt{-priority}, otherwise false. The function is intended to be used primarily by including it in the conflict resolution strategy for a context.

Examples

(defcontext my-context1 :strategy (-priority))
(defcontext my-context2 :strategy (recency -priority))
7 Reference Guide

See also

3.1.5.3 Conflict Resolution

Summary

Implements the recency tactic.

Package

kw

Signature

recency instantiation1 instantiation2 => result

Arguments

instantiation1\downarrow An instantiation object.

instantiation2\downarrow An instantiation object.

Values

result A boolean.

Description

The conflict resolution tactic / function recency returns true if and only if instantiation1 is preferred to instantiation2 by the conflict resolution tactic recency, otherwise false. The function is intended to be used primarily by including it in the conflict resolution strategy for a context.

Examples

( defcontext my-context1 :strategy ( recency ) )
( defcontext my-context2 :strategy ( priority recency ) )

See also

3.1.5.3 Conflict Resolution
-recency

Summary

Implements the -recency tactic.

Package

kw

Signature

-recency instantiation1 instantiation2 => result

Arguments

instantiation1 : An instantiation object.

instantiation2 : An instantiation object.

Values

result : A boolean.

Description

The conflict resolution tactic / function -recency returns true if and only if instantiation1 is preferred to instantiation2 by the conflict resolution tactic -recency, otherwise false. The function is intended to be used primarily by including it in the conflict resolution strategy for a context.

Examples

(defcontext my-context1 :strategy (recency))
(defcontext my-context2 :strategy (priority recency))

See also

3.1.5.3 Conflict Resolution

defcontext
deftactic
recency
instantiation
conflict-set
fire-rule
reset

Summary
Clears all objects from the object base.

Package
kw

Signature
reset

Description
The function reset clears all KnowledgeWorks objects (both KnowledgeWorks CLOS objects and KnowledgeWorks structures) from the object base of the current inferencing state.

The list of KnowledgeWorks classes remains unaffected.

Examples

  (reset)

See also
clear-all
clear-rules

return

Summary
Removes the top-most context from the agenda.

Package
kw

Signature
return

Description
The backward chaining goal return takes the topmost context on the agenda and makes it the current context, discarding the previous current context. When called from within a rule, rule execution continues to the end and the next rule to fire will be from the new current context.
Examples

See also

context

*signal-kb-name-clash*  

Summary
Controls the behavior if name clashes occur in object creation.

Package
kw

Initial Value
: error

Description
The variable *signal-kb-name-clash* determines behavior when creating a new named KB object with the same name as an existing KB object.

The possible values are:

: error  Signals a error Continuing will replace the old object with the new object.

: warn  Signals a warning and replaces the old object with the new object.

: quiet  Replaces the old object with the new object.

---

**specificity**  

*Conflict Resolution Tactic / Function*

Summary
Implements the specificity tactic.

Package
kw

Signature

**specificity**  instantiation1  instantiation2  =>  result

Arguments

instantiation1  An instantiation object.
An instantiation object.

A boolean.

The conflict resolution tactic / function `specificity` returns true if and only if `instantiation1` is preferred to `instantiation2` by the conflict resolution tactic `specificity`, otherwise false. The function is intended to be used primarily by including it in the conflict resolution strategy for a context.

```
(defcontext my-context1 :strategy (specificity))
(defcontext my-context2 :strategy (priority specificity))
```

See also

3.1.5.3 Conflict Resolution

`-specificity`

**Summary**

Implements the `-specificity` tactic.

**Package**

`kw`

**Signature**

```
-specificity instantiation1 instantiation2 => result
```

**Arguments**

- `instantiation1` An instantiation object.
- `instantiation2` An instantiation object.

**Values**

`result` A boolean.
Description

The conflict resolution tactic function \texttt{\texttt{-specificity}} returns true if and only if \texttt{instantiation1} is preferred to \texttt{instantiation2} by the conflict resolution tactic \texttt{-specificity}, otherwise false. The function is intended to be used primarily by including it in the conflict resolution strategy for a context.

Examples

\begin{verbatim}
  (defcontext my-context1 :strategy (-specificity))
  (defcontext my-context2 :strategy (priority -specificity))
\end{verbatim}

See also

3.1.5.3 Conflict Resolution

\begin{verbatim}
defcontext
deftactic
specificity
instantiation
conflict-set
fire-rule
\end{verbatim}

\textbf{standard-context}

\textit{Backward Chaining Goal}

Summary

The standard meta-interpreter context.

Package

\texttt{kw}

Signature

\texttt{standard-context}

Description

The backward chaining goal \texttt{standard-context} is the built-in goal that implements a meta-interpreter for the default (normal) behavior of a context. It is as if defined by the rule:

\begin{verbatim}
  (defrule standard-context :backward
    ((standard-context)
     <--
     (start-cycle)
     (instantiation ?instantiation)
     (fire-rule ?instantiation)
     (cut)
     (standard-context))
\end{verbatim}

Examples

\begin{verbatim}
  (defcontext my-context1 :meta (((format t "\%Entering context MY-CONTEXT1")))
\end{verbatim}
standard-kb-object

Summary
A class of objects for use in the object base.

Package
kw

Superclasses
standard-object

Description
The class standard-kb-object is the mixin class for (unnamed) KnowledgeWorks CLOS objects.

Subclasses of standard-kb-object are typically defined using the macro def-kb-class.

Examples

(start-class driver (standard-kb-object)
   ((location) (allocated-truck)))

See also
def-kb-class
named-kb-object

start-cycle

Summary
Used in the meta-interpreter to start the cycle.

Package
kw
Signature

\texttt{start-cycle}

Description

The backward chaining goal \texttt{start-cycle} is only relevant when writing a meta-interpreter for a context. \texttt{start-cycle} must be called at the start of every forward chaining cycle as it performs some essential housekeeping.

Examples

\begin{verbatim}
(start-cycle)
\end{verbatim}

See also

\begin{verbatim}
fire-rule instantiation defcontext standard-context
\end{verbatim}

\begin{tabular}{ll}
\textbf{start-kw} & \\
\end{tabular}

Summary

Starts the KnowledgeWorks programming environment.

Package

\texttt{kw}

Signature

\texttt{start-kw \&key host}

Arguments

\begin{verbatim}
host \downarrow A string.
\end{verbatim}

Description

The function \texttt{start-kw} starts the KnowledgeWorks programming environment from the initial prompt when the KnowledgeWorks image is started. If the LispWorks IDE is already running, \texttt{start-kw} adds the KnowledgeWorks menu so that the podium becomes the KnowledgeWorks Podium.

On GTK+ and Motif the environment is displayed on the machine specified by \texttt{host}, defaulting to the machine on which the KnowledgeWorks image is running. Other platforms ignore \texttt{host}.

Examples

\begin{verbatim}
(start-kw)
\end{verbatim}
**test**

**Summary**
Evaluates a Lisp form as a backward chaining goal.

**Package**
kw

**Signature**

\[
\text{test \ lisp-form}
\]

**Arguments**

lisp-form

A single Lisp form.

**Description**

The backward chaining goal test succeeds if and only if lisp-form returns a non-nil value. Any currently bound variables may be used in the lisp form.

test can also be used as a forward chaining pre-condition, as described in **3.1.2 Forward Chaining Syntax**.

**Examples**

\[
\begin{align*}
\text{(test (> ?c 10))} \\
\text{(test (not (and (eq ?a ?b) (member ?b ?c)))})
\end{align*}
\]

**undefcontext**

**Summary**

Removes a named context and its rules.

**Package**
kw

**Signature**

\[
\text{undefcontext \ context-name \ &rest \ ignore}
\]

**Arguments**

category-name

A symbol which names a context.

ignore

Ignored arguments.
Description

The macro **undefcontext** removes the context named `context-name` and all the rules in it.

`ignore` is not used and is only provided so that "un" may be prepended to a context definition in an editor buffer and evaluated to remove the context.

Examples

```
(undefcontext my-context)
```

See also

**defcontext**

---

**undefrule**

Summary

Removes a rule.

Package

**kw**

Signature

```
undefrule rule-name &rest ignore
```

Arguments

- `rule-name`\n  A symbol which names a rule.
- `ignore`\n  Ignored arguments.

Description

The macro **undefrule** removes the rule named `rule-name` and any unfired instantiations of that rule.

`ignore` is not used and is only provided so that “un” may be prepended to a rule definition in an editor buffer and evaluated to remove the rule.

Examples

```
(undefrule my-rule1)
```

See also

**defrule**
with-rule-actions

**Summary**

Allows rule syntax to be embedded in Lisp code.

**Package**

kw

**Signature**

\[\text{with-rule-actions bound-variables \&body body => successp}\]

**Arguments**

- **bound-variables**
  - A list of variables (each starting with ?).
- **body**
  - A rule body.

**Values**

- **successp**
  - A boolean.

**Description**

The macro `with-rule-actions` macro enables rule syntax to be embedded within Lisp. `body` is executed just as if it were the right hand side of a forward or backward chaining rule. All variables in `body` (each starting with ?) are taken to be unbound unless found in the list `bound-variables`, in which case its value is taken from the Lisp variable of the same name. `with-rule-actions` is similar to the function `any` but can be compiled for efficiency.

`successp` is `t` if the body succeeds (that is, all clauses are successfully executed) or `nil` if any of the clauses fail.

Any subgoals that match the object base will only find objects from the current inferencing state.

**Examples**

```
(defun my-fn (?x)
  "prints all the lists which append to give ?x and
  then returns NIL"
  (with-rule-actions (?x)
    (append ?a ?b ?x)
    ((format t "~S and ~S append to give ~S" ?a ?b ?x))
    (fail)))
```

**See also**

any
Appendix A: Common Prolog

A.1 Introduction

A.1.1 Overview

Common Prolog is a logic programming system within Common Lisp. It conforms closely to Edinburgh Prolog and at the same time integrates well with Lisp. The basic syntax of Common Prolog is Lisp-like, but an Edinburgh syntax translator is included that provides the ability to use pre-existing code. The implementation of Common Prolog was motivated by the desire to use the logic programming paradigm without having to give up the advantages of a Lisp development environment. Common Prolog is tightly integrated with Lisp and can be easily used in a mixed fashion with Lisp definitions even within the same source file. Common Prolog predicates are compiled into Lisp functions which may then be compiled by a standard Lisp compiler. Substantial effort has gone into providing a powerful debugging environment for Common Prolog, so that it can be used when building serious applications. The implementation of Common Prolog is based loosely on the Warren Abstract Machine (WAM) modified to take advantage of a Lisp environment's built in support for control flow and memory allocation. (For more details of the WAM, see An Abstract Prolog Instruction Set, by David H D Warren, Technical Note 309, SRI International, October 1983.)

A.1.1.1 Starting Common Prolog

Common Prolog may be loaded into an image with the function call:

```
(requiring "prolog")
```

This will load the Common Prolog system. If Common Prolog will be used extensively, it may be worthwhile to save an image with it pre-loaded. Alternatively, you may simply insert the call above into your LispWorks initialization file (usually .lispworks).

For information about saving an image and the LispWorks initialization file, see the Release Notes and Installation Guide.

Note: If you load KnowledgeWorks, then Common Prolog is loaded as part of this.

A.2 Syntax

Common Prolog uses a Lisp-like syntax in which variables are prefixed with "?" and normal Lisp prefix notation is used. Goals are represented as either lists or simple vectors e.g. (reverse (1 2 3) ?x) or #(member ?x (1 2 3)). A symbol beginning with ? may be escaped by prefixing another ?, i.e. ??foo is the symbol ?foo.

The definition of append/3 from Prolog:

```
append([], X, X).
append([U|X], Y, [U|Z]) :-
    append(X, Y, Z)
```

translates to:
(defrel append
  ((append () ?x ?x))
  ((append (?u . ?x) ?y (?u . ?z))
   (append ?x ?y ?z)))

Unlike many Lisp-based logic systems, Common Prolog uses simple vectors to represent Prolog structured terms. Thus, *functor*, *arg*, and *=..* all behave in a standard fashion:

```prolog
(arg 2 (foo 3 4) (3 4))
(arg 2 #(foo 3 4) 4)
(functor (foo 3 4) \ 2)
(functor #(foo 3 4) foo 2)
(=.. #(foo 3 4) (foo 3 4))
(=.. (foo 3 4) (\ foo (3 4)))
```

### A.3 Defining Relations

The normal method of defining relations in Common Prolog is to use the `defrel` macro:

```prolog
(defrel <relation name>
  [(declare declaration*)]
  <clause1>
  .
  <clauseN>)
```

where each `<clause>` is of the form:

```prolog
(<clause-head>
 <subgoal1>
 .
 <subgoalN>)
```

and declarations may include: *(mode* arg-mode*) and any of the normal Lisp optimization declarations. Mode declarations determine how much clause indexing will be done on the predicate and can also streamline generated code for a predicate that will only be used in certain ways. A mode declaration consists of the word "MODE" followed by a mode spec for each argument position of the predicate. The possible argument mode specs are:

- Generate completely general code for this arg and don’t index on it.
- * Generate completely general code and index.
+ Generate code assuming this argument will be bound on entry and index.
- Generate code assuming this argument will be unbound on entry and don’t index.

The default mode specs are ?* for the first argument and ? for all the rest.

### A.4 Using The Logic Interpreter

The Common Prolog system comes with a built-in `read-query-print` loop similar to a Prolog interpreter loop. To run it, make sure the common-prolog package is accessible and type: `(rqp)`. You will be presented with the prompt: `==>`. At this point you may type in goal expressions, for example:

```
| ==> (append ?x ?y (1 2))
```
Now Common Prolog is waiting for you to indicate whether or not you wish more solutions. If you press Return, you will get the message OK and return to the top level:

```
?X = NIL  
?Y = (1 2)  
OK.  
```  

### A.4.1 Multiple Solutions

If you hit ; (semicolon) following the retrieval of a solution, the system will attempt to resatisfy your goal:

```
?X = NIL  
?Y = (1 2);  
?X = (1)  
?Y = (2);  
?X = (1 2)  
?Y = NIL;  
NO.  
```  

When no more solutions remain, NO. is displayed and you are back at the top level.

### A.4.2 Multiple Goals

To request the solution of multiple goals, use: \(\text{\texttt{(and \ <goal1> \ \ldots \ \ <goalN>\)}}\).

For example:

```
=> (and (member ?x (2 3)) (append (?x) (foo) ?y))
X = 2  
Y = (2 FOO)  
OK.  
```  

### A.4.3 Definitions

It is possible to type logic definitions directly into the interpreter. The resulting Lisp code will be compiled in memory and you may use the definition immediately, for example:

```
==> (defrel color  
    ((color red))  
    ((color blue))  
    ((color green)))  
<... various compilation messages ...>
```
A.4.4 Exiting the Interpreter

The Common Prolog interpreter may be exited by typing:

```
==> (halt)
```

A.5 Accessing Lisp From Common Prolog

It is apparent from the Common Prolog syntax that the first element of any valid goal expression must be a symbol. Common Prolog takes advantage of this fact and gives a special interpretation to a goal with a list in the first position. A list in the **car** of a goal is treated as a Lisp expression with normal Lisp evaluation rules. Any logic variables in the expression are instantiated with their values. (They must be bound). The rest of the goal expression should be a list of expressions to be unified with the values returned by the Lisp evaluation. Any extra values returned are ignored, and any extra expressions in the tail of a goal are unified with new unbound variables.

A.5.1 Examples

```
==> ((print "foo"))
"foo"
YES.

==> (and (= ?x 3) ((* ?x ?x) ?y))
    ; Note that "?y" is unified with 9

?X = 3
?Y = 9

==> ((* 3 3) 10)

NO.

==> ((floor 3 4) ?x ?y)

?X = 0
?Y = 3

==> ((floor 3 4) ?x)

?X = 0

==> ((* 3 4) ?x ?y)

?X = 12
?Y = ?0
    ; note that system generated variables look like:
    ; ?<integer>
```
==></(typep 3 'integer) ?x)
  ?X = T
==></(typep 3 'integer) t)
  YES.
==>((and ((floor 5 3) ?x) ((floor 4 3) ?x))
  ?X = 1
==>((cons 3 4) (?x . ?y))
?X = 3
?Y = 4
==>((and (= ?op *) ((list ?op 3 4) ?y) (call (?y ?z)))
  ?OP = *
  ?Y = (* 3 4)
  ?Z = 12
==>(and (defrel fact
        ((fact 0 1))
        ((fact ?x ?y)
         ((- ?x 1) ?w)
         (fact ?w ?z)
         ((* ?z ?x) ?y)))
        (fact 10 ?result))
?X = ?0
?Y = ?1
?W = ?2
?Z = ?3
?RESULT = 3628800

A.6 Calling Prolog From Lisp

There are several entry points provided for calling Prolog from Lisp. The main interface function is called logic and has numerous options. The basic form is:

(logic <goal>
 :return-type <return-type>
 :all <all-type>
 :bag-exp <bag-exp>)

The keyword arguments are interpreted as follows:

:return-type describes what to do with a solution when one is found. Possible values of :return-type are:

;display Display variable bindings and prompt user (the option used by the read-query-print loop).
:fill Instantiate the goal expression and return it.
:bag Instantiate <bag-exp> and return it.
:alist Return an alist of variables and bindings.

The default is :fill.

:all tells what to do with multiple solutions. Possible values of :all are:

112
Return the first solution.

:values Return multiple solutions as multiple values.

:list Return a list of the solutions.

:bag-exp is an expression that should be instantiated with the bindings from a solution. This is only meaningful if :return-type is :bag.

### A.6.1 Examples

```
(logic '(color ?x) :return-type :display)
```

writes:

```
?X = RED<wait for input>
```

```
(logic '(color ?x) :return-type :fill)
```

returns:

```
(COLOR RED)
T
```

```
(logic '(color ?x) :return-type :alist)
```

returns:

```
((?X . RED))
T
```

```
(logic '(color ?x) :all :list)
```

returns:

```
((COLOR RED) (COLOR BLUE) (COLOR GREEN))
T
```

```
(logic '(color ?x)
   :return-type :bag
   :bag-exp '(%x is a color)
   :all :values)
```

returns:

```
(RED IS A COLOR)
(BLUE IS A COLOR)
(GREEN IS A COLOR)
```

A.6.2 Interface Functions

There are three additional ways to call logic, which are described in this section.

A.6.2.1 any, findall and findallset

Three simple interface functions call logic. They are any, findall, and findallset. Each takes two arguments: a result expression to instantiate and a goal expression. any returns the first solution found. findall returns all solutions. findallset returns all solutions deleting duplicates.

Assuming the definitions for fact and color from the previous examples.

```
|(any '(?x is the factorial of 5) '(fact 5 ?x))
```

returns:

```
|(120 IS THE FACTORIAL OF 5)
```

```
|(findall '(?x is a color) '(color ?x))
```

returns:

```
|{(RED IS A COLOR) (BLUE IS A COLOR)
  (GREEN IS A COLOR)}
```

```
|(findallset '?y '(or (= ?y 5) (= ?y 5)))
```

returns:

```
|(5)
```

findall and findallset will hang if a goal expression generates an infinite solution set.

More powerful all solution predicates (bagof and setof) are available from within Common Prolog.

A.6.2.2 deflogfun

A different interface is available for predicates which will be called often from Lisp. The macro deflogfun may be used to generate normal Lisp functions that run with precompiled goals.

```
(deflogfun break-up (y) (append ?a ?b y) (?a ?b))
```

then:
Appendix A: Common Prolog

\[(\text{break-up } '(\text{foo bar baz}))\]

returns:

\[(\text{NIL (FOO BAR BAZ)})\]
\[T\]

\[(\text{break-up } '(\text{foo bar baz}) :all :values)\]

returns:

\[(\text{NIL (FOO BAR BAZ)})\]
\[(() (FOO) (BAR BAZ))\]
\[(() (FOO BAR) (BAZ))\]
\[(() (FOO BAR BAZ) NIL)\]

\[(\text{break-up } '(\text{foo bar baz}) :all :list)\]

returns:

\[(() (NIL (FOO BAR BAZ))\]
\[(() (FOO) (BAR BAZ))\]
\[(() (FOO BAR) (BAZ))\]
\[(() (FOO BAR BAZ) NIL)\]
\[T\]

The generated function works like the Lisp functions \texttt{any} and \texttt{findall}, returning solutions to a prolog expression.

The form:

\[(\text{deflogfun name args sample-expr return-expr})\]

defines a Lisp function called \textit{name}, whose lambda list is the list \textit{args}. The function will also take a keyword argument :\textit{all}. If the function is called with :\textit{all} nil (the default), then it returns the first solution, like \texttt{any}. If the function is called with :\textit{all} t, then it returns a list of all the solutions, like \texttt{findall}. If the function is called with :\textit{all} :values, then it returns multiple values, with one value per solution.

The \textit{sample-expr} is like the second argument to \texttt{any}, that is, it is the prolog query expression. The \textit{return-expr} is like the first argument to \texttt{clog:any}, that is, it defines how the result will be formed from the results of the query. If any of the symbols mention in \textit{args} appears in \textit{sample-expr} or \textit{return-expr}, then its value is substituted. All other symbols in \textit{sample-expr} and \textit{return-expr} remain unchanged.

A.6.2.3 with-prolog

A final interface mechanism is \texttt{with-prolog}, which allows you to embed prolog into an arbitrary lisp function. Lisp variables are referenced in Prolog using ":?<name>".

\[(\text{defun palindromep (x)\n  (with-prolog\n    (append ?a (?b . ?c) ?.x) ; note ":?x" reference\n    (or (reverse ?a ?c)\n        (reverse ?a (?b . ?c))))\n  (palindromep '(yes no maybe)))\]

returns:
NIL

\[(\text{palindromep } '(\text{yes no maybe no yes}))\]

returns:

\[T\]

The body of a \texttt{with-prolog} returns \texttt{t} if it succeeds and a non-local exit is not executed. It returns \texttt{nil} on failure.

### A.7 Debugging

Common Prolog provides a standard 4-port debugging model (\texttt{call exit redo fail}). Tracing, Spy Points, Leashing, and Interactive Debugging are each discussed separately in this section.

#### A.7.1 Tracing

Exhaustive tracing is available with Common Prolog through the use of: \texttt{(trace)}. After executing \texttt{(trace)}, all goals will be displayed until control is returned to the top level loop, \texttt{nodebug} is executed or \texttt{notrace} is executed.

**A.7.1.1 Tracing rules**

You can turn on tracing for backward chaining from Lisp by running:

\[
\text{\texttt{\texttt{\texttt{(clog:logic '}}(\texttt{\texttt{\texttt{(and (clog:unleash) (trace))}}}}}\texttt{\texttt{)}}
\]

There are no command line tools for tracing forward chaining rules directly, but the RHS of each rule is run using a backward chaining rule with the same name, so they also appear when you trace backward chaining.

You could also add tracing to forward rules by defining a Meta Rule Protocol, for example like the explanation facility described in \ref{enum:6.1.3 A Simple Explanation Facility}.

#### A.7.2 Spy Points

Spy points are the most important debugging facility in Common Prolog. They are used in the same way \texttt{trace} is used in Lisp. After executing \texttt{(spy foo)}, all events associated with satisfying \texttt{foo} goals will be traced and the user will enter a debugging command loop at every port (see \ref{enum:A.7.4 Interactive Debugging} below). A user can also specify \texttt{(spy (foo 3))}, \texttt{(spy (foo bar))}, or \texttt{(spy ((foo 3) bar))} to place spy points on \texttt{foo} goals with arity 3, on all predicates for \texttt{foo} and \texttt{bar}, or on \texttt{foo} with arity 3 and all predicates for \texttt{bar} respectively. Spy points are turned off with \texttt{(nospy \texttt{<spypoints>})}. If no spy points are mentioned, \texttt{nospy} will turn off all spy points.

#### A.7.3 Leashing

Leashing allows the user to control execution while tracing for goals that are not spied. Spied goals cause execution to enter a debugging command loop whenever they are reached. Leashing provides the same functionality for unspied goals. A user may choose to enter a debugging command loop at any subset of ports by using \texttt{(leash events)} where \texttt{events} may be: \texttt{call}, \texttt{redo}, \texttt{exit} or \texttt{fail}. Leashing may be turned off using \texttt{(unleash)}. 

---

116
A.7.4 Interactive Debugging

When Common Prolog execution enters a debugging command loop, the user has many options, which may be listed with `?`, for example:

```prolog
|==> (spy member)

posium
YES.
OK.
```

```prolog
===> (member 3 ?x)

[1] CALL: (MEMBER 3 ?0) ? ? <- user types ?
```

- **(c)reep** - turn on exhaustive tracing
- **(s)kip** - skip until another port is reached for this goal
- **(l)eap** - turn off tracing until a spy point or this goal is reached
- **(b)reak** - enter a recursive read/query/print loop
- **(d)isplay** - display a listing for the current goal
- **(q)uit** - quit to top level
- **(r)etry** - try to satisfy this goal again
- **(f)ail** - cause the current goal to fail
- **(a)abort** - exit Common Prolog
- **?** - display this information

In a little more detail...

- **creep** - causes exhaustive tracing of the next goal
- **skip** - ignores spy points and executes without displaying anything until this goal is reached again either at an exit, fail, or redo port
- **leap** - turns off exhaustive tracing until a spy point or this goal is reached
- **break** - enters a recursive interpreter loop so that the user may query values, redefine a predicate, etc.
- **display** - uses "listing" to display the listing of the current goal
- **quit** - returns to the top level interpreter loop
- **retry** - causes execution to return to the call port of this goal as if this goal had just been reached for the first time.
- **fail** - causes execution to jump to the fail port of this goal
- **abort** - completely exit Common Prolog

Continuing the example:

```prolog
|d <- user selects display
```

Compiled procedure:
Another example:

```prolog
(%DEFREL reverse
   ((reverse () ()))
   ((reverse (?x . ?y) ?z)
    (reverse ?y ?w)
    (append ?w (?x) ?z)))
<noise..>

?X = ?0
?Y = ?1
?Z = ?2
?W = ?3

OK.
```

```prolog
(%DEFREL append
   ((append () ?x ?x))
   ((append (?u . ?x) ?y (?u . ?z))
    (append ?x ?y ?z)))
<noise..>

?X = ?0
?U = ?1
?Y = ?2
```
?Z = ?3

OK.

==> (unleash)

YES.
OK.

==> (trace)

YES.
OK.

==> (reverse (1 2 3) ?x)

[1] CALL: (REVERSE (1 2 3) ?0)
[2] CALL: (REVERSE (2 3) ?0)
[3] CALL: (REVERSE (3) ?0)
[4] CALL: (REVERSE NIL ?0)
[4] EXIT: (REVERSE NIL NIL)
[5] CALL: (APPEND NIL (3) ?0)
[5] EXIT: (APPEND NIL (3) (3))
[3] EXIT: (REVERSE (3) (3))
[6] CALL: (APPEND (3) (2) ?0)
[7] CALL: (APPEND NIL (2) ?0)
[7] EXIT: (APPEND NIL (2) (2))
[6] EXIT: (APPEND (3) (2) (3 2))
[2] EXIT: (REVERSE (2 3) (3 2))
[8] CALL: (APPEND (3 2) (1) ?0)
[9] CALL: (APPEND (2) (1) ?0)
[10] CALL: (APPEND NIL (1) ?0)
[10] EXIT: (APPEND NIL (1) (1))
[9] EXIT: (APPEND (2) (1) (2 1))
[8] EXIT: (APPEND (3 2) (1) (3 2 1))
[1] EXIT: (REVERSE (1 2 3) (3 2 1))

?X = (3 2 1);

[1] REDO: (REVERSE (1 2 3) (3 2 1))
[8] REDO: (APPEND (3 2) (1) (3 2 1))
[9] REDO: (APPEND (2) (1) (2 1))
[10] REDO: (APPEND NIL (1) (1))
[10] FAIL: (APPEND NIL (1) ?0)
[9] FAIL: (APPEND (2) (1) ?0)
[8] FAIL: (APPEND (3 2) (1) ?0)
[2] REDO: (REVERSE (2 3) (3 2))
[6] REDO: (APPEND (3) (2) (3 2))
[7] REDO: (APPEND NIL (2) (2))
[7] FAIL: (APPEND NIL (2) ?0)
[6] FAIL: (APPEND (3) (2) ?0)
[3] REDO: (REVERSE (3) (3))
[5] REDO: (APPEND NIL (3) (3))
[5] FAIL: (APPEND NIL (3) ?0)
[4] REDO: (REVERSE NIL NIL)
[4] FAIL: (REVERSE NIL ?0)
[3] FAIL: (REVERSE (3) ?0)
[2] FAIL: (REVERSE (2 3) ?0)
[1] FAIL: (REVERSE (1 2 3) ?0)

NO.
A.8 Common Prolog Macros

Macros may be defined within the logic system using the form:

\[
\text{(defrelmacro } \text{<name> <arg-list> <body>})
\]

which is effectively the same as a Common Lisp \texttt{defmacro}. Logic macros are expanded before variable translation so that logic variables may be treated as atoms. \texttt{defrelmacro} forms must have a fixed number of arguments. This allows different predicates with the same name but different arities to be defined. If you want to define a special form with an arbitrary number of arguments, use \texttt{defrel-special-form-macro}.

A.8.1 Example

\[
(\text{defrelmacro } \text{append3} (x y z w)
\quad \text{(let } (\text{iv (make-internal-var)}))
\quad \text{`(and (append ,x ,y ,iv)}
\quad \quad \text{(append ,iv ,z ,w)})))
\]

\[\Rightarrow (\text{append3} (1) (2) (3) ?y)\]

?Y = (1 2 3)

A.9 Defining Definite Clause Grammars

The \texttt{defgrammar} macro can be used to define a definite clause grammar (DCG), which is a relation that determines whether the start of a list of tokens (a \textit{sentence}) matches a particular grammar. The remaining tokens in the list become the \textit{sentence tail}.

The relation has the form:

\[(\text{<grammar name> <sentence> <sentence tail> <extra argument>*})\]

where the \texttt{<extra argument>} items are terms defined below.

The syntax of the \texttt{defgrammar} macro is:

\[
\begin{align*}
\text{(defgrammar } \text{<grammar name>} \\
\quad \text{<rule>*}) \\
\text{<rule>} &::= (\text{lhs} \text{ <rhs>*}) \\
\text{lhs} &::= \text{<grammar name>} \\
&\quad | (\text{<other grammar name> <term>*}) \\
&\quad | ((\text{<grammar name> <term>*}) <\text{newterm}>) \\
\text{<rhs>} &::= \text{<atom>} \\
&\quad | \text{<var>} \\
&\quad | (\text{<lisp clause>} \\
&\quad | (\text{call <term>}) \\
&\quad | (\text{cut}) \\
\text{lisp clause} &::= (\text{<non-atomic lisp form> <term>*}) \\
\text{<non-atomic lisp form>} &::= (\text{<lisp function name> <lisp arg>*})
\end{align*}
\]
Appendix A: Common Prolog

<grammar name> is the same symbol as the one naming the defgrammar.

<other grammar name> is a symbol naming another defgrammar.

<atom> is an atom, which forms the words of the sentence to be matched.

<var> is a variable reference.

<term> and <newterm> are any Common Prolog logic expression, including a variable.

<lisp function name> is a symbol naming a Lisp function.

<lisp arg> is any Lisp form, which is evaluated and passed to the function.

Within the <lhs>, extra arguments can be added by specifying <term>s. Every <rule> must specify the same <grammar name> as the defgrammar form and have the same number of extra arguments.

If the <lhs> specifies <newterm> forms, then they are pushed onto start of the sentence tail if the rule matches. This corresponds to the "pushback lists" or "right-hand context" in traditional Prolog DCG syntax.

The meaning of the various <rhs> items is as follows:

- <atom> matches that atom in the sentence.
- <var> is unified with the next item in the sentence.
- (<other grammar name> <term>*) calls the grammar relation <other grammar name> on the rest of the sentence. The optional <term> arguments are passed to the relation as its extra arguments.
- <lisp clause> evaluates the <non-atomic lisp form> as a Lisp form and unifies the values that it returns with the <term>s that follow it.
- (call <term>) calls <term> as a normal Prolog relation.
- (cut) calls the normal Prolog cut relation.

The phrase predicate can be used to call a DCG.

A.9.1 Examples

Here are some examples of using defgrammar.

A.9.1.1 Example 1: A simple definition.

This example shows the Common Prolog translation of the grammar shown at the top of http://cs.union.edu/~striegnk/learn-prolog-now/html/node59.html.

```
(defgrammar gram-det
  (gram-det the)
  (gram-det a))

(defgrammar gram-n
  (gram-n woman)
  (gram-n man))

(defgrammar gram-v
  (gram-v shoots))

(defgrammar gram-np
  (gram-np (gram-det) (gram-n)))
```
(defgrammar gram-vp
  (gram-vp (gram-v) (gram-np))
  (gram-vp (gram-v)))

(defgrammar gram-s
  (gram-s (gram-np) (gram-vp)))

Note the use of symbols for terminals and lists for non-terminals. They all use the first form of the `<lhs>` and have no extra terms on the `<rhs>`, so all of the relations are binary.

The following will both succeed and bind `?x` to the list `(foo bar)`:

```
(clog:any '?x '(gram-s (a woman shoots foo bar) ?x))
(clog:any '?x '(gram-s (a woman shoots the man foo bar) ?x))
```

A.9.1.2 Example 2: Using extra arguments.

```
(defgrammar one-of
  ((one-of ?word) ?word))

(defgrammar two-of
  ((two-of ?word) (one-of ?word) (one-of ?word)))
```

Each of these defines a 3-ary relation, whose extra argument is the word to match. When the relations are called, the word will typically be bound to a symbol from the sentence to match.

The following will succeed and bind `?x` to the list `(foo bar)`:

```
(clog:any '?x '(two-of (start start foo bar) ?x start))
```

The following will both fail because the sentences do not begin with two `start` symbols:

```
(clog:any '?x '(two-of (not-start start foo bar) ?x start))
(clog:any '?x '(two-of (start not-start foo bar) ?x start))
```

A.10 Edinburgh Syntax

Common Prolog provides a translator from Edinburgh syntax to allow users to port pre-existing code.

The `consult` predicate operates only on `.pl` files:

- `consult('xxx.pl')` means consult file `xxx.pl`.
- `consult('xxx')` means find a file named `xxx.pl` and consult it.

The `reconsult` predicate can operate on a Lisp source file, since `compile_and_reconsult('xxx.pl')` produces a Lisp binary file `xxx.?fasl`. That is, `reconsult` will load fasl and lisp files as well as `.pl` files:

- `reconsult('xxx.pl')` means reconsult file `xxx.pl`.
- `reconsult('xxx')` means look for a file named `xxx.?fasl` and load it, or if none found, look for `xxx.pl` and reconsult it, or if none found look for `xxx.lisp` and load it, or load `xxx`.

Loading a compiled file is equivalent to `reconsult`.

`compile_and_reconsult` compiles a file and reconsults the result.
Edinburgh syntax may also be used to interact with Common Prolog through the use of a different read-query-print loop. To use Edinburgh syntax, use \texttt{(erqp)} instead of \texttt{(rqp)} to start your command loop.

## A.11 Graphic Development Environment

Common Prolog includes a graphic environment, consisting of a specialized listener and graphic debugging tools. With the debugging tools it is possible to step through a program at the source level and control the 4-port debugger using the mouse. Call trees for predicates may also be displayed and manipulated.

The specialized listener provides mouse control over:

- File editing, compiling, consulting and reconsulting.
- Debugging control flow (creep, leap, skip, etc.).
- Leashing of debugging ports.
- The addition and deletion of spy points.

The Logic Listener interaction is similar to a normal Lisp Listener and will accept normal Lisp expressions except that:

1. Any expression that can be interpreted as Common Prolog will be handled by the Logic subsystem.
2. If a line consisting of just `?-' is entered, the Logic Listener will go into an Edinburgh \texttt{(erqp)} loop.

## A.12 Built-in Predicates

The built-in predicates listed in the table below are exported from the \texttt{common-prolog (clog)} package.

<table>
<thead>
<tr>
<th>Predicate</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/== (?x ?y)</td>
<td>same as Prolog (\equiv)</td>
</tr>
<tr>
<td>= (?x ?y)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td>=.. (?x ?y)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td>== (?x ?y)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td>@&lt; (?x ?y)</td>
<td>same as Prolog except all variables sort as identical</td>
</tr>
<tr>
<td>@=&lt;= (?x ?y)</td>
<td>ditto</td>
</tr>
<tr>
<td>@&gt; (?x ?y)</td>
<td>ditto</td>
</tr>
<tr>
<td>@&gt;= (?x ?y)</td>
<td>ditto</td>
</tr>
<tr>
<td>append (?x ?y ?z)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td>arg (+index +term ?value)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td>asserta (+exp)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td>assertz (+exp)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td>atomic (?x)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td>bagof (?exp (+goal . +ex-vars) ?bag)</td>
<td>standard Prolog (unusual syntax)*</td>
</tr>
<tr>
<td>call (+exp)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td>clause (+head ?tail)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>debug()</code></td>
<td>Cause debugging information to be saved for each call whether it is spied or not</td>
</tr>
<tr>
<td><code>debugging()</code></td>
<td>Display a list of all spied goals</td>
</tr>
<tr>
<td><code>defdetrel (+name &amp;rest +clauses)</code></td>
<td>Define a relation and declare it to be deterministic</td>
</tr>
<tr>
<td><code>defgrammar (+name &amp;rest +rules)</code></td>
<td>Define a grammar rule</td>
</tr>
<tr>
<td><code>defrel (+name &amp;rest +clauses)</code></td>
<td>Define a relation</td>
</tr>
<tr>
<td><code>defrelmacro (+name +args &amp;rest +body)</code></td>
<td>Define a logic macro</td>
</tr>
<tr>
<td><code>defrel-special-form-macro (+name +args &amp;rest +body)</code></td>
<td>Like <code>defrelmacro</code> but can have <code>&amp;rest</code> in <code>+args</code>. Use of this form will shadow all predicates named <code>+name</code> regardless of arity.</td>
</tr>
<tr>
<td><code>deterministic (+name)</code></td>
<td>Declare the relation called <code>+name</code> to be deterministic</td>
</tr>
<tr>
<td><code>erase (+ref)</code></td>
<td>Delete the predicate with database reference <code>+ref</code> from the database</td>
</tr>
<tr>
<td><code>fail()</code></td>
<td>Standard Prolog</td>
</tr>
<tr>
<td><code>findall (?exp +goal ?result)</code></td>
<td>Generate all solutions to <code>+goal</code> and instantiate <code>?exp</code> with the values. Return a list in <code>?result</code>.</td>
</tr>
<tr>
<td><code>findallset (?exp +goal ?result)</code></td>
<td>Same as <code>findall/3</code> but removes duplicates</td>
</tr>
<tr>
<td><code>halt()</code></td>
<td>Exit Common Prolog</td>
</tr>
<tr>
<td><code>integer (?x)</code></td>
<td>Standard Prolog</td>
</tr>
<tr>
<td><code>is (?result +exp)</code></td>
<td>Standard Prolog</td>
</tr>
<tr>
<td><code>keysort (+in ?out)</code></td>
<td>Standard Prolog except uses alist style cons pairs</td>
</tr>
<tr>
<td><code>leash (+event-spec)</code></td>
<td>Cause the interpreter to pause and ask for input when one of the leashed events is traced. An event-spec is one of: <code>call, exit, redo</code> or <code>fail</code>, or a list of ports.</td>
</tr>
<tr>
<td><code>listing (+name &amp;optional +arity)</code></td>
<td>Display a listing of the named predicate or listings for each arity if no arity is specified</td>
</tr>
<tr>
<td><code>member (+x ?y)</code></td>
<td>Standard Prolog</td>
</tr>
<tr>
<td><code>nodebug()</code></td>
<td>Leave debug mode (cease saving debug info for non-spied goals)</td>
</tr>
<tr>
<td><code>nospy (+args)</code></td>
<td>Remove <code>+args</code> from the list of spied goals. <code>+args</code> may be a predicate name or a list of predicate names. Unspy all goals if <code>+args</code> is <code>nil</code></td>
</tr>
<tr>
<td><code>not (+x)</code></td>
<td>Standard Prolog</td>
</tr>
<tr>
<td><code>notrace()</code></td>
<td>Turn off exhaustive tracing for debugged goals</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>once (+exp)</code></td>
<td>satisfy <code>+exp</code> as a goal once, then fail on retrying even if <code>+exp</code> has more solutions: this can be used to make a call deterministic so that the compiler can perform last call optimization.</td>
</tr>
<tr>
<td><code>output-defrels</code> (+name ?defrels)</td>
<td>return a list of <code>defrel</code> expressions derived from the dynamic clauses associated with <code>?name</code>.</td>
</tr>
<tr>
<td><code>read-term</code> (+term)</td>
<td>read in a term</td>
</tr>
<tr>
<td><code>recorda</code> (+exp ?val ?ref)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td><code>recordz</code> (+exp ?val ?ref)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td><code>repeat</code> ()</td>
<td>standard Prolog</td>
</tr>
<tr>
<td><code>retract</code> (+clause)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td><code>setof</code> (?exp (+goal . +ex-vars) ?bag)</td>
<td>standard Prolog (unusual syntax)*</td>
</tr>
<tr>
<td><code>sort</code> (+in ?out)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td><code>spy</code> (+args)</td>
<td>spy <code>+args. +args</code> may be a predicate name or a list of predicate names. If arity is not mentioned for a predicate name, predicates of all arities with that name are spied.</td>
</tr>
<tr>
<td><code>trace</code> ()</td>
<td>turn on tracing for debugged goals, also turn on debugging for the next top level goal</td>
</tr>
<tr>
<td><code>translate-vars</code> (?intern ?extern)</td>
<td>translate back and forth between internal and external variable representations. Can be used to pretty up the writing of terms containing variables</td>
</tr>
<tr>
<td><code>true</code> ()</td>
<td>standard Prolog</td>
</tr>
<tr>
<td><code>unleash</code> (+event-spec)</td>
<td>Undo leashing for <code>+event-spec</code>. <code>+event-spec</code> may be a port or a list of ports. If <code>+event-spec</code> is <code>nil</code>, all ports are unleashed.</td>
</tr>
<tr>
<td><code>var</code> (?x)</td>
<td>standard Prolog</td>
</tr>
<tr>
<td><code>phrase</code> +exp ?list</td>
<td>standard Prolog way to call a grammar rule</td>
</tr>
<tr>
<td><code>phrase</code> +exp ?list ?tail</td>
<td>standard Prolog way to call a grammar rule</td>
</tr>
</tbody>
</table>

* `setof` and `bagof` in standard Prolog use a special syntax for existentially quantified variables, for example:

```prolog
?- setof(X, Y^foo(X,Y), Z).
```

In Common Prolog, this would look like:

```prolog
===> (setof ?x ((foo ?x ?y) ?y) ?z)
```

So, a goal with no existentially quantified variables is nested in an extra set of parentheses:

```prolog
===> (bagof ?x ((bar ?x)) ?z)
```
A.13 Adding Built-in Predicates

Common Prolog provides several special forms for adding new predicates written in Lisp. Each one is described below, with an example.

A.13.1 The defdetpred form

The syntax of this form is:

```
(defdetpred <name> <num-args> <body>)
```

which defines a simple predicate that just runs Lisp code and does not have to unify any variables. Arguments are referenced with: `(special-arg <num>)`. The body succeeds by default, but if a failure case arises, use:

```
(detpred-fail <name> <num-args>)
```

For example:

```
(defdetpred my-integer 1
  (unless (integerp (special-arg 0))
    (detpred-fail my-integer 1)))
```

A.13.2 The defdetunipred form

The syntax of this form is:

```
(defdetunipred <name> <num-args> <unifier1 unifier2> <aux-vars> <body>)
```

`defdetunipred` is used when the defined predicate needs to unify values with arguments (or unify in general). The body is executed and, if successful, (that is, `detpred-fail` has not been called) unification is performed on the two unifiers. (If more than two items need to be unified, cons up lists of items to unify).

For example:

```
(defdetunipred my-arg 3 (temp1 temp2)
  (temp1 temp2 index term value)
  (setf index (special-arg 0)
    term (special-arg 1)
    value (special-arg 2))
  (unless (and (numberp index)
          (plusp index)
          (or (and (term-p term)
            (< index (length term))))
          (and (consp term)
            (< index 3))))
     (detpred-fail my-arg 3))
  (if (consp term)
    (setf temp1 (if (= index 1)
      (car term)
      (cdr term)))
    (setf temp1 (term-ref term index)))
  (setf temp2 value))
```
A.14 Edinburgh Compatibility Predicates

The following predicates all have their standard Edinburgh definitions (note that these are written as Lisp symbols, so \ is a Lisp escape character, meaning that \+ is the Edinburgh definition named \+):

```prolog
-->
->
/
//
<<
=
=<
>>
?-<
@>
@>=
,.
:=-


\+=
\\\
\\=
\\=-
\\=+
\\/
\\+=

^current-op
display
get
get0
is
name
nl
put
see
seen
skip
tell
telling
told
ttynl
ttyput
write
writeq
|is|
```
Appendix B: Examples

B.1 The Tutorial

The code for the tutorial (2 Tutorial) is reproduced for easy reference.

```lisp
;;;; OBJECT DEFINITIONS

(defun kb-class node ()

  ((animal :initform nil :accessor node-animal
             :initarg :animal)
   (question :initform nil :accessor node-question
             :initarg :question)
   (yes-node :initform nil :accessor node-yes-node
             :initarg :yes-node)
   (no-node :initform nil :accessor node-no-node
             :initarg :no-node)))

(defun kb-class root ()

  ((node :initform nil :accessor root-node
         :initarg :node)))

(defun kb-struct current-node node)
(defun kb-struct game-over node animal answer)

;;; FORWARD CHAINING RULES

;;; if there is no question we are about to ask then
;;; ask the question which is the root question of the
;;; question tree

(defun play :forward

  (root ?r node ?node)
  (not (current-node ? node ?))

  (tk:send-a-message
   (format nil "  ANIMAL GUESSING GAME - ~
             think of an animal to continue")))

  (assert (current-node ? node ?node)))

;;; ask a yes/no question - these are non-leaf questions

(defun y-n-question :forward

  (current-node ?current node ?node)
  (node ?node animal nil question ?q yes-node ?y-n
       no-node ?n-n)

  (tk:confirm-yes-or-no ?q) ?answer

  (erase ?current)

  ((find-new-node ?answer ?y-n ?n-n) ?new-current)

  (assert (current-node ? node ?new-current)))

(defun find-new-node (answer yes-node no-node)
  (if answer yes-node no-node))
```
;;; ask an animal question - these are leaf questions

(defrule animal-question :forward
  (current-node ?current node ?node)
  (node ?node animal ?animal question nil)
  -->
  (tk:confirm-yes-or-no
   (format nil "Is it a ~a?" ?animal)) ?answer)
  (erase ?current)
  (assert (game-over ? node ?node animal ?animal answer ?answer)))

;;; add new nodes to the tree for the new animal and
;;; the question that distinguishes it

(defrule new-question :forward
  :priority 20
  (game-over ? node ?node animal ?animal answer nil)
  -->
  (fetch-new-animal ?new-animal)
  ((tk:popup-prompt-for-string
    (format nil "Tell me a question for which the ~
    answer is yes for a ~a and no for a ~a" ?new-animal ?animal)) ?question)
  (assert (node ?yes-node question nil animal ?new-animal))
  (assert (node ?no-node question nil animal ?animal))
  (assert (node ?node animal nil yes-node ?yes-node no-node ?no-node question ?question)))

;;; game is over

(defrule game-finished :forward
  :priority 15
  (game-over ?g)
  -->
  (erase ?g)
  ; (test (not (tk:confirm-yes-or-no "Play again?")
  (return)))

;;; -------------------------------- BACKWARD CHAINING ----------------

;;; prompt user for new animal

(defrule fetch-new-animal :backward
  ((fetch-new-animal ?new-animal)
   <--
   (repeat)
   (string-upcase
    (tk:popup-prompt-for-string
     "What was your animal?")
     ?new-animal)
   (not (= ?new-animal "NIL")) ; check if abort was pressed
   (or
    (does-not-exist-already ?new-animal)
    (and ((tk:send-a-message "Animal exists already") (fail)))
   )
  )

;;; check if a node already refers to this animal

(defrule does-not-exist-already :backward
  ((does-not-exist-already ?animal)
   <--
   (node ? animal ?animal)
   (cut)
(fail)
((does-not-exist-already ?animal)
  <-- ))

;;;; -------------- SAVING THE ANIMAL BASE ------------
;;;; writes out code which when loaded reconstructs the
;;;; tree of questions

(defun save-animals (filename)
  (let* ((start-node (any `?node `(root ? node ?node)))
          (code `(make-instance `root
                         :node ,(node-code start-node))))
          (*print-pretty* t))
    (with-open-file
      (stream filename :direction :output
                   :if-exists :supersede)
      (write `(in-package kw-user) :stream stream)
      (write-char #\Newline stream)
      (write code :stream stream))
    nil))

(defun node-code (node)
  (when node
    `(make-instance `node
                   :question ,(node-question node)
                   :animal `,(node-animal node)
                   :yes-node ,(node-code (node-yes-node node))
                   :no-node ,(node-code (node-no-node node))))

B.2 Explanation Facility

Below is the complete code implementing the simple explanation facility of 6.1.1.3 A Simple Explanation Facility. The implementation principle is exactly as described.

;;;; A SIMPLE EXPLANATION FACILITY

(in-package kw-user)

; connects rule to explanation definitions
(defvar *explanation-table*
  (make-hash-table :test #'eq))

; explanation generated at run time
(defvar *explanation* nil)

;;;; the next four definitions make up the defexplain
;;;; macro for each of the why, what and because
;;;; definitions we create a function which we can call
;;;; at run time on the bindings of the instantiation to
;;;; generate the explanation text - this will be
;;;; reasonably efficient

(defun is-var (expr)
  "is this a variable (i.e. starts with ?)"
  (and (symbolp expr)
       (eql (char (symbol-name expr) 0) #\?)))

(defun find-vars (expr)
  "returns a list of all the variables in expr"
  (if (consp expr)
      (append (find-vars (car expr))
              (find-vars (cdr expr)))
      nil))
(defun make-explain-func (explain-stuff)
  "generates a function to generate explanation text at
  run time"
  (let* ((explain-string (car explain-stuff))
         (explain-args (cdr explain-stuff))
         (vars (remove-duplicates
                (find-vars explain-args))))
    `(lambda (bindings)
        (let ,,(mapcar
            #'(lambda (v)
                `(,v (cdr (assoc ,v bindings))))
            vars)
            (format nil ,explain-string
                    ,@explain-args)))))

(defun defexplain (rulename &key why what because)
  "puts an entry for the rule in the explanation table"
  `(setf (gethash `,,rulename *explanation-table*)
         (list ,,(make-explain-func why)
               ,,(make-explain-func what)
               ,,(make-explain-func because)))))

;;; next two definitions generate an explanation for
;;; each instantiation that fires and stores it away in
;;; *explanation*  

(defun add-explanation (inst)
  "generate an explanation for firing this
  instantiation"
  (let ((explain-info
          (gethash (inst-rulename inst)
                   *explanation-table*))
          (when explain-info
            (do-the-rest explain-info (inst-bindings inst)))))

(defun do-the-rest (explain-info bindings)
  "creates explanation text derived from explain
  functions and bindings"
  (let ((why-func (first explain-info))
        (what-func (second explain-info))
        (because-func (third explain-info)))
    (push `(*cycle* ,,(inst-rulename inst)
            ,(funcall why-func bindings)
            ,(funcall what-func bindings)
            ,(funcall because-func bindings)
            *explanation*)))))

;;; meta-interpreter for explanation contexts
;;; before firing the rule generate explanation for
;;; this cycle

(defrule explain-context :backward
  (explain-context)
  <--
  (start-cycle)
  ((add-explanation ?inst))
  (fire-rule ?inst)
  (cut)
  (explain-context)))

;;; simple text output of the explanation

(defun explain (&optional cycle)
"print out either the whole explanation or just for one cycle"
(if cycle (explain-cycle (assoc cycle *explanation*))
  (dolist (cycle-entry (reverse *explanation*))
    (explain-cycle cycle-entry))))

(defun explain-cycle (entry)
  "print this explanation entry"
  (if entry
    (let ((cycle (first entry))
      (rulename (second entry))
      (why (third entry))
      (what (fourth entry))
      (because (fifth entry)))
      (format t "~-2%-a: ~a~%~a~%~a~%~a"
        cycle rulename why what because))
    (format t "~-2%-No explanation for this cycle")))

;;; we could make a really smart tool here, but to give
;;; the general idea...

(defun explain-an-action ()
  (let ((item
tk:scrollable-menu
    (reverse *explanation*)
    :title "Which action do you want explained?"
    :name-function #'(lambda (x) (fourth x))))
    (if item (tk:send-a-message (fifth item))))

;;; starting the rule interpreter should clear any old
;;; explanation

(defadvice (infer rest-explanation :before)
  (&rest args)
  (unless *in-interpreter* (setq *explanation* nil)))

Below are some example rules using the explanation facility. They are taken from the Monkey and Banana Example distributed with KnowledgeWorks. The classes used in the example are **monkey**, **object** and **goal**.

(defrule mb7 :forward
  :context mab
  (goal ?g status active type holds object ?w)
  (object ?o1 kb-name ?w at ?p on floor)
  (monkey ?m at ?p holds nil)
  ==> 
  ((format t "~%Grab ~s" ?w))
  (assert (monkey ?m holds ?w))
  (assert (goal ?g status satisfied)))

(defexplain mb7
:why ("Monkey is at the ~s which is on the floor" ?w)
:what ("Monkey grabs the ~s" ?w)
:because ("Monkey needs the ~s somewhere else" ?w))

(defrule mb12 :forward
  :context mab
  :context mab
  (goal ?g status active type walk-to object ?p)
  (monkey ?m on floor at ?c holds nil)
  (test (not (eq ?c ?p)))
  ==> 
  ((format t "~%Walk to ~s" ?p))
  (assert (monkey ?m at ?p))
  (assert (goal ?g status satisfied)))
(defexplain mb12
  :why ("Monkey is on the floor holding nothing")
  :what ("Monkey walks to ~s" ?p)
  :because ("Monkey needs to do something with an object at ~s" ?p))

(defrule mb13 :forward
  :context mab
  (goal ?g status active type walk-to object ?p)
  (monkey ?m on floor at ?c holds ?w)
  (test (and ?w (not (eq ?c ?p))))
  (object ?o1 kb-name ?w)
  (assert (monkey ?m at ?p))
  (assert (object ?o1 at ?p))
  (assert (goal ?g status satisfied)))

(defexplain mb13
  :why ("Monkey is on the floor and is holding the ~s" ?w)
  :what ("Monkey walks to ~s with the ~s" ?p ?w)
  :because ("Monkey wants the ~s to be at ~s" ?w ?p))

(defrule mb14 :forward
  :context mab
  (goal ?g status active type on object floor)
  (monkey ?m on ?x)
  (test (not (eq ?x `floor)))
  (object ?o1 kb-name ?o at ?p)
  (assert (monkey ?m on floor))
  (assert (goal ?g status satisfied)))

(defexplain mb14
  :why ("Monkey is on ~s" ?x)
  :what ("Monkey jumps onto the floor")
  :because ("Monkey needs to go somewhere")

(defrule mb17 :forward
  :context mab
  (goal ?g status active type on object ?o)
  (object ?o1 kb-name ?o at ?p)
  (monkey ?m at ?p holds nil)
  (assert (monkey ?m on ?o))
  (assert (goal ?g status satisfied)))

(defexplain mb17
  :why ("Monkey is at the location of the ~s" ?o)
  :what ("Monkey climbs onto the ~s")
  :because ("Monkey wants to be on top of the ~s" ?o))

(defrule mb18 :forward
  :context mab
  (goal ?g status active type holds object nil)
  (monkey ?m holds ?x)
  (test ?x)
  (assert (monkey ?m holds nil))
  (assert (goal ?g status satisfied)))

(defexplain mb18
  :why ("Monkey is holding a nil")
  :what ("Monkey drops the nil")
  :because ("Monkey needs to clear his hands"))
B.3 Uncertain Reasoning Facility

Below is the complete code which implements the uncertain reasoning facility of 6.1.1.4 Reasoning with Certainty Factors. The implementation is exactly as described with a few extra considerations to check the rule interpreter is running before returning an uncertain value, that the objects have a certainty-factor slot and so on.

;;; -----SIMPLE REASONING WITH UNCERTAINTY FACTORS ----

(in-package kw-user)

;;; default certainty factor
(defvar *c-factor* 1)

;;; implication strength of a rule
(defvar *implication-strength* 1)

(defun default-c-factor ()
  "if the forward chainer is not running, certainty
  factor is just 1"
  (if *in-interpreter*
      (* *implication-strength* *c-factor*)
      1))

;;; uncertain objects need a slot to store their
;;; 'probability' this slot defaults to the value
;;; returned by default-c-factor

(defun object-c-factor (obj)
  "if an object has no uncertainty slot, return 1 (i.e.
   certain)"
  (if (slot-exists-p obj `c-factor)
      (slot-value obj `c-factor)
      1))

(defun inst-c-factor (inst)
  "the certainty factor of an instantiation"
  (token-c-factor (inst-token inst)))

(defun token-c-factor (token)
  "the certainty factor of an ANDed list of objects
  (just multiply them)"
  (reduce `* (mapcar `object-c-factor token)))

(defun implication-strength (val)
  "for a rule to set the implication strength"
  (setq *implication-strength* val))

;;; this function increases the certainty of the object
;;; which is the first argument by an amount dependent
;;; on the combined certainty of the remaining
;;; arguments

(defun add-evidence (obj &rest token)
  "increments the certainty of obj based on the
  ---

:why ("Monkey is holding the ~s" ?x)
:what ("Monkey drops the ~s" ?x)
:because ("Monkey wants to do something for which he
can't hold anything")

Appendix B: Examples

:why ("Monkey is holding the ~s" ?x)
:what ("Monkey drops the ~s" ?x)
:because ("Monkey wants to do something for which he
can't hold anything")
certainty of token"
(let ((c-f (slot-value obj `c-factor)))
  (setf (slot-value obj `c-factor)
        (+ c-f
          (* (- 1 c-f) *implication-strength*
            (token-c-factor token))))))

;;; this tactic is dynamic as the certainty factor slot
;;; gets changed by calling add-evidence

(defun certainty :dynamic (i1 i2)
  "a conflict resolution tactic to prefer more certain
instantiations"
  (> (inst-c-factor i1) (inst-c-factor i2)))

;;; Before firing a rule this meta-interpreter just
;;; sets the value of *c-factor* to the certainty of
;;; the instantiation so that any new uncertain objects
;;; made get this (times *implication-strength*) as
;;; their certainty. Also sets *implication-strength*
;;; to 1 as a default in case the rule does not set it.

(defun uncertain-context :backward
  ((uncertain-context)
   <--
   (start-cycle)
   (instantiation ?inst)
   ((progn (setq *c-factor* (inst-c-factor ?inst))
            (setq *implication-strength* 1)))
   (fire-rule ?inst)
   (cut)
   (uncertain-context)))

Below are some example rules using this facility for a simple car maintenance problem.

;;; ---------------- SOME EXAMPLE RULES ---------------
;;; to run: (run-diagnose)

(defun kb-struct start)
(defun kb-class symptom (uncertain-kb-object)
  ((type :initarg :type))
(defun kb-class fault (uncertain-kb-object)
  ((type :initarg :type))
(defun kb-class remedy (uncertain-kb-object)
  ((type :initarg :type))

;;; this context sets up the initial hypotheses and
;;; gathers evidence this does not need the meta
;;; -interpreter as that's only necessary for
;;; transparent assignment of certainty factors to new
;;; objects

(defun context diagnose :strategy ()
  (start ?s)
  -->
  (assert (symptom ? type over-heat c-factor 1))
  (assert (symptom ? type power-loss c-factor 1))
  (assert (fault ? type lack-of-oil c-factor 0.5))
  (assert (fault ? type lack-of-water c-factor 0))
  (assert (fault ? type battery c-factor 0))
  (assert (fault ? type unknown c-factor 0))
  (context (cure)))
(defrule diagnose1 :forward
  :context diagnose
  (symptom ?s type over-heat)
  (fault ?f type lack-of-water)
  -->
  ((implication-strength 0.9))
  ((add-evidence ?f ?s)))

(defrule diagnose2 :forward
  :context diagnose
  (symptom ?s type overheat)
  (fault ?f type unknown)
  -->
  ((implication-strength 0.1))
  ((add-evidence ?f ?s)))

(defrule diagnose3 :forward
  :context diagnose
  (symptom ?s type wont-start)
  (fault ?f type battery)
  -->
  ((implication-strength 0.9))
  ((add-evidence ?f ?s)))

(defrule diagnose4 :forward
  :context diagnose
  (symptom ?s type wont-start)
  (fault ?f type unknown)
  -->
  ((implication-strength 0.1))
  ((add-evidence ?f ?s)))

(defrule diagnose5 :forward
  :context diagnose
  (symptom ?s type power-loss)
  (fault ?f type lack-of-oil)
  -->
  ((implication-strength 0.9))
  ((add-evidence ?f ?s)))

(defrule diagnose6 :forward
  :context diagnose
  (symptom ?s type power-loss)
  (fault ?f type unknown)
  -->
  ((implication-strength 0.1))
  ((add-evidence ?f ?s)))

;;; any two distinct symptoms strengthens the
;;; hypothesis that there's something more serious
;;; going wrong

(defrule diagnose7 :forward
  :context diagnose
  (symptom ?s1 type ?t1)
  (symptom ?s2 type ?t2)
  (test (not (eq ?t1 ?t2)))
  (fault ?f type unknown)
  -->
  ((add-evidence ?f ?s1 ?s2)))

;;; here we need the meta-interpreter to assign the
;;; right certainty factors to the remedy objects. Also
;;; use certainty as a conflict resolution tactic to
;;; print the suggested remedies out in order

(defcontext cure :strategy (priority certainty):
 :meta ((uncertain-context)))

(defrule cure1 :forward :context cure
 (fault ?f type unknown)
  >>>
 (assert (remedy ? type cross-fingers))
 (assert (remedy ? type go-to-garage)))

(defrule cure2 :forward :context cure
 (fault ?f type lack-of-oil)
  >>>
 (assert (remedy ? type add-oil)))

(defrule cure3 :forward :context cure
 (fault ?f type lack-of-water)
  >>>
 (assert (remedy ? type add-water)))

(defrule cure4 :forward :context cure
 (fault ?f type battery)
  >>>
 (assert (remedy ? type new-battery)))

(defrule print-cures :forward :context cure :priority 5
 (remedy ?r type ?t)
  >>>
 ((format t "Suggest remedy ~a with certainty-factor ~a" ?t (slot-value ?r `c-factor))))

(defun run-diagnose ()
 (reset)
 (make-instance `start)
 (infer :contexts `(diagnose)))

## B.4 Other Examples

Other examples distributed with KnowledgeWorks include:

- Truck — a largely forward chaining truck scheduling example.
- Spill — an outline of a chemical spillage diagnosis system.
- Whist — a windowing example which plays whist.
Appendix C: Implementation Notes

C.1 Forward Chainer

C.1.1 Forward Chaining Algorithm

The KnowledgeWorks forward chaining engine is based on the RETE algorithm (see *Rete: A Fast Algorithm for the Many Pattern/Many Object Pattern Match Problem* by Forgy in *Artificial Intelligence* 19, September 1982). A data flow network representing the conditions of the forward chaining rules (a RETE network) is maintained and this keeps lists of the instantiations and partial instantiations of rules. This structure is modified at run time as objects change. The RETE algorithm relies on the tacit assumption that during the forward chaining cycle relatively few objects change (hence there are relatively few changes to be made to the network each cycle), and in these cases gives a huge increase in performance speed.

C.1.2 CLOS and the Forward Chainer

CLOS objects acquire KnowledgeWorks functionality from the `standard-kb-object` mixin. Object creation and modification hooks defined on this mixin enable the RETE network to track the objects. Objects are indexed into the RETE network by class and modifications propagated only where any changes to the slots of the object are relevant.

One potential problem is that as KnowledgeWorks CLOS objects are designed for use in ordinary code, performance could deteriorate seriously as every time an object is changed the RETE network must be amended. For this reason changes to CLOS objects are merely remembered as they are made. The stored set of changes is flushed at the start of every forward chaining cycle, so the penalty for using KnowledgeWorks objects is really only paid when the forward chainer is running.

C.1.3 Forward Chaining and the Backward Chainer

For more uniform semantics throughout KnowledgeWorks, the right hand side of KnowledgeWorks forward chaining rules are executed directly by the backward chainer, as is the default meta-interpreter for a context which has no meta-interpreter specially defined. When compiled with debugging turned off, in many cases the backward chainer can be optimized out leaving raw Lisp code.

C.2 Backward Chainer

C.2.1 Backward Chaining Algorithm

The KnowledgeWorks backward chaining system is an extended Prolog written entirely in Lisp and based loosely on the Warren Abstract Machine (WAM). (see *An Abstract Prolog Instruction Set* by David H.D. Warren, Technical Note 309 SRI International October 1983). High performance is achieved by compiling each Prolog clause into a Lisp function and handling the Prolog control flow with continuation passing. This approach removes the need for interpretation and provides easy integration with CLOS.
C.2.2 Term Structure

In order to provide compatibility with Edinburgh Prolog, the KnowledgeWorks backward chaining system treats Prolog structured terms differently from lists. Structured terms whose functors are not `.' are stored as simple vectors with the functor as element 0 (for example, the term: \texttt{foo(bar)} is equivalent to \texttt{#(foo bar)}).

C.2.3 The Binding Trail

The variable binding trail for the backward chainer is stored in a simple vector but may overflow into list structure if the trail grows larger than the size of the vector: (30000). The system will continue to function normally when this happens but may slow down slightly and do more consing. (Note: We have never written a program that causes this to happen other than deliberately produced testing programs).
Appendix D: For More Information

D.1 General References

D.1.1 Forward Chaining

- Programming Expert Systems in OPS5, An Introduction to Rule-Based Programming by Lee Brownston, Robert Farrell, Elaine Kant and Nancy Martin (Addison-Wesley). While being specifically on OPS5, this text covers most aspects of forward chaining in considerable detail.

D.1.2 Backward Chaining and Prolog

- The Art of Prolog, by Leon Sterling and Ehud Shapiro (MIT Press).
- The Craft of Prolog, by Richard A. O'Keefe (MIT Press). This is a more advanced text.

D.1.3 Uncertain Reasoning

- Rule-Based Expert Systems, by B. G. Buchanan and E. H. Shortliffe (Addison-Wesley). This text covers specifically the MYCIN system.

D.1.4 Expert Systems

- Building Expert Systems, by Frederick Hayes-Roth, Donald A. Waterman and Douglas B. Lenat (Addison-Wesley). This text focuses more on the issues involved in designing an expert system.

D.1.5 Lisp and CLOS

- The Art of the Metaobject Protocol, by Gregor Kiczales, Jim des Rivieres and Daniel G. Bobrow (MIT Press). This is the only proper guide to the CLOS Metaobject Protocol.

D.2 The LispWorks manuals

In addition to the KnowledgeWorks and Prolog User Guide, the LispWorks manual set includes the following manuals which might be helpful while using KnowledgeWorks:

- The LispWorks® User Guide and Reference Manual describes the language-level features and tools available in LispWorks, along with detailed information on the functions, macros, variables and classes.
Appendix D: For More Information

- The *LispWorks IDE User Guide* describes the LispWorks IDE, the user interface for LispWorks. The LispWorks IDE is a set of windowing tools that let you develop and test Common Lisp code more easily and quickly.

- The *Editor User Guide* describes the keyboard commands and programming interface to the the LispWorks IDE editor tool.

- The *Release Notes and Installation Guide* explains how to install LispWorks, configure it and start it running. It also contains a set of release notes that documents last minute issues that could not be included in the main manual set.

These books are all available in HTML and PDF formats.

Commands in the **Help** menu of any of the the LispWorks IDE tools give you direct access to the online documentation in HTML format. Details of how to use these commands can be found in the *LispWorks IDE User Guide*.

Please let us know at **lisp-support@lispworks.com** if you find any mistakes in the LispWorks documentation, or if you have any suggestions for improvements.
Appendix E: Converting Other Systems

E.1 OPS5

OPS5 rulebases may be readily converted into KnowledgeWorks rulebases. The main OPS5 forms needing conversion are:

- **literalize** into `def-kb-struct` or `def-kb-class`. For example:

  \[
  (\text{literalize employee name father-name mother-name})
  \]

  could become:

  \[
  (\text{def-kb-struct employee name father-name mother-name})
  \]

- **strategy** into a defcontext form with the right conflict resolution strategy. For example:

  \[
  (\text{strategy lex})
  \]

  could become:

  \[
  (\text{defcontext ops5 :strategy (lex specificity)})
  \]

  and:

  \[
  (\text{strategy mea})
  \]

  could become:

  \[
  (\text{defcontext ops5 :strategy (mea lex specificity)})
  \]

In OPS5 you cannot have different conflict resolution strategies for different sets of rules. The KnowledgeWorks context mechanism for passing control is much clearer and more powerful than, for instance, the use of the MEA strategy as sole control mechanism in OPS5.

- **p** into `defrule`. For example, the OPS5 rule:

  \[
  (\text{p recognize-pair}
  \text{ (employee ^name <parent>)}
  \text{ (employee ^name <child> ^mother-name <parent>)}
  \text{ --- >}
  \text{ (make pair))}
  \]

  will become:

  \[
  (\text{defrule recognize-pair :forward}
  \text{ (employee ? name ?parent)}
  \text{ (employee ? name ?child mother-name ?parent)}
  \text{ --- >}
  \text{ (assert (pair ?))})
  \]

As an extended example below are given some OPS5 rules from the Monkey and Banana problem (see Appendix B):
Examples):

(strategy mea)
(literalize monkey
  name at on holds)
(literalize object
  name at weight on)
(literalize goal
  status type object to)
(literalize start)

(p mb1
  (goal ^status active ^type holds ^object <w>)
  (object ^name <w> ^at <p> ^on ceiling)
  -->
  (make goal ^status active ^type move ^object ladder
    ^to <p>))

(p mb4
  {(goal ^status active ^type holds ^object <w>) <goal>}
  (object ^name <w> ^at <p> ^on ceiling)
  (object ^name ladder ^at <p>)
  { (monkey ^on ladder ^holds nil) <monkey> }
  -->
  (write (crlf) Grab <w>)
  (modify <goal> ^status satisfied)
  (modify <monkey> ^holds <w>))

(p mb8
  (goal ^status active ^type move ^object <o> ^to <p>)
  (object ^name <o> ^weight light ^at <> <p>)
  -->
  (make goal ^status active ^type holds ^object <o>))

In KnowledgeWorks this could be:

(defcontext ops5 :strategy (mea lex specificity))

(def-named-kb-class monkey ()
  ((at :initform nil)
   (on :initform nil)
   (holds :initform nil)))

(def-named-kb-class object ()
  ((at :initform nil)
   (weight :initform nil)
   (on :initform nil)))

(def-kb-struct goal status type object to)
(def-kb-struct start)

(defrule mb1 :forward
  :context ops5
  (goal ?g status active type holds object ?w)
  (object ? name ?w at ?p on ceiling)
  -->
  (assert (goal ?g status active type move object ladder
    to ?p)))

(defrule mb4 :forward
  :context ops5
  (goal ?g status active type holds object ?w)
  (object ? name ?w at ?p on ceiling)
  (object ? name ladder at ?p)
  (monkey ?m on ladder holds nil)
(assert (goal ?g status satisfied))
(assert (monkey ?m holds ?w))

(defrule mb8 :forward
  :context ops5
  (goal ? status active type move object ?o to ?p)
  (object ? name ?o weight light at ?q)
  (test (not (eq ?q ?p))))

--->
((format t "~%Grab ~S" ?w))

E.2 Prolog

Please refer to A.10 Edinburgh Syntax.
Glossary

agenda
A stack of rule groups (or contexts). Control can be passed to the next context on the agenda.

arity
The number of arguments (to a function, rule condition etc.)

backward chaining
The process of reasoning backward from postulated goals to determine if their preconditions can be satisfied. If these preconditions are satisfied the postulated goals are considered true.

browsers
Windows which allow you to look freely through different parts of the system.

class
In object-oriented programming, classes define classes with the same attributes (slots) and behavior (methods). Instances of these classes are created during the execution of a program which represent concrete examples of the abstract class descriptions.

conflict resolution strategy
The method(s) used to decide which of a set of eligible rules will fire. A conflict resolution strategy is a list of conflict resolution tactics which are applied in sequence to the conflict set to determine which instantiation is to fire.

conflict resolution tactic
A single predicate used to decide whether one instantiation is to be preferred to another. They may be combined into a conflict resolution strategy.

conflict set
The set of instantiations of rules which at a given time are matched by the object base.

contexts
Groups of rules in a knowledge base.

destructuring
The ability to match an expression against a piece of data where variables in the expression are bound to the corresponding parts of the data if the structure of the expression and the data agree. For example, (?x . ?y) can match (1 2 3) with ?x binding to 1 and ?y to (2 3).

forward chaining
The process of reasoning forward from known facts to perform arbitrary actions and to deduce new facts.
forward chaining cycle
The process of matching the conditions of rules against the object base to produce a set of rules eligible to fire (the conflict set), selecting one of those (conflict resolution) and firing it (performing its actions).

inference engine
The part of the system which is responsible for rule-firing, either in backward or forward chaining mode.

inferencing state
A collection of information that the inferencing engine uses.

instantiation
An instantiation of a rule is the set of objects against which a rule matches. A rule may have no instantiations (if it is not matched at all by the object base) or many instantiations (each referring to a different set of objects).

knowledge based systems
A system which encodes the knowledge for a problem domain in high-level forms, usually facts and rules. The software architecture separates the knowledge from the inference mechanism used to deduce new knowledge.

LispWorks
An advanced Common Lisp programming environment, which serves as the infrastructure for KnowledgeWorks.

meta object protocol (MOP)
Describes how the Common Lisp Object System is implemented in terms of itself. Hence CLOS may be used to modify its own behavior.

meta rule protocol (MRP)
Allows you to debug, modify or replace the default behavior of forward chaining rules in the system in terms of backward chaining goals.

object base
The set of CLOS objects which KnowledgeWorks can reason over ("knows about").

object-oriented
Programming paradigm in which structures within the language are organized as classes of objects which have attributes (slots) and behavior (methods) associated with them.

objects
The KnowledgeWorks® object base contains KnowledgeWorks CLOS objects, which may for efficiency be replaced by KnowledgeWorks structures.

structures
A CLOS class can be replaced by a structure class in cases where speed is important and the code must be optimized, and when the full power of CLOS is not required. The structure is then analogous to the CLOS object.
toolkit

A collection of complementary software or utilities (such as KnowledgeWorks®) with a common application focus.
The document contains an index page from a technical manual. The index includes entries for various concepts, functions, and topics, along with page numbers indicating where they are discussed. Here is a structured representation of the index content:

**Index**

A
- action 1.1.2: Technical Overview 9, 3.1.1: Overview 22, 3.2.5: The Backward Chaining Interpreter 28
- **add-explanation** 6.1.1.3: A Simple Explanation Facility 49
- **assert** 3.1.2: Forward Chaining Syntax 23
- **assert** backward chaining goal 60 6.4: Logical Dependencies and Truth Maintenance 56
- **assertz** A.12: Built-in Predicates 123
- **arity** 3.2.2: Backward Chaining Syntax 27, 5.1: The KnowledgeWorks Listener 36
- **atomic** A.12: Built-in Predicates 123

B
- backward chaining 1.1.2: Technical Overview 8, 2.4.1: Rule Browser 13, 3: Rules 22, 3.2: Backward Chaining 26, 6.2.3: Backward Chaining 54
- debugging 3.2.7: Backward Chaining Debugging 28
- definition of rules 3.2.4: Defining Backward Chaining Rules 27
- implementation notes C.2: Backward Chainer 138
- interpreter 3.2.5: The Backward Chaining Interpreter 27
- syntax 3.2.2: Backward Chaining Syntax 27

backward chaining goals
- **assert** 60 6.4: Logical Dependencies and Truth Maintenance 56
- **conflict-set** 62
- **context** 63
- **cut** 64
- **erase** 73 6.4: Logical Dependencies and Truth Maintenance 56
- **fail** 73
- **fire-rule** 76 6.1.1: Meta Rule Protocol 47
- **instantiation** 80 6.1.1: Meta Rule Protocol 47, 6.1.1: Meta Rule Protocol 48
- **kw-class** 84
- **not** 92
Index

return 99
standard-context 102
start-cycle 103  6.1.1 : Meta Rule Protocol 47
test 105

bagof  A.12 : Built-in Predicates 123
browsers 2.4 : Browsers 13
class 2.4.3 : Class Browser 15,  5.5 : The Class Browser 38
object 2.4.2 : Objects Browser 14,  2.6.2 : Single-Stepping Rules 19,  5.6 : The Objects Browser 41
rule 2.4.1 : Rule Browser 13,  2.6.1 : Monitoring Forward Chaining Rules 18,  5.7 : The Rule Browser 43
system 5.4 : The System Browser 38

C 1.1.1 : Background 8
call  A.12 : Built-in Predicates 123
certainty factor 6.1.1.4 : Reasoning with Certainty Factors 50
certainty factors 6.1.1.4 : Reasoning with Certainty Factors 50,  6.1.2.1 : Examples 52
*c-factor* 6.1.1.4 : Reasoning with Certainty Factors 50
chaining 1.1.2 : Technical Overview 8
class  def-named-kb-class 69
class browser 5.5 : The Class Browser 38
classes 2.4.3 : Class Browser 15
named 4.1.2 : Named Classes 29
named-kb-object 91  4.1.2 : Named Classes 29
relational database 4.2 : Relational Database Objects 30
standard-class 6.3 : Use of Meta-Classes 55
standard-db-object 4.2.1 : Example 30
standard-kb-object 103  4.2.1 : Example 30,  5.5 : The Class Browser 39,  6.3 : Use of Meta-Classes 55,  def-kb-
class 67
unnamed 4.1.1 : Unnamed Classes 29
clause  A.12 : Built-in Predicates 123
clear 5.3 : Clearing KnowledgeWorks 37
clear-all function 61  5.3 : Clearing KnowledgeWorks 37,  6.5.2 : The Current Inferencing State 57
clear-rules function 62  5.3 : Clearing KnowledgeWorks 37
CLOS 1.1.1 : Background 8,  1.1.2 : Technical Overview 9,  2 : Tutorial 11,  2.2 : Loading the Tutorial 12,  2.4.2 : Objects
Browser 14,  2.7 : Lisp Integration 20,  3 : Rules 22,  3.2.1 : Overview 26,  5.3 : Clearing KnowledgeWorks 37,  6.2.1.1 :
KnowledgeWorks Structures 52
class categories in KnowledgeWorks 4.1 : CLOS objects 29
classes in KnowledgeWorks 4.1 : CLOS objects 29
objects in 1.1.2 : Technical Overview 9,  4.1 : CLOS objects 29
CLOS mixin class 1.1.2 : Technical Overview 9
CLOS/SQL class 4.2 : Relational Database Objects 30
Common Lisp Interface 3.3 : Common Lisp Interface 28
Index

Common Lisp Object System (CLOS)  1.1.1 : Background  8,  2 : Tutorial  11
Common Prolog main chapter  Appendix A : Common Prolog  108
condition  3.1.1 : Overview  22
  syntax  3.1.2 : Forward Chaining Syntax  22
conflict resolution  2.4.4 : Forward Chaining History  17,  3.1.1 : Overview  22,  3.1.5.2 : Contexts  25,  3.1.5.3 : Conflict Resolution  25
  optimizing  6.2.2 : Conflict Resolution  54
  strategy  6.1.2 : User-definable Conflict Resolution  51
  tactics  3.1.5.3 : Conflict Resolution  25,  6.1.2 : User-definable Conflict Resolution  51,  6.2.2.2 : Optimization of the Strategy  54
  use of contexts  6.2.2.1 : Use of Contexts  54
  user definable  6.1.2 : User-definable Conflict Resolution  51
conflict resolution strategy  6.1.2 : User-definable Conflict Resolution  51
conflict resolution tactic  3.1.5.3 : Conflict Resolution  25,  6.1.2 : User-definable Conflict Resolution  51
conflict resolution tactic / functions

  lex  85  3.1.5.3 : Conflict Resolution  25
  -lex  86  3.1.5.3 : Conflict Resolution  25,  6.2.2.2 : Optimization of the Strategy  54
  mea  89  3.1.5.3 : Conflict Resolution  25
  -mea  90  3.1.5.3 : Conflict Resolution  25,  6.2.2.2 : Optimization of the Strategy  54
  order  93  3.1.5.2 : Contexts  25,  3.1.5.3 : Conflict Resolution  25
  -order  94  3.1.5.3 : Conflict Resolution  25
  priority  95  3.1.5.2 : Contexts  25,  3.1.5.3 : Conflict Resolution  25
  -priority  96  3.1.5.3 : Conflict Resolution  25
  recency  97  3.1.5.2 : Contexts  25,  3.1.5.3 : Conflict Resolution  25
  -recency  98  3.1.5.3 : Conflict Resolution  25,  6.2.2.2 : Optimization of the Strategy  54
  specificity  100  3.1.5.3 : Conflict Resolution  25
  -specificity  101  3.1.5.3 : Conflict Resolution  25

conflict-set  backward chaining goal  62
context  3.1.2 : Forward Chaining Syntax  23,  6.1.1 : Meta Rule Protocol  47
context definition  3.1.6.1 : Defining Contexts  26
contexts  2.4.1 : Rule Browser  13,  3.1.5.1 : The Agenda  24,  3.1.5.2 : Contexts  25
control
  flow of  3.1.5 : Control Flow  24,  6.1 : Control Flow  47
creep  2.6.2 : Single-Stepping Rules  19,  5.8.1 : Spy Windows  44
current-cycle  function  64
cut  6.2.3.3 : Cut  55
cycle
  of forward chaining  3.1.1 : Overview  22
*cycle*  symbol macro  65
Index

D
DCG  A.9 : Defining Definite Clause Grammars  120

dec  A.12 : Built-in Predicates  124
decutable
debug
in Prolog  A.7 : Debugging  116
debugging
1.1.2 : Technical Overview  8, 2.6 : Debugging  17, 3.1.7 : Forward Chaining Debugging  26, 5.8 : Debugging with the
Environment  43, A.12 : Built-in Predicates  124
backward chaining  3.2.7 : Backward Chaining Debugging  28
forward chaining  3.1.7 : Forward Chaining Debugging  26
default-context  3.1.4 : The Forward Chaining Interpreter  24, 5.3 : Clearing KnowledgeWorks  37, clear-all  62, clear-rules  62
defclass macro  def-kb-class  67, def-named-kb-class  69
defclass macro in LispWorks  4.1.2 : Named Classes  29
defcontext macro  65 3.1.5.2 : Contexts  25, 3.1.5.3 : Conflict Resolution  25, 3.1.6 : Examples  26, 6.1.1 : Meta Rule
Protocol  47
defdetpred  A.13.1 : The defdetpred form  126
defdetrel  A.12 : Built-in Predicates  124
defdetunipred  A.13.2 : The defdetunipred form  126
defexplain  6.1.1.3 : A Simple Explanation Facility  49, 6.1.1.3 : A Simple Explanation Facility  49
defgrammar A.9 : Defining Definite Clause Grammars  120, A.12 : Built-in Predicates  124
Defining Contexts  3.1.6.1 : Defining Contexts  26
Definite Clause Grammars  A.9 : Defining Definite Clause Grammars  120
def-kb-class macro  67 4.1.1 : Unnamed Classes  29, 4.1.2 : Named Classes  29, 6.1.1.4 : Reasoning with Certainty
Factors  50, 6.3.1 : Example  55, 6.4.1 : Example  56
def-kb-struct macro  68 6.2.1.1 : KnowledgeWorks Structures  53
def-named-kb-class macro  69 4.1.2 : Named Classes  29
defrelmacro A.8 : Common Prolog Macros  120, A.12 : Built-in Predicates  124
defrel-special-form-macro  A.12 : Built-in Predicates  124
defrule macro  70 3 : Rules  22, 3.1.2.1 : Example  24, 3.2.2.1 : Example  27, 6.1.1 : Meta Rule Protocol  47, 6.1.1.4 :
Reasoning with Certainty Factors  50, 6.2.3.1 : Pattern Matching  54, 6.2.3.2 : Tail Recursion  55, 6.3.1 : Example  56, 6.4.1 :
Example  56, 6.5.2 : The Current Inferencing State  57
defstruct macro  62.1.1 : KnowledgeWorks Structures  53
deftactic macro  71 6.1.2 : User-definable Conflict Resolution  51
def-view-class in LispWorks  4.2.1 : Example  30
destroy-inferencing-state function  72 6.5.1 : Creating and Maintaining Inferencing States  57
deterministic A.12 : Built-in Predicates  124
documentation strings  3 : Rules  22, 3.1.5.2 : Contexts  25, 6.1.2 : User-definable Conflict
Resolution  51, defcontext  66, defrule  70, deftactic  71
dynamic conflict resolution  62.2.2 : Optimization of the Strategy  54

E
Edinburgh Prolog  3.2.6 : Edinburgh Prolog Translator  28

151
Index

Edinburgh Syntax  A.10: Edinburgh Syntax  122
compatible predicates  A.14: Edinburgh Compatibility Predicates  127
editor  5.2: The Editor  37
deditor window  2.4.1: Rule Browser  13
environment
  graphic environment in Prolog  A.11: Graphic Development Environment  123
erase  3.1.2: Forward Chaining Syntax  23, A.12: Built-in Predicates  124
erase backward chaining goal  73  6.4: Logical Dependencies and Truth Maintenance  56
explanations  6.1.1.3: A Simple Explanation Facility  49
expression
  syntax  3.1.2: Forward Chaining Syntax  23

F
fail  A.12: Built-in Predicates  124
fail backward chaining goal  73
field
  pattern  2.4.2: Objects Browser  14, 5.6: The Objects Browser  42
  query  5.6: The Objects Browser  42
findall function 74  3.2.5: The Backward Chaining Interpreter  27, A.6.2.1: any, findall and findallset  114, A.12: Built-in Predicates  124
findallset function 74  A.6.2.1: any, findall and findallset  114, A.12: Built-in Predicates  124
find-inferencing-state function 75  6.5.1: Creating and Maintaining Inferencing States  57
fire-rule backward chaining goal  76  6.1.1: Meta Rule Protocol  47
forward chaining  1.1.2: Technical Overview  8, 2.3: Running the Tutorial  12, 3: Rules  22, A.6.2.1: Forward Chaining  52, A.6.2.1: Efficient Forward Chaining Rule Preconditions  53
cycle  3.1.1: Overview  22, 6.1.1: Meta Rule Protocol  47, 6.1.1: Meta Rule Protocol  47
debugging  3.1.7: Forward Chaining Debugging  26
history  2.4.4: Forward Chaining History  16, 5.9.1: Forward Chaining History  46
implementation notes  C.1: Forward Chainer  138
interpreter  3.1.4: The Forward Chaining Interpreter  24
rule definition  3.1.3: Defining Forward Chaining Rules  24
syntax  3.1.2: Forward Chaining Syntax  22
functions
  all-debug  59  3.1.7: Forward Chaining Debugging  26
  any  59  3.2.5: The Backward Chaining Interpreter  27, A.6.2.1: any, findall and findallset  114
  clear-all  61  5.3: Clearing KnowledgeWorks  37, 6.5.2: The Current Inferencing State  57
  clear-rules  62  5.3: Clearing KnowledgeWorks  37
  current-cycle  64
destroy-inferencing-state  72  6.5.1: Creating and Maintaining Inferencing States  57
findall  74  3.2.5: The Backward Chaining Interpreter  27, A.6.2.1: any, findall and findallset  114, A.12: Built-in Predicates  124
findallset  74  A.6.2.1: any, findall and findallset  114, A.12: Built-in Predicates  124
find-inferencing-state  75  6.5.1: Creating and Maintaining Inferencing States  57
get-kb-object  77  4.1.2: Named Classes  29
**Index**

<table>
<thead>
<tr>
<th>term</th>
<th>page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>infer</td>
<td>2.3: Running the Tutorial 12, 2.6.2: Single-Stepping Rules 19, 3.1.4: The Forward Chaining Interpreter 24, 6.5.2: The Current Inferencing State 57</td>
</tr>
<tr>
<td>inferencing-state-name</td>
<td>79</td>
</tr>
<tr>
<td>inst-bindings</td>
<td>81 6.1.1.1: Functions defined on Instantiations 48</td>
</tr>
<tr>
<td>inst-rulename</td>
<td>82 6.1.1.1: Functions defined on Instantiations 48</td>
</tr>
<tr>
<td>inst-token</td>
<td>82 6.1.1.1: Functions defined on Instantiations 48</td>
</tr>
<tr>
<td>list-all-inferencing-states</td>
<td>87 6.5.1: Creating and Maintaining Inferencing States 57</td>
</tr>
<tr>
<td>make-inferencing-state</td>
<td>87 6.5.1: Creating and Maintaining Inferencing States 57</td>
</tr>
<tr>
<td>no-debug</td>
<td>92 3.1.7: Forward Chaining Debugging 26</td>
</tr>
<tr>
<td>reset</td>
<td>99 5.3: Clearing KnowledgeWorks 37, 6.5.2: The Current Inferencing State 57</td>
</tr>
<tr>
<td>start-kw</td>
<td>104</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td></td>
</tr>
<tr>
<td>generic functions</td>
<td></td>
</tr>
<tr>
<td>kb-name</td>
<td>83 4.1.2: Named Classes 29</td>
</tr>
<tr>
<td>make-instance</td>
<td>88 4.1: CLOS objects 29, 4.1.1: Unnamed Classes 29, 4.1.2: Named Classes 29, 6.2.1.1: KnowledgeWorks Structures 53, 6.4: Logical Dependencies and Truth Maintenance 56</td>
</tr>
<tr>
<td>validate-superclass</td>
<td>6.3: Use of Meta-Classes 55</td>
</tr>
<tr>
<td>get-kb-object</td>
<td>function 77 4.1.2: Named Classes 29</td>
</tr>
<tr>
<td>goals</td>
<td>1.1.2: Technical Overview 9</td>
</tr>
<tr>
<td>graphical tools</td>
<td>1.1.2: Technical Overview 8</td>
</tr>
<tr>
<td>H</td>
<td></td>
</tr>
<tr>
<td>halt</td>
<td>A.12: Built-in Predicates 124</td>
</tr>
<tr>
<td>history</td>
<td>2.4.4: Forward Chaining History 16</td>
</tr>
<tr>
<td>forward chaining</td>
<td>2.4.4: Forward Chaining History 16, 5.9.1: Forward Chaining History 46</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>I</td>
<td></td>
</tr>
<tr>
<td>Implementation Notes</td>
<td></td>
</tr>
<tr>
<td>appendix</td>
<td>Appendix C: : Implementation Notes 138</td>
</tr>
<tr>
<td>implication strength</td>
<td>6.1.1.4: Reasoning with Certainty Factors 50</td>
</tr>
<tr>
<td><em>implic-strength</em></td>
<td>6.1.1.4: Reasoning with Certainty Factors 50, 6.1.1.4: Reasoning with Certainty Factors 51</td>
</tr>
<tr>
<td>infer</td>
<td>78 2.3: Running the Tutorial 12, 2.6.2: Single-Stepping Rules 19, 3.1.4: The Forward Chaining Interpreter 24, 6.5.2: The Current Inferencing State 57</td>
</tr>
<tr>
<td>inference engine</td>
<td>1.1.2: Technical Overview 9</td>
</tr>
<tr>
<td><em>inferencing-state</em></td>
<td>variable 78 6.5.2: The Current Inferencing State 57</td>
</tr>
<tr>
<td>inferencing-state-name</td>
<td>function 79</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>inferencing states</td>
<td></td>
</tr>
<tr>
<td>creating and maintaining</td>
<td>6.5.1: Creating and Maintaining Inferencing States 57</td>
</tr>
<tr>
<td>current</td>
<td>6.5.2: The Current Inferencing State 57, <em>inferencing-state</em> 78</td>
</tr>
<tr>
<td>definition of</td>
<td>6.5: Inferencing States 57</td>
</tr>
<tr>
<td>interleaved</td>
<td>6.5.3.2: Interleaved in a Single Thread 58</td>
</tr>
<tr>
<td>multiple threads</td>
<td>6.5.3.1: Multiple threads 57</td>
</tr>
</tbody>
</table>
Index

uses 6.5.3: Uses of Inferencing States 57

*in-interpreter* variable 80

inspector
instances 5.5: The Class Browser 39

instantiation backward chaining goal 80 6.1.1: Meta Rule Protocol 47, 6.1.1: Meta Rule Protocol 48
instantiations 6.1.1.1: Functions defined on Instantiations 48

inst-bindings function 81 6.1.1.1: Functions defined on Instantiations 48

inst-rulename function 82 6.1.1.1: Functions defined on Instantiations 48

inst-token function 82 6.1.1.1: Functions defined on Instantiations 48

integer A.12: Built-in Predicates 124

interface functions in Prolog A.6.2: Interface Functions 114

interpreter
backward chaining 3.2.5: The Backward Chaining Interpreter 27
forward chaining 3.1.4: The Forward Chaining Interpreter 24

Introduction
main chapter 1: Introduction 8

is A.12: Built-in Predicates 124

K

kb-name generic function 83 4.1.2: Named Classes 29

:kb-name initarg 4.1.2: Named Classes 29, named-kb-object 91

keysort A.12: Built-in Predicates 124

keyword
:backward 3: Rules 22
:forward 3: Rules 22

:meta 6.1.1: Meta Rule Protocol 47

:predicate 2.4.4: Forward Chaining History 17

Knowledge Based Systems (KBS) 1.1.1: Background 8, 1.1.2: Technical Overview 9

KnowledgeWorks 1.1: KnowledgeWorks 8
backward chaining engine 3.2.1: Overview 26

clearing 5.3: Clearing KnowledgeWorks 37
CLOS objects 3.2.1: Overview 26, 4: Objects 29

Converting Other Systems Into, Appendix E: Converting Other Systems 142
generic functions 5.5: The Class Browser 41
historical perspective 1.1.1: Background 8
instances 5.5: The Class Browser 39

listener 5.1: The KnowledgeWorks Listener 36
loading files 2.2: Loading the Tutorial 12

mixin class 4.2: Relational Database Objects 30
object base 3.2.1: Overview 26

objects 3.2.3: Objects 27
Index

<table>
<thead>
<tr>
<th>Rule/Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>podium 2.1</td>
<td>Getting Started 11</td>
</tr>
<tr>
<td>rule development 5</td>
<td>The Programming Environment 36</td>
</tr>
<tr>
<td>rule monitor 5.7</td>
<td>The Rule Browser 43, 5.9</td>
</tr>
<tr>
<td>rules in 3</td>
<td>Rules 22</td>
</tr>
<tr>
<td>running the tutorial 2.3</td>
<td>Running the Tutorial 12</td>
</tr>
<tr>
<td>spy window 5.7</td>
<td>The Rule Browser 43</td>
</tr>
<tr>
<td>structures 4.3</td>
<td>KnowledgeWorks Structures 35, 6.2.1.1</td>
</tr>
<tr>
<td>technical overview 1.1.2</td>
<td>Technical Overview 8</td>
</tr>
<tr>
<td>tools 2.6.2</td>
<td>Single-Stepping Rules 19</td>
</tr>
<tr>
<td>Use of Meta-Classes 6.3</td>
<td>Use of Meta-Classes 55</td>
</tr>
<tr>
<td>kw-class</td>
<td>backward chaining goal 84</td>
</tr>
</tbody>
</table>

**L**
- 2.6.2 | Single-Stepping Rules 19, 5.8.1 | Spy Windows 44 |
- leash A.12 | Built-in Predicates 124 |
- leashing A.7 | Debugging 116 |
- lex | conflict resolution tactic / function 85, 3.1.5.3 | Conflict Resolution 25 |
- ~lex | conflict resolution tactic / function 86, 3.1.5.3 | Conflict Resolution 25, 6.2.2.2 | Optimization of the Strategy 54 |
- Lisp 1.1.1 | Background 8, 2 | Tutorial 11, 3.1.2 | Forward Chaining Syntax 23, 3.3 | Common Lisp Interface 28, 4 | Objects 29 |
- LispWorks 1.1 | KnowledgeWorks 8, 2 | Tutorial 11, 2.8 | Systems 21, 3.2.1 | Overview 26 |
- accessing Lisp from Prolog A.5 | Accessing Lisp From Common Prolog 111 |
- availability in KnowledgeWorks 5 | The Programming Environment 36 |
- calling Prolog A.6 | Calling Prolog From Lisp 112 |
- Common Prolog Logic Listener 5.1 | The KnowledgeWorks Listener 36 |
- SQL interface 4.2 | Relational Database Objects 30 |
- LispWorks IDE 2.7.1 | The LispWorks IDE 20 |
- list-all-inferencing-states function 87, 6.5.1 | Creating and Maintaining Inferencing States 57 |
- listener 2.3 | Running the Tutorial 12, 5.1 | The KnowledgeWorks Listener 36 |
- listing A.12 | Built-in Predicates 124 |
- loading files 2.2 | Loading the Tutorial 12 |
- logic A.6 | Calling Prolog From Lisp 112 |
- logical 3.1.2 | Forward Chaining Syntax 23, 6.4 | Logical Dependencies and Truth Maintenance 56 |
- logic interpreter A.4 | Using The Logic Interpreter 109 |
- logic listener A.11 | Graphic Development Environment 123 |

**M**
- macro A.8 | Common Prolog Macros 120 |
- macros
  - defclass def-kb-class 67, def-named-kb-class 69 |
  - defcontext 65, 3.1.5.2 | Contexts 25, 3.1.5.3 | Conflict Resolution 25, 3.1.6 | Examples 26, 6.1.1 | Meta Rule Protocol 47 |
  - def-kb-class 67, 4.1.1 | Unnamed Classes 29, 4.1.2 | Named Classes 29, 6.1.1.4 | Reasoning with Certainty 84
## Index

<table>
<thead>
<tr>
<th>Factors</th>
<th>50, 6.3.1 : Example 55, 6.4.1 : Example 56</th>
</tr>
</thead>
<tbody>
<tr>
<td>def-kb-struct</td>
<td>68, 6.2.1.1 : KnowledgeWorks Structures 53</td>
</tr>
<tr>
<td>def-named-kb-class</td>
<td>69, 4.1.2 : Named Classes 29</td>
</tr>
<tr>
<td>defrule</td>
<td>70, 3 : Rules 22, 3.1.2.1 : Example 24, 3.2.2.1 : Example 27, 6.1.1 : Meta Rule Protocol 47, 6.1.1.4 : Reasoning with Certainty Factors 50, 6.2.3.1 : Pattern Matching 54, 6.2.3.2 : Tail Recursion 55, 6.3.1 : Example 56, 6.4.1 : Example 57</td>
</tr>
<tr>
<td>defstruct</td>
<td>62.1.1 : KnowledgeWorks Structures 53</td>
</tr>
<tr>
<td>deftactic</td>
<td>71, 6.1.2 : User-definable Conflict Resolution 51</td>
</tr>
<tr>
<td>undefcontext</td>
<td>105, 3.1.6.1 : Defining Contexts 26</td>
</tr>
<tr>
<td>undefrule</td>
<td>106, 3.1.3 : Defining Forward Chaining Rules 24</td>
</tr>
<tr>
<td>with-rule-actions</td>
<td>107</td>
</tr>
<tr>
<td>make-inferencing-state</td>
<td>function 87, 6.5.1 : Creating and Maintaining Inferencing States 57</td>
</tr>
<tr>
<td>make-instance</td>
<td>generic function 88, 4.1 : CLOS objects 29, 4.1.1 : Unnamed Classes 29, 4.1.2 : Named Classes 29, 6.2.1.1 : KnowledgeWorks Structures 53, 6.4 : Logical Dependencies and Truth Maintenance 56</td>
</tr>
<tr>
<td>mea</td>
<td>conflict resolution tactic / function 89, 3.1.5.3 : Conflict Resolution 25</td>
</tr>
<tr>
<td>−mea</td>
<td>conflict resolution tactic / function 90, 3.1.5.3 : Conflict Resolution 25, 6.2.2.2 : Optimization of the Strategy 54</td>
</tr>
<tr>
<td>member</td>
<td>A.12 : Built-in Predicates 124</td>
</tr>
</tbody>
</table>

### menu item

| browse | 2.4.3 : Class Browser 15 |
| class browser | 2.4.3 : Class Browser 15 |
| Classes | 2.4.3 : Class Browser 16 |
| clear | 5.3 : Clearing KnowledgeWorks 37 |
| context | 5.7 : The Rule Browser 43 |
| FC History | 2.4.4 : Forward Chaining History 17 |
| Inspect | 5.6 : The Objects Browser 42 |
| Instantiations | 5.6 : The Objects Browser 42 |
| KnowledgeWorks | 2.2 : Loading the Tutorial 12, 2.4.2 : Objects Browser 14, 2.4.3 : Class Browser 16, 2.4.4 : Forward Chaining History 17, 5.6 : The Objects Browser 42, 5.7 : The Rule Browser 43 |
| Listener | 2.2 : Loading the Tutorial 12 |
| Objects | 2.4.2 : Objects Browser 14, 5.6 : The Objects Browser 42 |
| Rules | 2.4.1 : Rule Browser 13, 5.7 : The Rule Browser 43 |
| :meta | keyword 6.1.1 : Meta Rule Protocol 47 |
| meta-interpreter | 6.1.1 : Meta Rule Protocol 47 |
| Meta Object Protocol (MOP) | 1.1.2 : Technical Overview 9 |
| metaprotocols | 1.1.2 : Technical Overview 8 |
| meta-rule | 6.1.1 : Meta Rule Protocol 47 |
| Meta Rule Protocol (MRP) | 1.1.2 : Technical Overview 9, 6.1.1 : Meta Rule Protocol 47 |
| mixin | 1.1.2 : Technical Overview 9, 4.1.1 : Unnamed Classes 29, 4.1.2 : Named Classes 29 |
| monitor window | 2.6.1 : Monitoring Forward Chaining Rules 18, 5.9 : Monitor Windows 44 |
Index

MYCIN 6.1.1.4 : Reasoning with Certainty Factors 50

N
named classes 4.1.2 : Named Classes 29

named-kb-object class 91 4.1.2 : Named Classes 29

node 2.4.1 : Rule Browser 13

nodebug A.12 : Built-in Predicates 124

no-debug function 92 3.1.7 : Forward Chaining Debugging 26

nonvar A.12 : Built-in Predicates 124

nospy A.12 : Built-in Predicates 124

not 3.1.2 : Forward Chaining Syntax 23, A.12 : Built-in Predicates 124

not backward chaining goal 92

notrace A.12 : Built-in Predicates 124

O

object 3.2.3 : Objects 27

browser 2.6.2 : Single-Stepping Rules 19, 5.6 : The Objects Browser 41

certainty factor 6.1.1.4 : Reasoning with Certainty Factors 50

named 4.1 : CLOS objects 29

object base 2.6.1 : Monitoring Forward Chaining Rules 18, 4.3 : KnowledgeWorks Structures 35

and inferencing states 6.5 : Inferencing States 57

clearing 5.3 : Clearing KnowledgeWorks 37

main chapter 4 : Objects 29

uncertainty 6.1.1.4 : Reasoning with Certainty Factors 50, 6.1.1.4 : Reasoning with Certainty Factors 50

object browser 2.4.2 : Objects Browser 14

object system 1.1.2 : Technical Overview 8

once A.12 : Built-in Predicates 125

OP5 6.2.1.1 : KnowledgeWorks Structures 53, E.1 : OP5 142

optimization 6.2 : Optimization 52

optimization of KnowledgeWorks 4.3 : KnowledgeWorks Structures 35

order conflict resolution tactic / function 93 3.1.5.2 : Contexts 25, 3.1.5.3 : Conflict Resolution 25

~order conflict resolution tactic / function 94 3.1.5.3 : Conflict Resolution 25

output-defrels A.12 : Built-in Predicates 125

P

pattern 2.4.2 : Objects Browser 14, 5.6 : The Objects Browser 42

matching 6.2.3.1 : Pattern Matching 54

phrase A.12 : Built-in Predicates 125

popup 2.3 : Running the Tutorial 12

Preferences... command 2.4.2 : Objects Browser 14, 5.6 : The Objects Browser 42, 5.7 : The Rule Browser 43

*print-verbose* variable 95

priority conflict resolution tactic / function 95 3.1.5.2 : Contexts 25, 3.1.5.3 : Conflict Resolution 25
Index

-priority conflict resolution tactic / function 96  3.1.5.3 : Conflict Resolution 25
procedural language 1.1.2 : Technical Overview 8
programming environment

main chapter 5 : The Programming Environment 36
Prolog 3.2.1 : Overview 26, 3.2.6 : Edinburgh Prolog Translator 28, E.2 : Prolog 144
accessing Lisp A.5 : Accessing Lisp From Common Prolog 111
adding built in predicates A.13 : Adding Built-in Predicates 126
built in predicates A.12 : Built-in Predicates 123
calling from LispWorks A.6 : Calling Prolog From Lisp 112

cut 6.2.3.3 : Cut 55
debugging A.7 : Debugging 116
Edinburgh Syntax A.10 : Edinburgh Syntax 122
exiting the interpreter A.4.4 : Exiting the Interpreter 111
graphic environment A.11 : Graphic Development Environment 123
interface functions A.6.2 : Interface Functions 114
leashing A.7 : Debugging 116
logic interpreter A.4 : Using The Logic Interpreter 109
logic listener A.11 : Graphic Development Environment 123
macros A.8 : Common Prolog Macros 120
main chapter Appendix A : Common Prolog 108
overview A.1.1 : Overview 108
predicates compatible with Edinburgh syntax A.14 : Edinburgh Compatibility Predicates 127
retrieving multiple solutions in A.4.1 : Multiple Solutions 110
specifying multiple goals in A.4.2 : Multiple Goals 110
spy points A.7 : Debugging 116
syntax A.2 : Syntax 108
tracing A.7 : Debugging 116

Q

query 5.6 : The Objects Browser 42

R

read-query-print loop A.4 : Using The Logic Interpreter 109
read-term A.12 : Built-in Predicates 125
recency conflict resolution tactic / function 97  3.1.5.2 : Contexts 25, 3.1.5.3 : Conflict Resolution 25
-recency conflict resolution tactic / function 98  3.1.5.3 : Conflict Resolution 25, 6.2.2.2 : Optimization of the Strategy 54
recorda A.12 : Built-in Predicates 125
recorded A.12 : Built-in Predicates 125
recordz A.12 : Built-in Predicates 125
relational database classes 4.2 : Relational Database Objects 30

repeat A.12 : Built-in Predicates 125
reset function 99  5.3 : Clearing KnowledgeWorks 37,  6.5.2 : The Current Inferencing State 57
Index

retract  A.12 : Built-in Predicates  125
return  3.1.2 : Forward Chaining Syntax  23,  3.1.5.2 : Contexts  25
rule  3 : Rules  22
   action  3.1.1 : Overview  22
   backward chaining  3.2.4 : Defining Backward Chaining Rules  27
browser  2.6.1 : Monitoring Forward Chaining Rules  18
condition  3.1.1 : Overview  22
definition of forward chaining  3.1.3 : Defining Forward Chaining Rules  24
editing definitions  2.6.3 : Editing Rule Definitions  19
   groups  2.4.4 : Forward Chaining History  17
   implication strength  6.1.1.4 : Reasoning with Certainty Factors  50
   single-stepping  2.6.2 : Single-Stepping Rules  18
rulebase  4.2 : Relational Database Objects  30
   rule browser  5.7 : The Rule Browser  43
   rule-defined conflict resolution  6.2.2.2 : Optimization of the Strategy  54
rule monitor  5.7 : The Rule Browser  43,  5.9 : Monitor Windows  44
   rule preconditions  6.2.1.2 : Efficient Forward Chaining Rule Preconditions  53
Rules
   main chapter  3 : Rules  22

S

setof  A.12 : Built-in Predicates  125
signal-kb-name-clash* variable  100
sort  A.12 : Built-in Predicates  125
specificity conflict resolution tactic / function  100  3.1.5.3 : Conflict Resolution  25
~specificity conflict resolution tactic / function  101  3.1.5.3 : Conflict Resolution  25
spy  A.12 : Built-in Predicates  125
   spy points  A.7 : Debugging  116
spy window  2.6.2 : Single-Stepping Rules  19,  5.7 : The Rule Browser  43,  5.8.1 : Spy Windows  43
standard-class  class  6.3 : Use of Meta-Classes  55
standard-context backward chaining goal  102
standard-db-object  class  4.2.1 : Example  30
standard-kb-class  6.3.1 : Example  55
standard-kb-object  class  103  4.2.1 : Example  30,  5.5 : The Class Browser  39,  6.3 : Use of Meta-Classes  55,  def-kb-
class  67
start-cycle backward chaining goal  103  6.1.1 : Meta Rule Protocol  47
start-kw function  104
static conflict resolution  6.2.2.2 : Optimization of the Strategy  54
structures  4.3 : KnowledgeWorks Structures  35,  5.3 : Clearing KnowledgeWorks  37,  6.2.1.1 : KnowledgeWorks Structures  52
subclasses  2.4.3 : Class Browser  16
symbol macros

*cycle*  65

syntax

backward chaining  3.2.2: Backward Chaining Syntax  27
expression  3.1.2: Forward Chaining Syntax  23
forward-condition  3.1.2: Forward Chaining Syntax  22
of forward chaining  3.1.2: Forward Chaining Syntax  22

syntax of Prolog  A.2: Syntax  108

system browser  5.4: The System Browser  38

systems  2.8: Systems  21

T

tactic  3.1.5.3: Conflict Resolution  25,  deftactic  71
Tail Recursion  6.2.3.2: Tail Recursion  55

**test**  backward chaining goal  105

Tools menu

Preferences...  2.4.2: Objects Browser  14,  5.6: The Objects Browser  42,  5.7: The Rule Browser  43

trace  A.12: Built-in Predicates  125

in Prolog  A.7: Debugging  116

**translate-vars**  A.12: Built-in Predicates  125

**true**  A.12: Built-in Predicates  125

truth maintenance  3.1.2: Forward Chaining Syntax  23,  6.4: Logical Dependencies and Truth Maintenance  56

Tutorial

main chapter  2: Tutorial  11

U

**undefcontext** macro  105  3.1.6.1: Defining Contexts  26

**undefrule** macro  106  3.1.3: Defining Forward Chaining Rules  24

**unleash** A.12: Built-in Predicates  125

unnamed classes  4.1.1: Unnamed Classes  29

V

**validate-superclass** generic function  6.3: Use of Meta-Classes  55

**var** A.12: Built-in Predicates  125

variables

**inferencing-state**  78  6.5.2: The Current Inferencing State  57
**in-interpreter**  80
**print-verbose**  95
**signal-kb-name-clash**  100

W

window

browser  2.4: Browsers  13

editor  2.4.1: Rule Browser  13,  5.2: The Editor  37
Index

listener  2.2 : Loading the Tutorial  12,  2.3 : Running the Tutorial  12,  5.1 : The KnowledgeWorks Listener  36
monitor  2.6.1 : Monitoring Forward Chaining Rules  18,  5.9 : Monitor Windows  44
podium  2.1 : Getting Started  11
popup  2.3 : Running the Tutorial  12
spy  2.6.2 : Single-Stepping Rules  19,  5.7 : The Rule Browser  43,  5.8.1 : Spy Windows  43
subclasses  2.4.3 : Class Browser  16

with-prolog  A.6.2.3 : with-prolog  115
with-rule-actions  macro  107

Non-alphanumerics

*  1.2.1 : Prolog syntax  10
+  1.2.1 : Prolog syntax  10
/==  A.12 : Built-in Predicates  123
<=  1.2.1 : Prolog syntax  10
==  A.12 : Built-in Predicates  123
:=  1.2.1 : Prolog syntax  10
==  A.12 : Built-in Predicates  123
@<  A.12 : Built-in Predicates  123
@<=  A.12 : Built-in Predicates  123
@>  A.12 : Built-in Predicates  123
@>=  A.12 : Built-in Predicates  123
[ . . ]  1.2.1 : Prolog syntax  10
|  1.2.1 : Prolog syntax  10